MATLAB® 7

Creating Graphical User Interfaces

MATLAB

‘\The MathWorks™

Accelorating the poce of engineering and science



LN N

How to Contact The MathWorks

www . mathworks.com Web

comp.soft-sys.matlab Newsgroup

www . mathworks.com/contact_TS.html Technical Support
suggest@mathworks.com Product enhancement suggestions
bugs@mathworks.com Bug reports

doc@mathworks.com Documentation error reports
service@mathworks.com Order status, license renewals, passcodes
info@mathworks.com Sales, pricing, and general information

508-647-7000 (Phone)
508-647-7001 (Fax)

The MathWorks, Inc.
3 Apple Hill Drive
Natick, MA 01760-2098

For contact information about worldwide offices, see the MathWorks Web site.
MATLAB® Creating Graphical User Interfaces
© COPYRIGHT 2000-2009 by The MathWorks, Inc.

The software described in this document is furnished under a license agreement. The software may be used
or copied only under the terms of the license agreement. No part of this manual may be photocopied or
reproduced in any form without prior written consent from The MathWorks, Inc.

FEDERAL ACQUISITION: This provision applies to all acquisitions of the Program and Documentation
by, for, or through the federal government of the United States. By accepting delivery of the Program

or Documentation, the government hereby agrees that this software or documentation qualifies as
commercial computer software or commercial computer software documentation as such terms are used

or defined in FAR 12.212, DFARS Part 227.72, and DFARS 252.227-7014. Accordingly, the terms and
conditions of this Agreement and only those rights specified in this Agreement, shall pertain to and govern
the use, modification, reproduction, release, performance, display, and disclosure of the Program and
Documentation by the federal government (or other entity acquiring for or through the federal government)
and shall supersede any conflicting contractual terms or conditions. If this License fails to meet the
government’s needs or is inconsistent in any respect with federal procurement law, the government agrees
to return the Program and Documentation, unused, to The MathWorks, Inc.

Trademarks

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. See
www . mathworks.com/trademarks for a list of additional trademarks. Other product or brand
names may be trademarks or registered trademarks of their respective holders.

Patents

The MathWorks products are protected by one or more U.S. patents. Please see
www.mathworks.com/patents for more information.


http://www.mathworks.com/trademarks
http://www.mathworks.com/patents

Revision History

November 2000
June 2001

July 2002

June 2004
October 2004
March 2005
September 2005
March 2006
May 2006
September 2006
March 2007
September 2007
March 2008
October 2008
March 2009
September 2009

Online Only
Online Only
Online Only
Online Only
Online Only
Online Only
Online Only
Online Only
Online Only
Online Only
Online Only
Online Only
Online Only
Online Only
Online Only
Online Only

New for MATLAB 6.0 (Release 12)

Revised for MATLAB 6.1 (Release 12.1)
Revised for MATLAB 6.6 (Release 13)
Revised for MATLAB 7.0 (Release 14)
Revised for MATLAB 7.0.1 (Release 14SP1)
Revised for MATLAB 7.0.4 (Release 14SP2)
Revised for MATLAB 7.1 (Release 14SP3)
Revised for MATLAB 7.2 (Release 2006a)
Revised for MATLAB 7.2

Revised for MATLAB 7.3 (Release 2006b)
Revised for MATLAB 7.4 (Release 2007a)
Revised for MATLAB 7.5 (Release 2007b)
Revised for MATLAB 7.6 (Release 2008a)
Revised for MATLAB 7.7 (Release 2008b)
Revised for MATLAB 7.8 (Release 2009a)
Revised for MATLAB 7.9 (Release 2009b)






Introduction to Creating GUIs

About GUIs in MATLAB Software

What Isa GUI? ........ ... .. . . . . 1-2
How Does a GUIWork? ............................. 14
Where Do I Start? ....... ... ... ... ... . i 1-6
Ways to Build MATLABGUIs ....................... 1-8

Creating a Simple GUI with GUIDE

2|

GUIDE: A Brief Introduction ....................... 2-2
What Is GUIDE? .. ... . i e 2-2
Opening GUIDE ....... ... . ... .. 2-2
LayingOut a GUIL ........ .. ... i, 2-7
Programminga GUI .................... ... ... ..... 2-8

Example: Simple GUI .............................. 2-9
Simple GUL Overview ..........c.oviiiieennnnennn.. 2-9
View Completed Layout and Its GUI M-File ............ 2-10

Laying Out aSimple GUI ........................... 2-11
Opening a New GUI in the Layout Editor .............. 2-11
Setting the GUI Figure Size ......................... 2-14
Adding the Components ..............ccviivevnine... 2-15
Aligning the Components ..............covivevnne... 2-16

Adding Text to the Components ...................... 2-18



vi

Completed Layout ........... ..., 2-23

Saving the GUIl Layout ............................. 2-25
Programming a Simple GUI ........................ 2-28
Adding Codetothe M-file .............. ... ... ....... 2-28
Generating DatatoPlot ............................ 2-28
Programming the Pop-UpMenu ..................... 2-31
Programming the Push Buttons ...................... 2-33
Runningthe GUI ................. ... ... ........... 2-36

Creating a Simple GUI Programmatically

3

Contents

Example: Simple GUI .............................. 3-2
Simple GULOVerview . .........c.uiiiiinnneneeennnn. 3-2
View Completed Example ........................... 3-3

Function Summary ............... ... ... 3-4

Creatinga GUIM-File .............................. 3-5

Laying Outa Simple GUI ........................... 3-7
Creatingthe Figure ......... ... .. ... 3-7
Adding the Components ............c0iiiiiineeeno... 3-7

Initializingthe GUI ................................ 3-11

Programming the GUI ............................. 3-14
Programming the Pop-UpMenu ..................... 3-14
Programming the Push Buttons ...................... 3-15
Associating Callbacks with Their Components .......... 3-15

Running the Final GUI ............................. 3-17
Final M-File . ... ... i i 3-17



Runningthe GUI ....... ... ... ... . ... 3-20

Creating GUIs with GUIDE

What Is GUIDE?

q |

GUIDE: Getting Started ............................ 4-2
GUILayout .......c.ciiiiiiiiiie e, 4-2
GUI Programming . ............oiuiuiueenennnnnnnnn.. 4-2

GUIDE Tools Summary ..................ccciiuiuu.... 4-3

GUIDE Preferences and Options

5

GUIDE Preferences ..............ccuuiiiiiiiininnnn.. 5-2
Setting Preferences ................ciiiiiiiinn.... 5-2
Confirmation Preferences ................ ... ........ 5-2
Backward Compatibility Preference .................. 5-4
All Other Preferences .............. ..., 5-6

GUIOPtions ...... ...ttt 5-9
The GUI Options Dialog Box ........................ 5-9
Resize Behavior ............ ... .. .. 5-10
Command-Line Accessibility ........................ 5-10
Generate FIG-Fileand M-File ....................... 5-11
Generate FIG-FileOnly ............................ 5-14

vii



viii

Contents

Laying Out a GUIDE GUI

6

Designinga GUI ............ .. ... ... ... ... ........ 6-2
Starting GUIDE ............ ... ... ... .. i, 6-4
Selecting a GUI Template .......................... 6-6
Accessing the Templates .............. ..., 6-6
Template Descriptions ............... ... 6-7
Settingthe GUISize ................ ... i, 6-15
Maximizing the Layout Area ........................ 6-18
Adding Componentstothe GUI ..................... 6-19
Available Components .............ccitiiiiiiine... 6-20
A Working GUI with Many Components ............... 6-24
Adding Components to the GUIDE Layout Area ........ 6-31
Defining User Interface Controls ..................... 6-38
Defining Panels and Button Groups .................. 6-55
Defining Axes ... .t e 6-61
Defining Tables ........ ... ... ... 6-65
Adding ActiveX Controls ............ ..., 6-76
Working with Components in the Layout Area .......... 6-79
Locating and Moving Components .................... 6-82
Resizing Components ...........c.oiuiiiiuennnnennnn 6-85
Aligning Components ...............coviuiinnnennn. 6-88
Alignment Tool .......... ... ... i iiiiiiiinnnnnn. 6-88
Property Inspector ......... ... .. . i, 6-91
Gridand Rulers ........... ... .. 6-95
Guide Lines .........iiuiiiiiiiiiiiiiii i, 6-95
Setting TabOrder ............ ... ..., 6-97
Creating Menus ...............ciiiiiiiiinnnnnnnn. 6-100
Menus forthe MenuBar ............................ 6-102
Context Menus .........oiiiiiniiniinnennnnn. 6-113



Creating Toolbars ............ ... ... 6-121

Creating Toolbars with GUIDE ...................... 6-121
Editing ToolIcons ......... .. ... 6-130
Viewing the Object Hierarchy ...................... 6-135
Designing for Cross-Platform Compatibility ......... 6-136
Default System Font ............................... 6-136
Standard Background Color ......................... 6-137
Cross-Platform Compatible Units .................... 6-138

Saving and Running a GUIDE GUI

7

Naming a GUIl and ItsFiles ......................... 7-2
The GUI Files ... .o 7-2
Fileand GUI Names ...........cciiiiiiinneneennna.. 7-3
Renaming GUIs and GUI Files ...................... 7-3

Savinga GUI ......... ... ... .. 7-4
WaystoSavea GUIL .......... ... ... ... 7-4
SavingaNew GUI ........ ... ... 7-5
Saving an Existing GUI ............................ 7-8

Runninga GUI ....... ... ... ... ... ... ..., 7-10
Executingthe M-file ........... ... ..., 7-10
From the GUIDE Layout Editor ..................... 7-10
From the Command Line ........................... 7-11
FromanM-file ....... ... ... i, 7-11

8|

ix



X

Contents

What Is a Callback? .......... . ...,
Kindsof Callbacks .........cciiiiiiiiiiiinn.,

GUI Files: An Overview ...............cciiiinnnn.
M-Filesand FIG-Files .......... ... ... ...
GUI M-File Structure ...........cciiiiiineeneennnnn.
Adding Callback Templates to an Existing GUI M-File ...
About GUIDE-Generated Callbacks ..................

Associating Callbacks with Components .............
GUI Components ...........uuiiimimnnneneeennnnn
Setting Callback Properties Automatically .............
Deleting Callbacks from a GUI M-File ................

Callback Syntax and Arguments ....................
Callback Templates .......... ...
Naming of Callback Functions .......................
Changing Callbacks Assigned by GUIDE ..............
Input Arguments ........ ... . i

Initialization Callbacks ............................
Opening Function ........... ..ttt
Output Function ........... ... 0.,

Examples: Programming GUIDE GUI Components ...
PushButton ....... ... .. i
Toggle Button ......... ...,
RadioButton .......... ... .. .. . . . .
Check BoxX .. oiiii i e
Edit Text . ... e
Table ... ..
Slhder ..ot e
List Box ...
Pop-UpMenu .........ciiiiiiiiiiiiiiinnn.
Panel ....... . . ..
Button Group .........c i e
AXES e
ActiveX Control . .......... i
Menultem ........ ... ... i

8-2

8-7



Managing and Sharing Application Data in

GUIDE
Mechanisms for Managing Data ..................... 9-2
L0 =) T =) 9-2
Nested Functions ......... ..o, 9-4
UserData Property ............c0 .. 9-5
Application Data ......... ... i, 9-5
GUIData ... e e 9-7
Examples of Sharing Data Among a GUT’s Callbacks .... 9-10
Making Multiple GUIs Work Together ............... 9-21
Data-Sharing Techniques ........................... 9-21
Example — Manipulating a Modal Dialog Box for User
Input ... e 9-22
Example — Individual GUIDE GUIs Cooperating as Icon
Manipulation Tools . ......... ... iiiiiinnnnn.. 9-30

10|

GUI with Multiple Axes ............... ... 10-2
About the Multiple Axes Example .................... 10-2
View and Run the Multiple AxesGUI ................. 10-3
Designingthe GUIL ......... ... ... . ... ... .. 10-4
Plot Push Button Callback .......................... 10-8
Validating User Input as Numbers ................... 10-11

GUI for Animatinga 3-DView ...................... 10-15
About the 3-D Animation Example ................... 10-15
View and Run the 3-D Globe GUI .................... 10-16
Designingthe GUI ......... ... ... ... ... .. 10-17
Graphics Techniques ..., 10-24
Further Graphic Explorations ....................... 10-29

GUI to Interactively Explore Data in a Table ......... 10-31

About the tablestat Example ........................ 10-31



View and Run the tablestat GUI ..................... 10-33

Designingthe GUIL .............. ... . ... 10-35
Extending Tablestat ............... .. ... .. 10-52
List Box Directory Reader .......................... 10-54
About the List Box Directory Example ................ 10-54
View and Run the List Box Directory GUI ............. 10-55
Implementing the List Box Directory GUI ............. 10-56
Accessing Workspace Variables from a List Box ...... 10-61
About the Workspace Variable Example ............... 10-61
View and Run the Workspace Variable GUI ............ 10-62
Reading Workspace Variables ....................... 10-63
Reading the Selections from the List Box .............. 10-64
A GUI to Set Simulink Model Parameters ............ 10-66
About the Simulink Model Parameters Example ........ 10-66
View and Run the Simulink Parameters GUI ........... 10-67
How to Use the Simulink Parameters GUT ............. 10-68
Runningthe GUI ................ . ... ... 10-70
Programming the Slider and Edit Text Components ..... 10-71
Running the Simulation from the GUT ................ 10-73
Removing Results from the List Box .................. 10-75
Plotting the Results Data ........................... 10-76
The GUI HelpButton .............................. 10-78
Closingthe GUI ......... .. ... . .. 10-78
The List Box Callback and Create Function ............ 10-79
An Address Book Reader ........................... 10-81
About the Address Book Reader Example .............. 10-81
View and Run the Address Book Reader GUT ........... 10-82
Runningthe GUI ................ ... .. ... 10-83
Loading an Address Book Into the Reader ............. 10-85
The Contact Name Callback ......................... 10-88
The Contact Phone Number Callback ................. 10-90
Paging Through the Address Book — Prev/Next ........ 10-91
Saving Changes to the Address Book from the Menu .. ... 10-93
The Create New Menu ............c0iiiiiiinnnnnn. 10-94
The Address Book Resize Function ................... 10-95
Using a Modal Dialog Box to Confirm an Operation ... 10-98
About the Modal Dialog Example .................... 10-98

xii Contents



View and Run the Modal Dialog Box GUIs ............. 10-99

Setting Up the Close Confirmation Dialog ............. 10-100
Setting Up the GUI with the Close Button ............. 10-101
Running the Close-Confirmation GUI ................. 10-102
How the Close-Confirmation GUIs Work .............. 10-103

Creating GUIs Programmatically

Laying Out a GUI

Designinga GUI .......... ... ... ... . i ... 11-2
Creating and Running the GUI M-File ............... 11-4
File Organization ................00iiiiiiininnn... 11-4
File Template ......... i, 11-4
Runningthe GUI .......... ... ... .. ... ... . .. 11-5
Creating the GUI Figure ........................... 11-7
Adding Componentstothe GUI ..................... 11-10
Available Components ...........iiiiii., 11-10
Adding User Interface Controls ...................... 11-13
Adding Panels and Button Groups .................... 11-32
Adding AXeS .. i vttt e e e 11-38
Adding ActiveX Controls .......... ..., 11-41

Composing and Coding GUIs with Interactive Tools .. 11-42

Setting Positions of Components Interactively .......... 11-43
Aligning Components .............cueeiiinennnnnnn.. 11-52
Setting Colors Interactively ......................... 11-58
Setting Font Characteristics Interactively ............. 11-60
Generating Code to Set Component Properties .......... 11-62
Summary of GUI Development Tools ................. 11-67
Setting TabOrder ................ ... .. . i, 11-68
How Tabbing Works . ............. i iiiiiiinn.... 11-68
Default TabOrder ......... ..., 11-68

xiii



xiv

Changingthe TabOrder .............. ..., 11-71

Creating Menus ...............iiiiminnnneennnnn 11-73
Adding Menu Bar Menus .............ccoiiiii... 11-73
Adding Context Menus ...........cciiiiiinnneeenn.. 11-79

Creating Toolbars ............ ... ... 11-86
Using the uitoolbar Function ........................ 11-86
Commonly Used Properties ......................... 11-86
To0lbarS .ot e e e 11-87
Displaying and Modifying the Standard Toolbar ........ 11-90

Designing for Cross-Platform Compatibility ......... 11-92
Default System Font ............................... 11-92
Standard Background Color ......................... 11-93
Cross-Platform Compatible Units .................... 11-94

Programming the GUI

12

Introduction .......... ... .. . . . . .. . 12-2
Initializing the GUI ................................ 12-4
Examples .......... . . e 12-5
Callbacks: An Overview ...............cciiieeennnn. 12-9
What Is a Callback? .............. ... ..., 12-9
Kindsof Callbacks ...........cciiiiiiinnnnnnnn. 12-10
Providing Callbacks for Components .................. 12-13
Examples: Programming GUI Components ........... 12-22
Programming User Interface Controls ................. 12-22
Programming Panels and Button Groups .............. 12-30
Programming Axes ........ . ... 12-33
Programming ActiveX Controls ...................... 12-36
Programming Menu Items .......................... 12-36
Programming Toolbar Tools ......................... 12-39

Contents



Managing Application-Defined Data

13

Mechanisms for Managing Data ..................... 13-2
OVeIVIBW & ittt ettt ettt e e 13-2
Nested Functions .......... ... ... .. .. 13-4
UserData Property .......... ... ... 13-5
ApplicationData .............. ... i 13-6
GUIData ... ..ottt e et e e 13-8

Sharing Data Among a GUT’s Callbacks .............. 13-11
Sharing Data with Nested Functions ................. 13-11
Sharing Data with UserData ........................ 13-15
Sharing Data with Application Data .................. 13-18
Sharing Data with GUI Data ........................ 13-21

Managing Callback Execution

14

Callback Interruption .............................. 14-2
Callback Execution .............ciiiiiiinnnennnn.. 14-2
How the Interruptible Property Works ................ 14-2
How the Busy Action Property Works ................. 14-4
Example ....... ... .. . . 14-4

Examples of GUIs Created Programmatically

15

Introduction ........... ... ... . ... i . 15-2
GUI with Axes, Menu, and Toolbar .................. 15-3
About the Axes, Menu, and Toolbar Example ........... 15-3
Viewing and Running the AxesMenuToolbar GUI
M-Files ..ot e e e e 15-5
Generating the Graphing Commands and Data ......... 15-6

. 4%



Creating the GUI and Its Components ................ 15-7

Initializingthe GUI . ............. ... ... ... ... ... 15-12
Defining the Callbacks ............... ... ..., 15-13
Helper Function: Plotting the Plot Types .............. 15-17
GUI that Displays and Graphs Tabular Data ......... 15-18
About the tableplot Example ........................ 15-18
Viewing and Running the tableplot GUI M-File ......... 15-22
Setting Up and Interacting with the uitable ............ 15-23
Subfunction Summary for tableplot ................... 15-29
Further Explorations with tableplot .................. 15-29

A GUI That Manages List Data ...................... 15-32
About the List Master Example ...................... 15-32
Viewing and Running the List Master GUI M-File ...... 15-35
Using List Master ..........c0 i, 15-36
Programming List Master .......................... 15-41
Adding an “Import from File” Option to List Master ..... 15-49
Adding a “Rename List” Option to List Master .......... 15-49
Color Palette ............ ... .ttt iiiiiiiinnnnn. 15-50
About the Color Palette Example ..................... 15-50
Techniques Used in the Color Palette Example ......... 15-54
Viewing and Running the Color Palette GUI M-File ..... 15-54
Subfunction Summary for Color Palette ............... 15-55
M-File Structure .......... ..ttt 15-56
GUI Programming Techniques ....................... 15-57
IconEditor .......... ... i 15-62
About the Example ......... .. ... . .. 15-62
Viewing and Running the Icon Editor GUI M-Files ...... 15-64
Subfunction Summary ........... ..., 15-67
M-File Structure ...........ciiiiiiiiiiiinn. 15-69
GUI Programming Techniques ....................... 15-69
Examples

Simple Examples (GUIDE) .......................... A-2

xvi Contents



Simple Examples (Programmatic) ................... A-2

Application Examples (GUIDE) ..................... A-2
Programming GUI Components (GUIDE) ............ A-2
Application-Defined Data (GUIDE) .................. A-3
GUI Layout (Programmatic) ........................ A-3
Programming GUI Components (Programmatic) ..... A-3
Application-Defined Data (Programmatic) ........... A-14
Application Examples (Programmatic) .............. A-14

Index

xXvii



Contents



Introduction to Creating GUIs

Chapter 1, About GUIs in
MATLAB Software (p. 1-1)

Chapter 2, Creating a Simple
GUI with GUIDE (p. 2-1)

Chapter 3, Creating a Simple
GUI Programmatically (p. 3-1)

Explains what a GUI is, how
a GUI works, and how to get
started creating a GUL.

Steps you through the process
of creating a simple GUI using
GUIDE.

Steps you through the process
of creating a simple GUI
programmatically.






About GUIs in MATLAB
Software

e “What Is a GUI?” on page 1-2

e “How Does a GUI Work?” on page 1-4

e “Where Do I Start?” on page 1-6

e “Ways to Build MATLAB GUIs” on page 1-8



1 About GUIs in MATLAB® Software

What Is a GUI?

A graphical user interface (GUI) is a graphical display in one or more
windows containing controls, called components, that enable a user to perform
interactive tasks. The user of the GUI does not have to create a script or
type commands at the command line to accomplish the tasks. Unlike coding
programs to accomplish tasks, the user of a GUI need not understand the
details of how the tasks are performed.

GUI components can include menus, toolbars, push buttons, radio buttons,
list boxes, and sliders—just to name a few. GUIs created using MATLAB®
tools can also perform any type of computation, read and write data files,

communicate with other GUIs, and display data as tables or as plots.

The following figure illustrates a simple GUI that you can easily build
yourself.

<) simple_gui M=

Surf |
hesh |
Cortour |

Select Data

IPeaks - I

The GUI contains

® An axes component

® A pop-up menu listing three data sets that correspond to MATLAB
functions: peaks, membrane, and sinc

® A static text component to label the pop-up menu
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What Is a GUI2

® Three buttons that provide different kinds of plots: surface, mesh, and
contour

When you click a push button, the axes component displays the selected data
set using the specified type of 3-D plot.
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How Does a GUI Work?

In the GUI described in “What Is a GUI?” on page 1-2, the user selects a data
set from the pop-up menu, then clicks one of the plot type buttons. The mouse
click invokes a function that plots the selected data in the axes.

Most GUIs wait for their user to manipulate a control, and then respond

to each action in turn. Each control, and the GUI itself, has one or more
user-written routines (executable MATLAB code) known as callbacks, named
for the fact that they “call back” to MATLAB to ask it to do things. The
execution of each callback is triggered by a particular user action such as
pressing a screen button, clicking a mouse button, selecting a menu item,
typing a string or a numeric value, or passing the cursor over a component.
The GUI then responds to these events. You, as the creator of the GUI, provide
callbacks which define what the components do to handle events.

This kind of programming is often referred to as event-driven programming. In
the example, a button click is one such event. In event-driven programming,
callback execution is asynchronous, that is, it is triggered by events external to
the software. In the case of MATLAB GUIs, most events are user interactions
with the GUI, but the GUI can respond to other kinds of events as well, for
example, the creation of a file or connecting a device to the computer.

You can code callbacks in two distinct ways:

e As MATLAB functions, written in M and stored in M-files

® As strings containing MATLAB expressions or commands (such as 'c =
sqgrt(a*a + b*b);'or 'print')

Using functions stored in M-files as callbacks is preferable to using strings,
as functions have access to arguments and are more powerful and flexible.
MATLAB scripts (sequences of statements stored in M-files that do not define
functions) cannot be used as callbacks.

Although you can provide a callback with certain data and make it do
anything you want, you cannot control when callbacks will execute. That

is, when your GUI is being used, you have no control over the sequence of
events that trigger particular callbacks or what other callbacks might still be



How Does a GUI Work?2

running at those times. This distinguishes event-driven programming from
other types of control flow, for example, processing sequential data files.
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1 About GUIs in MATLAB® Software

Where Do | Start?

Before starting to construct a GUI you have to design it. At a minimum,
you have to decide:

Who the GUI users will be
What you want the GUI to do

® How users will interact with the GUI

What components the GUI requires to function

When designing any software, you need to understand the purposes a new
GUI needs to satisfy. You or the GUI’s potential users should document user
requirements as completely and precisely as possible before starting to build
it. This includes specifying the inputs, outputs, displays, and behaviors of the
GUI and the application it controls. After you design a GUI, you need to
program each of its controls to operate correctly and consistently. Finally, you
should test the completed or prototype GUI to make sure that it behaves as
intended under realistic conditions. (Or better yet, have someone else test it.)
If testing reveals design or programming flaws, iterate the design until the
GUI works to your satisfaction. The following diagram illustrates the main
aspects of this process.

1-6
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Designing a Graphical User Interface

Understand
Requirements
» Purpose

* Use cases

e Interactivity
* Functionality

Specify GUI(s)
* Inputs

 Controls
* Displays
 Behavior
* Outputs

Add
another
window or
dialog?

Design GUI(s)
» Sequencing
» Grouping

* Labeling

* Styling

A

i

mock-up or prototype

lterate as needed

Y

Generate GUI(s)
* via GUIDE
* Via programming

Program GUI(s)
* Initialization
« Actions

« Coordination
» Data management
» Shutdown

Test GUI(s)

» Unusual inputs
* Default actions
* Error handling

» Wrong results

» Ease of use

“Designing a GUI” on page 6-2 lists several references to help you design GUIs.

You also must decide what technique you want to use to create your GUIL.
For more information, see the next section, “Ways to Build MATLAB GUIs”

on page 1-8.
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1 About GUIs in MATLAB® Software

Ways to Build MATLAB GUIs

A MATLAB GUI is a figure window to which you add user-operated controls.
You can select, size, and position these components as you like. Using
callbacks you can make the components do what you want when the user
clicks or manipulates them with keystrokes.

You can build MATLAB GUIs in two ways:

e Use GUIDE (GUI Development Environment), an interactive GUI
construction kit.

® Create M-files that generate GUIs as functions or scripts (programmatic
GUI construction).

The first approach starts with a figure that you populate with components
from within a graphic layout editor. GUIDE creates an associated M-file
containing callbacks for the GUI and its components. GUIDE saves both
the figure (as a FIG-file) and the M-file. Opening either one also opens the
other to run the GUI.

In the second, programmatic, GUI-building approach, you code an M-file
that defines all component properties and behaviors; when a user executes
the M-file, it creates a figure, populates it with components, and handles user
interactions. The figure is not normally saved between sessions because the
M-file creates a new one each time it runs.

As a result, the M-files of the two approaches look different. Programmatic
M-files are generally longer, because they explicitly define every property of
the figure and its controls, as well as the callbacks. GUIDE GUIs define
most of the properties within the figure itself. They store the definitions in
its FIG-file rather than in its M-file. The M-file contains callbacks and other
functions that initialize the GUI when it opens.

MATLAB software also provides functions that simplify the creation of
standard dialog boxes, for example to issue warnings or to open and save
files. The GUI-building technique you choose depends on your experience,
your preferences, and the kind of application you need the GUI to operate.
This table outlines some possibilities.

1-8



Ways to Build MATLAB® GUIs

Type of GUI

Technique

Dialog box

MATLAB software provides a
selection of standard dialog boxes
that you can create with a single
function call. For links to these
functions, see “Predefined Dialog
Boxes” in the GUI Development
section of the MATLAB Function
Reference documentation.

GUI containing just a few
components

It is often simpler to create GUIs
that contain only a few components
programmatically. You can fully
define each component with a single
function call.

Moderately complex GUIs

GUIDE simplifies the creation of
moderately complex GUIs.

Complex GUIs with many
components, and GUIs that
require interaction with other GUIs

Creating complex GUIs
programmatically lets you control
exact placement of the components
and provides reproducibility.

You can combine the two approaches to some degree. You can create a GUI
with GUIDE and then modify it programmatically. However, you cannot
create a GUI programmatically and later modify it with GUIDE.

After you decide which technique you want to use, you can continue to learn
about creating GUIs in MATLAB by following the examples contained in:

® Chapter 2, “Creating a Simple GUI with GUIDE”

e Chapter 3, “Creating a Simple GUI Programmatically”



1 About GUIs in MATLAB® Software

1-10



Creating a Simple GUI with
GUIDE

e “GUIDE: A Brief Introduction” on page 2-2
¢ “Example: Simple GUI” on page 2-9

¢ “Laying Out a Simple GUI” on page 2-11

* “Saving the GUI Layout” on page 2-25

® “Programming a Simple GUI” on page 2-28
¢ “Running the GUI” on page 2-36
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GUIDE: A Brief Introduction

In this section...

“What Is GUIDE?” on page 2-2
“Opening GUIDE” on page 2-2
“Laying Out a GUI” on page 2-7
“Programming a GUI” on page 2-8

What Is GUIDE?

GUIDE, the MATLAB Graphical User Interface Development Environment,
provides a set of tools for creating graphical user interfaces (GUIs). These
tools greatly simplify the process of laying out and programming GUIs.

Opening GUIDE
There are several ways to open GUIDE from the MATLAB Command line.

Command Result

guide Opens GUIDE with a choice of GUI templates
guide FIG-file Opens FIG-file name in GUIDE

name

You can also right-click a FIG-file in the Current Folder Browser and select
Open in GUIDE from the context menu.
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|Currenl: Directory =0 a x Command Window
@ & [T <« creating_guis » examp Open Enter [F_I¢
0 |Name £ ISize |Dats Run File =
ﬂ Fl4ex.m 15KB 2[4/ View Help = Lett
@ Flaex_help.html 2KB 5[4/ Openas Text | clc
| globegui.fig 4 cle
4 glgbegui.m . 14 KB 61'35%331:
j guide_colorpalette fig 49 KB  6/2¢

%) quide_colorpalettem 4KB  6/2¢  Rename F2 it
“j quide_iconeditor.fig 4 KB 6/2¢ Delete Delete L9
“j quide_iconeditor.m 13KB  8f2¢

#) guide_toolpalette.fig 44KB  gf2¢  COMPATE Selected Files =1p.
#) guide_toolpalette.m  7KB  §/2¢  Compare Against L
# iconEditar.m 17KB  1f2¢|  Source Contral ]

#Y iconRead.m 2KB B[

— — Cuk Chrl+

globegui.fig (FIG Filz) Capy crlic —
4 Startl Paste Chrl+V

When you right-click a FIG-file in this way, the figure opens in the GUIDE
Layout Editor, where you can work on it.
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Tag: figurel Current Point: [378, 274] Position: [520, 373, 565, 427]

All tools in the tool palette have tool tips. Setting a GUIDE preference lets
you display the palette in GUIDE with tool names or just their icons. See
“GUIDE Preferences” on page 5-2 for more information.

Getting Help in GUIDE

When you open GUIDE to create a new GUI, a gridded layout area displays.
It has a menu bar and toolbar above it, a tool palette to its left, and a status
bar below it, as shown below. See “GUIDE Tools Summary” on page 4-3 for
a full description. At any point, you can access help topics from the GUIDE
Help menu, shown in the following illustration.
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ol

File Edit View Layout Tools | Help

NS | & ™ @ 9 GetingStarted Db

Laying Ouk GUIs =
Programming GUIs

3
= Example GUIs
® |4 Online Video Demaos
[exfT | [THT
== | =
El
[l
B
Tag: figurel Current Point: [2, 64] Position: [560, 677, 383, 271]

The first three options lead you to topics in the GUIDE documentation that
can help you get started using GUIDE. The Example GUIs option opens a
list of complete examples of GUIs built using GUIDE that you can browse,

study, open in GUIDE, and run.

The bottom option, Online Video Demos, opens a list of GUIDE- and related
GUI-building video tutorials on MATLAB Central. You can access MATLAB
video demos, as well as the page on MATLAB Central by clicking links in the
following table.
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Type of Video

Video Content

MATLAB New Feature
Demos

New Graphics and GUI Building Features in
Version 7.6 (9 min, 31 s)

New Graphics and GUI Building Features in
Version 7.5 (2 min, 47 s)

New Creating Graphical User Interfaces features
in Version 7 (4 min, 24 s)

MATLAB Central Video
Tutorials

Archive for the “GUI or GUIDE” Category from
2005 to present.

Note You must be connected to the Internet to play the videos, which run in
your system browser and require the Adobe® Flash® Player plug-in.

Most of the MATLAB Central video tutorials are informal and brief, lasting 5
min. or less. Each covers a specific topic, such as “Accessing data from one
widget to another in GUIDE.” See the following static screen shot of one such
video. (The video does not play when you click this illustration.)


http://www.mathworks.com/support/2008b/matlab/7.7/demos/WhatsNewR2008a_GraphicsAndGUIBuilding.html
http://www.mathworks.com/support/2008b/matlab/7.7/demos/WhatsNewR2008a_GraphicsAndGUIBuilding.html
http://www.mathworks.com/support/2008b/matlab/7.7/demos/WhatsNewR2008a_GraphicsAndGUIBuilding.html
http://www.mathworks.com/support/2008b/matlab/7.7/demos/WhatsNewR2007b_GraphicsAndGUIBuilding.html
http://www.mathworks.com/support/2008b/matlab/7.7/demos/WhatsNewR2007b_GraphicsAndGUIBuilding.html
http://www.mathworks.com/support/2008b/matlab/7.7/demos/WhatsNewR2007b_GraphicsAndGUIBuilding.html
http://www.mathworks.com/support/2008b/matlab/7.7/demos/WhatsNew_6GUIs_viewlet_swf.html
http://www.mathworks.com/support/2008b/matlab/7.7/demos/WhatsNew_6GUIs_viewlet_swf.html
http://blogs.mathworks.com/videos/category/gui-or-guide/

GUIDE: A Brief Introduction

May 13th, 2008

Accessing data from one widget to another in GUIDE

Last time, I showed how to add the newly documented UITABLE to a GUI. [dick here] There were a few questions [dick
here] about how to access the data in the UITABLE from the callback of another widget. The answer to this question is

applicable to all widgets, not just UITABLES. Basically, you are using the handles structure to access the handle of another
control, then using the GET command to query it for its data.

B ®

Files Pod

Authors add new tutorials to the set over time. Bookmark this page and
revisit it occasionally to see them.

Laying Out a GUI

The GUIDE Layout Editor enables you to populate a GUI by clicking and
dragging GUI components into the layout area. There you can resize, group
and align buttons, text fields, sliders, axes, and other components you add.
Other tools accessible from the Layout Editor enable you to:

2-7
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® (Create menus and context menus

Create toolbars

Modify the appearance of components

Set tab order
e View a hierarchical list of the component objects

e Set GUI options

The following topic, “Laying Out a Simple GUI” on page 2-11, uses some
of these tools to show you the basics of laying out a GUIL. “GUIDE Tools
Summary” on page 4-3 describes the tools.

Programming a GUI

When you save your GUI layout, GUIDE automatically generates an M-file
that you can use to control the way the GUI works. This M-file provides code
to initialize the GUI and organizes the GUI callbacks. Callbacks are functions
that execute in response to user-generated events, such as a mouse click.
Using the M-file editor, you can add code to the callbacks to perform the
functions you want. “Programming a Simple GUI” on page 2-28 shows you
what code to add to the example M-file to make the GUI work.



Example: Simple GUI

Example: Simple GUI

In this section...

“Simple GUI Overview” on page 2-9

“View Completed Layout and Its GUI M-File” on page 2-10

Simple GUI Overview

This section shows you how to use GUIDE to create the graphical user
interface (GUI) shown in the following figure.

<) simple_qui H=

—

Surt |ﬁi*xhxxh

Mash — push buttons
| —"
Contour | /
Select Dats —— | static text

[peaks ~| ———— pop-up menu

axes
The GUI contains

®* An axes component

® A pop-up menu listing three different data sets that correspond to MATLAB
functions: peaks, membrane, and sinc

® A static text component to label the pop-up menu

® Three push buttons, each of which displays a different type of plot: surface,
mesh, and contour
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To use the GUI, select a data set from the pop-up menu, then click one of the
plot-type buttons. Clicking the button triggers the execution of a callback that
plots the selected data in the axes.

Subsequent topics, starting with “Laying Out a Simple GUI” on page 2-11,
guide you through the steps to create this GUIL. We recommend that you
create the GUI for yourself as the best way to learn how to use GUIDE.

View Completed Layout and Its GUI M-File

If you are reading this in the MATLAB Help browser, you can click the
following links to display this example in the GUIDE Layout Editor and the
MATLAB Editor.

Note The following links execute MATLAB commands and are designed to
work within the MATLAB Help browser. If you are reading this online or in
PDF, go to the corresponding section in the MATLAB Help Browser to use
the links.

® (Click here to display this GUI in the Layout Editor.
® (lick here to display the GUI M-file in the MATLAB Editor.

2-10



Laying Out a Simple GUI

Laying Out a Simple GUI

In this section...

“Opening a New GUI in the Layout Editor” on page 2-11
“Setting the GUI Figure Size” on page 2-14

“Adding the Components” on page 2-15

“Aligning the Components” on page 2-16

“Adding Text to the Components” on page 2-18

“Completed Layout” on page 2-23

Opening a New GUI in the Layout Editor

1 Start GUIDE by typing guide at the MATLAB prompt. The GUIDE Quick
Start dialog displays, as shown in the following figure.

—iEix

Create New GUT | open Existing GUI |

GUIDE templates rPreview
<\ Blank GUI (Default)

<\ GUI with Uicontrols

4\ GUI with Axes and Menu
4\ Madal Question Dialag

BLANK

[~ Save new figure as: |C:\Work|GBT|GUIDE |examples|mygui.fig

QK I Cancel Help
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2 Creating a Simple GUI with GUIDE

2 In the Quick Start dialog, select the Blank GUI (Default) template.
Click OK to display the blank GUI in the Layout Editor, as shown in the
following figure.

ol

File Edit Wew Layout Tools Help

EEFIEE L IR

50 100 150 Z00 E50 200 250 200 a50 500 -

]

o
=
=

g|E|0]3|e|E ]
]

ls7

st

Tag: figurel Current Point: [10, 53] Pasition: [520, 410, 536, 390]
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3 Display the names of the GUI components in the component palette. Select
Preferences from the MATLAB File menu. Then select GUIDE > Show
names in component palette, and click OK. The Layout Editor then
appears as shown in the following figure.

-1l

File Edit View Layout Tools Help

EEFIEE L R EEEEEIEERE

5g 100 150 200 z50 200 250 400
k Select

Push Button

= Slider
#® Radio Button
b check Box

[eofT Edit Text

T Skatic Text
== Pop-up Manu
El Listbox

Tagale Butkan
E Table
i{ﬂ Axes

] Panel

|E Button Group

=X ActiveX Control

Tag: figural Current Poink: [S5, 164] Paosition: [520, 432, 450, 368]
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Setting the GUI Figure Size

Set the size of the GUI by resizing the grid area in the Layout Editor. Click
the lower-right corner and drag it until the GUI is approximately 3 in. high
and 4 in. wide. If necessary, make the window larger.

-Iolx

File Edt View Layout Tools Help

OCHd|e BBy o | 2EBHhE 8H3% B

50 100 150 zoa zs0 200 asao 200 25C a
R Select

Push Button

e Slider
@ Radio Button
[ CheckBox @

[ Edit Text

&

T#T] Static Text

z

= Pop-up Manu
=l Listhox

154
&7

Togale Buttan
E Table

id Axes

[%] Panel

|E Button Group

118

Click and drag
corner to resize

2]

=¥ ActiveX, Contral 5 -
-

4 »

Tag: figurel Current Point: [55, 164] Position: [520, 432, 450, 368]
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Adding the Components

1 Add the three push buttons to the GUI. Select the push button tool from
the component palette at the left side of the Layout Editor and drag it
into the layout area. Create three buttons this way, positioning them
approximately as shown in the following figure.

R=EY
File Edit Wiew Layout Tools Help

EEEIEERIE

0 z

200 L] 200 250 200 50 £00 SJAI

AEEITELERE

k Select |

1

e Slider

® Radio Button Push Button |
B check Box

Z27E

el Edit Text

11! Skatic Text

o0
o Push Button |

=3 Pop-up Menu
E] Listbax

178

. .
— Push Button I
Toggle Button ] . :I_

El 1abl=
i{i Axes

] Panel

g

1

&

["&] Buttan Graup

25

=X ActiveX Contral

-
1 [»

Tag: pushbutton3 Current Point: [488, 144] Position: [415, 151, 69, 22]

2 Add the remaining components to the GUL
® A static text area
® A pop-up menu

®* An axes
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2-16

Arrange the components as shown in the following figure. Resize the axes

component to approximately 2-by-2 inches.

i untitled.fig B[] 4
File Edit Wiew Layout Tools Help
¥ =,
Ncd| R o |2 B64 0% P
Loo 150 zoo z50 200 250 0 aso £ £
k Select | | ';I
Push Button
e Slider :
#® Radio Button Push Button |
B check Box E
el Edit Text
- axes]
T Skatic Texk o Push E'““ﬂl_—
=3 Pop-up Menu
£ Listbox £
Push Buttan
Toggle Button
El 1abl= 4
; i Push Button |
] Panel i
T | — | IPO -up Menu vI
["&] Buttan Graup an p-up
EX ActiveX Control b4
-
1 [»
Tag: axesl Current Point: [374, 58] Position: [103, 62, 268, 261]

Aligning the Components

If several components have the same parent, you can use the Alignment Tool

to align them to one another. To align the three push buttons:

1 Select all three push buttons by pressing Ctrl and clicking them.

2 Select Align Objects from the Tools menu to display the Alignment Tool.




Laying Out a Simple GUI

3 Make these settings in the Alignment Tool, as shown in the following figure:
® 20 pixels spacing between push buttons in the vertical direction.

o Left-aligned in the horizontal direction.

wf untitled.fig -1o] x|
File Edit Wiew Layout Tools Help
¥ =
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Push Button |
Toggle Button T S—— . .
El 1abl= §-— : = =
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Kl [
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i untitled.fig

File Edit Wiew Layout Tools Help

4 Click OK. Your GUI now looks like this in the Layout Editor.
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Adding Text to the Components
The push buttons, pop-up menu, and static text have default labels when you
create them. Their text is generic, for example Push Button 1. Change the
text to be specific to your GUI, so that it explains what the component is for.
This topic shows you how to modify the default text.
¢ “Labeling the Push Buttons” on page 2-19

¢ “Entering Pop-Up Menu Items” on page 2-21

¢ “Modifying the Static Text” on page 2-22
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After you have added the appropriate text, the GUI will look like this in the
Layout Editor.
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Labeling the Push Buttons

Each of the three push buttons lets the GUI user choose a plot type: surf,
mesh, and contour. This topic shows you how to label the buttons with those
choices.

1 Select Property Inspector from the View menu.
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E Inspector: figure {(Untitled)
BackingStore on -
BeingDeleted off
Busyhction queus -
ButtonDaownFcn & L
Clipping an -
CloseRequestFen closereq @
Color e Y -
CreateFcn &
CurrentCharacker a &
CurrentPoint [-0.2-0.077]
DieleteFon &
DockContrals an T .

2 In the layout area, select the top push button by clicking it.

Push Button |
n "

| Push Button

—— Push Button I_

3 In the Property Inspector, select the String property and then replace the
existing value with the word Surf.

i Inspector: uicontrol (pushbutton1 “Push Butto... =] E3
SelectionHighlight on v .
SliderStep [0,01 0.1]
Style pushbutton oy i
Tag pushbuttoni &

4 Click outside the String field. The push button label changes to Surf.
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Surt

Push Button

—— Push Buttan =

ki

5 Select each of the remaining push buttons in turn and repeat steps 3 and 4.
Label the middle push button Mesh, and the bottom button Contour.

Entering Pop-Up Menu ltems

The pop-up menu provides a choice of three data sets: peaks, membrane, and
sinc. These data sets correspond to MATLAB functions of the same name.
This topic shows you how to list those data sets as choices in the pop-menu.

1 In the layout area, select the pop-up menu by clicking it.

2 In the Property Inspector, click the button next to String. The String
dialog box displays.

£ Inspector: uicontrol (popupmenul "Pop-up Me... [I[=]

= |4 ¥ &
B2 (4] = =

SelectiorHighlight an T -
SliderStep [0.01 0.1]
Skyle MAO N | -

Tan Skring B
Fop-up Menu =
=]
4 v
ke | Cancel |
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3 Replace the existing text with the names of the three data sets: Peaks,
Membrane, and Sinc. Press Enter to move to the next line.

String

Feaks =

membrane

Sinc

4 I
0)4 | Cancel |

4 When you have finished editing the items, click OK. The first item in your
list, Peaks, appears in the pop-up menu in the layout area.

IPeaks vl

R ——

Modifying the Static Text
In this GUI, the static text serves as a label for the pop-up menu. The user

cannot change this text. This topic shows you how to change the static text
to read Select Data.

1 In the layout area, select the static text by clicking it.

2 In the Property Inspector, click the button next to String. In the String

dialog box that displays, replace the existing text with the phrase
Select Data.
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E Inspector: uicontrol {(text1 "Static Text™)

AN

[ Slderatep [DOL 0 I] "

Style text
Tag Skring E
TaaltipString Select Data =
=]
l [r[
0] NJ Cancel |
LAY

3 Click OK. The phrase Select Data appears in the static text component
above the pop-up menu.

|
Select Dat:

IPeaks LI
Tt

Completed Layout

In the Layout Editor, your GUI now looks like this and the next step is to

save the layout. The next topic, “Saving the GUI Layout” on page 2-25, tells
you how to save it.
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Saving the GUI Layout

When you save a GUI, GUIDE creates two files, a FIG-file and an M-file. The
FIG-file, with extension .fig, is a binary file that contains a description of the
layout. The M-file, with extension .m, contains the code that controls the GUI.

1 Save and activate your GUI by selecting Run from the Tools menu.
2 GUIDE displays the following dialog box. Click Yes to continue.

CEE——— x|

Activating will save changes to your figure and M-file.
Do you wish to cantinue?

™ Da not show this dialog again.

Yes

1=
o

3 GUIDE opens a Save As dialog box in your current folder and prompts you
for a FIG-file name.

Save As: E
Save in:l 7 waork, j L i gl

File narme: Save I
Save a3 type: IFigu[es [*.fig] j Cancel |

4 Browse to any folder for which you have write privileges, and then enter
the filename simple gui for the FIG-file. GUIDE saves both the FIG-file
and the M-file using this name.
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2-26

5 If the folder in which you save the GUI is not on the MATLAB path,

GUIDE opens a dialog box, giving you the option of changing the current
folder to the folder containing the GUI files, or adding that folder to the
top or bottom of the MATLAB path.

Guoe x
& File O:\Wyaorkisimple_gui.m
is notin current directory or MATLAB path

To continue activation, select one of the following:
ol Change MATLAB current directory

 Add directory to the top of the MATLABR path

 Add directory to the hottorn of the WMATLAB path

QK Cancel

6 GUIDE saves the files simple gui.fig and simple gui.m and activates

the GUI. It also opens the GUI M-file in your default editor.

The GUI opens in a new window. Notice that the GUI lacks the standard
menu bar and toolbar that MATLAB figure windows display. You can add
your own menus and toolbar buttons with GUIDE, but by default a GUIDE
GUI includes none of these components.

When you operate simple gui, you can select a data set in the pop-up
menu and click the push buttons, but nothing happens. This is because the
M-file contains no code to service the pop-up menu and the buttons. The
next topic, “Programming a Simple GUI” on page 2-28, shows you how to
program the GUI to make its controls operate.
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=10l

Surf |
L Mesh |
0.6 Contour |

0.4
select Data

0.2 IPeaks - I

To run a GUI created with GUIDE without opening GUIDE, execute its M-file
by typing its name.

simple_gui
You can also use the run command with the M-file, for example,

run simple_gui

Note Do not attempt to run a GUIDE GUI by opening its FIG-file outside of
GUIDE. If you do so, the figure opens and appears ready to use, but the GUI
does not initialize and its callbacks do not function.
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Programming a Simple GUI

In this section...

“Adding Code to the M-file” on page 2-28
“Generating Data to Plot” on page 2-28
“Programming the Pop-Up Menu” on page 2-31

“Programming the Push Buttons” on page 2-33

Adding Code to the M-file

When you saved your GUI in the previous topic, “Saving the GUI Layout”
on page 2-25, GUIDE created two files: a FIG-file simple gui.fig that
contains the GUI layout, and an M-file simple gui.m that contains the code
that controls how the GUI behaves. The M-file consists of a set of MATLAB
functions (that is, it is not a script). But the GUI did not respond because the
functions contain no code yet to make it work. This topic shows you how to
add code to the M-file to make the GUI do things. There are three steps:

Generating Data to Plot

This topic shows you how to generate the data to be plotted when the GUI
user clicks a button. The opening function generates this data by calling
MATLAB functions. The opening function, which initializes a GUI when it
opens, is the first callback in every GUIDE-generated GUI M-file.

In this example, you add code that creates three data sets to the opening
function. The code uses the MATLAB functions peaks, membrane, and sinc.

1 Display the opening function in the M-file editor. If the GUI M-file,
simple_gui.m, is not already open in your editor, open it by selecting
M-file Editor from the View menu. In the editor, click the function icon
2 on the toolbar, then select simple_gui_OpeningFcn in the pop-up

menu that displays.
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14 % applied to the GUI before simple gui OpeningFunctior
15 % unrecognized property name or invalid walue makes pr
16 5 stop. 41l inputs are passed to sSimple_gul_ OpeningFe
17 5
I_llEi % Faee UL Options on GUIDE'SI Tools menu. Choose "Gi'.iﬂ
4 3
|simple_cquiIsimple_cqui_Openinchn|Ln 43 Cal 1 |OVR 4

The cursor moves to the opening function, which already contains this code:

% --- Executes just before simple_gui is made visible.

function simple_gui_OpeningFcn(hObject, eventdata, handles, varargin)
% This function has no output args, see OutputFcn.

% hObject handle to figure

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

% varargin command line arguments to simple_gui (see VARARGIN)

% Choose default command line output for simple_gui
handles.output = hObject;

% Update handles structure
guidata(hObject, handles);

% UIWAIT makes simple_gui wait for user response (see UIRESUME)
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% uiwait(handles.figurel);

2 Create data for the GUI to plot by adding the following code to the opening
function immediately after the comment that begins % varargin...

% Create the data to plot.
handles.peaks=peaks(35);
handles.membrane=membrane;

[x,y] = meshgrid(-8:.5:8);

r = sqrt(x."2+y."2) + eps;

sinc = sin(r)./r;

handles.sinc = sinc;

% Set the current data value.
handles.current_data = handles.peaks;
surf(handles.current_data)

The first six executable lines create the data using the MATLAB functions
peaks, membrane, and sinc. They store the data in the handles structure,
an argument provided to all callbacks. Callbacks for the push buttons can
retrieve the data from the handles structure.

The last two lines create a current data value and set it to peaks, and then
display the surf plot for peaks. The following figure shows how the GUI
now looks when it first displays.
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) simple_gui ] 4

Surf |
Mesh |
Contour |

select Data

IPeaks - I

40

Programming the Pop-Up Menu

The pop-up menu enables the user to select the data to plot. When the GUI
user selects one of the three plots, MATLAB software sets the pop-up menu
Value property to the index of the selected string. The pop-up menu callback
reads the pop-up menu Value property to determine the item that the menu
currently displays , and sets handles.current_data accordingly.

1 Display the pop-up menu callback in the M-file editor. Right-click the

pop-up menu component in the Layout Editor to display a context menu.
From that menu, select View Callbacks > Callback.
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If the editor is not already open, GUIDE opens it to display the GUI M-file,
and the cursor moves to the pop-menu callback, which already contains
this code:

% --- Executes on selection change in popupmenui.

function popupmenui_Callback(hObject, eventdata, handles)

% hObject handle to popupmenul (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

2 Add the following code to the popupmenu1_Callback after the comment
that begins % handles...

This code first retrieves two pop-up menu properties:

It

String — a cell array that contains the menu contents

Value — the index into the menu contents of the selected data set

then uses a switch statement to make the selected data set the current

data. The last statement saves the changes to the handles structure.
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% Determine the selected data set.

str = get(hObject, 'String');

val = get(hObject, 'Value');

% Set current data to the selected data set.

switch str{val};

case 'Peaks' % User selects peaks.
handles.current_data = handles.peaks;

case 'Membrane' % User selects membrane.
handles.current_data = handles.membrane;

case 'Sinc' % User selects sinc.
handles.current_data = handles.sinc;

end

% Save the handles structure.

guidata(hObject,handles)

Programming the Push Buttons

Each of the push buttons creates a different type of plot using the data
specified by the current selection in the pop-up menu. The push button
callbacks get data from the handles structure and then plot it.
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1 Display the Surf push button callback in the M-file editor. Right-click the
Surf push button in the Layout Editor to display a context menu. From
that menu, select View Callbacks > Callback.

B
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In the editor, the cursor moves to the Surf push button callback in the GUI
M-file, which already contains this code:

% --- Executes on button press in pushbuttoni.

function pushbuttoni_Callback(hObject, eventdata, handles)

% hObject handle to pushbuttoni (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

2 Add the following code to the callback immediately after the comment that
begins % handles...

% Display surf plot of the currently selected data.
surf(handles.current_data);

3 Repeat steps 1 and 2 to add similar code to the Mesh and Contour push
button callbacks.

¢ Add this code to the Mesh push button callback, pushbutton2_Callback:
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% Display mesh plot of the currently selected data.
mesh(handles.current_data);

¢ Add this code to the Contour push button callback,
pushbutton3_Callback:

% Display contour plot of the currently selected data.
contour(handles.current_data);

4 Save the M-file by selecting Save from the File menu.

Your GUI is ready to run. The next topic, “Running the GUI” on page 2-36,
tells you how to do that.
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Running the GUI

In “Programming a Simple GUI” on page 2-28, you programmed the pop-up
menu and the push buttons. You also created data for them to use and
initialized the display. Now you can run your GUI and see how it works.

1 Run your GUI by selecting Run from the Layout Editor Tools menu. If
the GUI is on your MATLAB path or in your current folder, you can also

run it by typing its name, simple_gui, at the prompt. The GUI looks like
this when it first displays:

E

Surf

Mesh

Ek

Contour

Select Data

IPeakS - l

40

Notice that the GUI does not display a menu bar or toolbar, as figures
normally do. By default, omits them because most GUIs do not support all
the operations that the standard menu items and buttons provide. You
can, however, turn on the standard figure toolbar and menu bar, or create
custom ones using the GUIDE Menu Editor and Toolbar Editor, if you
choose. In addition, by default, GUIs created by GUIDE lack controls to
dock them in the MATLAB desktop that normal figures possess. You can
give a GUI docking controls, but it must display a menu bar or a toolbar
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to enable them. For more information, see “How Menus Affect Figure
Docking” on page 6-102.

2 In the pop-up menu, select Membrane, then click the Mesh button. The
GUI displays a mesh plot of The MathWorks™ L-shaped Membrane logo™.

I

Surf |

Contour |

Select Data

IMembrane - I

3 Try other combinations before closing the GUI.

See “A Working GUI with Many Components” on page 6-24 for an example of
a similar GUIDE GUI that features additional types of controls.
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¢ “Example: Simple GUI” on page 3-2

* “Function Summary” on page 3-4

e “Creating a GUI M-File” on page 3-5

¢ “Laying Out a Simple GUI” on page 3-7
e “Initializing the GUI” on page 3-11

® “Programming the GUI” on page 3-14

¢ “Running the Final GUI” on page 3-17
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Example: Simple GUI

Simple GUI Overview

This section shows you how to write M-code that creates the example
graphical user interface (GUI) shown in the following figure.

<) simple_gui M=l E3 |

Surf | \
Mesh | e
Cartour | /

SelectDats — | stafic text

[peaks ~| ——— pop-up menv

™
— push buttons

|

axes

The GUI contains

e An axes

® A pop-up menu listing three data sets that correspond to MATLAB
functions: peaks, membrane, and sinc

® A static text component to label the pop-up menu
¢ Three push buttons, each of which provides a different kind of plot: surface,

mesh, and contour

To use the GUI, the user selects a data set from the pop-up menu, then clicks
one of the plot-type push buttons. Clicking the button triggers the execution
of a callback that plots the selected data in the axes.
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The next topic, “Function Summary” on page 3-4, summarizes the functions
used to create this example GUI.

Subsequent topics guide you through the process of creating the GUI. This
process begins with “Creating a GUI M-File” on page 3-5. We recommend
that you create the GUI for yourself.

View Completed Example

If you are reading this in the MATLAB Help browser, you can click the
following links to display the example GUI and its M-file.

Note The following links execute MATLAB commands and are designed to
work within the MATLAB Help browser. If you are reading this online or
in PDF, you should go to the corresponding section in the MATLAB Help
Browser to use the links.

® (Click here to display the example GUI.
® (lick here to display the GUI M-file in the MATLAB Editor.
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Function Summary
MATLAB software provides a suite of functions for creating GUIs. This topic
introduces you to the functions you need to create the example GUI. Click any

function name to read its documentation.

Functions Used to Create the Simple GUI

Function Description

align Align GUI components such as user interface
controls and axes.

axes Create axes objects.

figure Create figure objects. A GUI is a figure object.

movegui Move GUI figure to specified location on screen.

uicontrol Create user interface control objects, such as

push buttons, static text, and pop-up menus.

Other MATLAB Functions Used to Program the GUI

Function Description

contour Contour graph of a matrix

eps Floating point relative accuracy

get Query object properties

membrane Generate data used in the MATLAB logo (a
demo function)

mesh Mesh plot

meshgrid Generate X and Y arrays for 3-D plots

peaks Example function of two variables.

set Set object properties

sin Sine; result in radians

sqrt Square root

surf 3-D shaded surface plot
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Creating a GUI M-File

Start by creating an M-file for the example GUI. Because the file will contain
functions, it is a function M-file as opposed to a script M-file, which contains a
sequence of MATLAB commands but does not define functions.

1 At the MATLAB prompt, type edit. MATLAB opens the editor.

2 Type or copy the following statement into the editor. This function
statement is the first line in the file.

function simple_gui2

3 Add these comments to the M-file following the function statement. They
are displayed at the command line in response to the help command. They
must be followed by a blank line.

% SIMPLE_GUI2 Select a data set from the pop-up menu, then

% click one of the plot-type push buttons. Clicking the button
% plots the selected data in the axes.

(Leave a blank line here)

4 Add an end statement at the end of the file. This end statement matches
the function statement. Your file now looks like this.

function simple_gui2

% SIMPLE_GUI2 Select a data set from the pop-up menu, then

% click one of the plot-type push buttons. Clicking the button
% plots the selected data in the axes.

end

Note You need the end statement because the example is written using
nested functions. For information about using nested functions, see “Nested
Functions” in the MATLAB Programming Fundamentals documentation.

5 Save the file in your current folder or at a location that is on your MATLAB
path.
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The next section, “Laying Out a Simple GUI” on page 3-7, shows you how to
add components to your GUI.
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Laying Out a Simple GUI

In this section...

“Creating the Figure” on page 3-7
“Adding the Components” on page 3-7

Creating the Figure

In MATLAB software, a GUI is a figure. This first step creates the figure and
positions it on the screen. It also makes the GUI invisible so that the GUI
user cannot see the components being added or initialized. When the GUI has

all its components and is initialized, the example makes it visible.

% Initialize and hide the GUI as it is being constructed.
f = figure('Visible', 'off', 'Position',[360,500,450,285]);

The call to the figure function uses two property/value pairs. The Position
property is a four-element vector that specifies the location of the GUI on the
screen and its size: [distance from left, distance from bottom, width, height].

Default units are pixels.

The next topic, “Adding the Components” on page 3-7, shows you how to add

the push buttons, axes, and other components to the GUI.

Adding the Components

The example GUI has six components: three push buttons, one static text,
one pop-up menu, and one axes. Start by writing statements that add these

components to the GUI. Create the push buttons, static text, and pop-up

menu with the uicontrol function. Use the axes function to create the axes.

1 Add the three push buttons to your GUI by adding these statements to your

M-file following the call to figure.

% Construct the components.
hsurf = uicontrol('Style'

'String', 'Surf’

hmesh = uicontrol('Style’

'String', 'Mesh’

)

H

"pushbutton’',...
'Position',[315,220,70,25]);
"pushbutton',...
'Position',[315,180,70,25]);
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hcontour = uicontrol('Style', 'pushbutton',...
'String', 'Countour', 'Position',[315,135,70,25]);

These statements use the uicontrol function to create the push buttons.
Each statement uses a series of property/value pairs to define a push
button.

Property Description

Style In the example, pushbutton specifies the component as a
push button.

String Specifies the label that appears on each push button.
Here, there are three types of plots: Surf, Mesh, Contour.

Position Uses a four-element vector to specify the location of each
push button within the GUI and its size: [distance from
left, distance from bottom, width, height]. Default units
for push buttons are pixels.

Each call returns the handle of the component that is created.

2 Add the pop-up menu and its label to your GUI by adding these statements
to the M-file following the push button definitions.

hpopup = uicontrol('Style', 'popupmenu’,...
'String',{'Peaks', 'Membrane', 'Sinc'},...
'Position',[300,50,100,25]);

htext = uicontrol('Style', 'text','String', 'Select Data',...

'"Position',[325,90,60,15]);

For the pop-up menu, the String property uses a cell array to specify the
three items in the pop-up menu: Peaks, Membrane, Sinc. The static text
component serves as a label for the pop-up menu. Its String property
tells the GUI user to Select Data. Default units for these components
are pixels.

3 Add the axes to the GUI by adding this statement to the M-file. Set
the Units property to pixels so that it has the same units as the other
components.

ha = axes('Units', 'pixels', 'Position',[50,60,200,185]);
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4 Align all components except the axes along their centers with the following
statement. Add it to the M-file following all the component definitions.

align([hsurf,hmesh,hcontour,htext,hpopup], 'Center', 'None');

5 Make your GUI visible by adding this command following the align
command.

set(f,'Visible','on')
6 This is what your M-file should now look like:

function simple_gui2

% SIMPLE_GUI2 Select a data set from the pop-up menu, then

% click one of the plot-type push buttons. Clicking the button
% plots the selected data in the axes.

% Create and hide the GUI as it is being constructed.
f = figure('Visible','off', 'Position',[360,500,450,285]);

% GConstruct the components.

hsurf = uicontrol('Style', 'pushbutton','String', 'Surf',...
'Position',[315,220,70,25]);

hmesh = uicontrol('Style', 'pushbutton', 'String', '‘Mesh',...
‘Position',[315,180,70,25]);

hcontour = uicontrol('Style', 'pushbutton’,...
‘String', 'Countour’',...
'Position',[315,135,70,25]);

htext = uicontrol('Style', 'text', 'String', 'Select Data',...
'Position',[325,90,60,15]);

hpopup = uicontrol('Style', 'popupmenu’,...
‘String', {'Peaks', 'Membrane', 'Sinc'}, ...
‘Position',[300,50,100,25]);

ha = axes('Units', 'Pixels', 'Position',[50,60,200,185]);

align([hsurf,hmesh,hcontour,htext,hpopup], 'Center', 'None');

%Make the GUI visible.
set(f,'Visible','on"')

end
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3-10

7 Run your M-file by typing simple gui2 at the command line. This is what
your GUI now looks like. Note that you can select a data set in the pop-up
menu and click the push buttons. But nothing happens. This is because
there 1s no code in the M-file to service the pop-up menu or the buttons.

hFguet ~=lol x|

File Edit ‘iew Insert Tools Deskbop  Window  Help o

Surf |
0a
Mesh |
06
Courtaur |
0.4
02 Select Data
0 IPeaks - I
0] (03] 1

8 Type help simple gui2 at the command line. MATLAB software displays
this help text.

help simple_gui2
SIMPLE_GUI2 Select a data set from the pop-up menu, then
click one of the plot-type push buttons. Clicking the button
plots the selected data in the axes.

The next topic, “Initializing the GUI” on page 3-11, shows you how to initialize
the GUL
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Initializing the GUI

When you make the GUI visible, it should be initialized so that it is ready for

the user. This topic shows you how to

Make the GUI behave properly when it is resized by changing the
component and figure units to normalized. This causes the components to
resize when the GUI is resized. Normalized units map the lower-left corner
of the figure window to (0,0) and the upper-right corner to (1.0, 1.0).

Generate the data to plot. The example needs three sets of data:
peaks_data, membrane_data, and sinc_data. Each set corresponds to

one of the items in the pop-up menu.

Create an initial plot in the axes

Assign the GUI a name that appears in the window title
Move the GUI to the center of the screen

Make the GUI visible

Replace this code in your M-file:

% Make the GUI visible.
set(f, 'Visible','on')

with this code:

% Initialize the GUI.

% Change units to normalized so components resize automatically.
set([f,hsurf,hmesh,hcontour,htext,hpopup], 'Units', 'normalized');

% Generate the data to plot.

peaks_data = peaks(35);
membrane_data = membrane;

[X,y] = meshgrid(-8:.5:8);
r = sqrt(x.”2+y.”2) + eps;

sinc_data = sin(r)./r;

% Create a plot in the axes.
current_data = peaks_data;

surf(current_data);

% Assign the GUI a name to appear in the window title.

set(f, 'Name', 'Simple GUI'")
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% Move the GUI to the center of the screen.
movegui(f, 'center')

% Make the GUI visible.

set(f, 'Visible','on');

2 Verify that your M-file now looks like this:

function simple_guiZ2

% SIMPLE_GUI2 Select a data set from the pop-up menu, then

% click one of the plot-type push buttons. Clicking the button
% plots the selected data in the axes.

% Create and hide the GUI figure as it is being constructed.
f = figure('Visible','off', 'Position',[360,500,450,285]);

% Construct the components

hsurf = uicontrol('Style', 'pushbutton','String', 'Surf',...
'Position',[315,220,70,25]);

hmesh = uicontrol('Style', 'pushbutton','String', '‘Mesh',...
'Position',[315,180,70,25]);

hcontour = uicontrol('Style', 'pushbutton',...
'String', 'Countour’',...
'"Position',[315,135,70,25]);

htext = uicontrol('Style', 'text', 'String', 'Select Data',...
'"Position',[325,90,60,15]);

hpopup = uicontrol('Style', 'popupmenu’,...
‘String', {'Peaks', 'Membrane', 'Sinc'}, ...
'"Position',[300,50,100,25]);

ha = axes('Units','Pixels', 'Position',[50,60,200,185]);

align([hsurf,hmesh,hcontour,htext,hpopup], 'Center', 'None');

% Create the data to plot
peaks_data = peaks(35);
membrane_data = membrane;
[x,y] = meshgrid(-8:.5:8);
r = sqrt(x."2+y.”2) + eps;
sinc_data = sin(r)./r;

% Initialize the GUI.

% Change units to normalized so components resize
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% automatically.

set([f,hsurf,hmesh,hcontour,htext,hpopupl],...
‘Units', 'normalized');

%Create a plot in the axes.

current_data = peaks_data;

surf(current_data);

% Assign the GUI a name to appear in the window title.

set(f, 'Name','Simple GUI')

% Move the GUI to the center of the screen.

movegui(f, 'center')

% Make the GUI visible.

set(f,'Visible','on');

end

3 Run your M-file by typing simple gui2 at the command line. The
initialization above cause it to display the default peaks data with the surf
function, making the GUI look like this.

<) Figure 1: Simple GUI i ] 4
File Edit Wew Insert Tools Deskbop ‘Window Help N

Select Data

IPeaks - I

The next topic, “Programming the GUI” on page 3-14, shows you how
to program the push buttons and pop-up menu so you can interactively
generate different plots in the axes.
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Programming the GUI

In this section...

“Programming the Pop-Up Menu” on page 3-14
“Programming the Push Buttons” on page 3-15

“Associating Callbacks with Their Components” on page 3-15

Programming the Pop-Up Menu

The pop-up menu enables users to select the data to plot. When a GUT user
selects one of the three data sets, MATLAB software sets the pop-up menu
Value property to the index of the selected string. The pop-up menu callback
reads the pop-up menu Value property to determine which item is currently
displayed and sets current_data accordingly.

Add the following callback to your file following the initialization code and
before the final end statement.

o°

Pop-up menu callback. Read the pop-up menu Value property to
% determine which item is currently displayed and make it the
% current data. This callback automatically has access to
% current_data because this function is nested at a lower level.
function popup_menu_Callback(source,eventdata)
% Determine the selected data set.
str = get(source, 'String');
val = get(source,'Value');
% Set current data to the selected data set.
switch str{val};
case 'Peaks' % User selects Peaks.
current_data = peaks_data;
case 'Membrane' % User selects Membrane.
current_data = membrane_data;
case 'Sinc' % User selects Sinc.
current_data = sinc_data;
end
end
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The next topic, “Programming the Push Buttons” on page 3-15, shows you
how to write callbacks for the three push buttons.

Programming the Push Buttons

Each of the three push buttons creates a different type of plot using the
data specified by the current selection in the pop-up menu. The push button
callbacks plot the data in current_data. They automatically have access to
current_data because they are nested at a lower level.

Add the following callbacks to your file following the pop-up menu callback
and before the final end statement.

% Push button callbacks. Each callback plots current_data in the
% specified plot type.

function surfbutton_Callback(source,eventdata)

% Display surf plot of the currently selected data.
surf(current_data);

end

function meshbutton_Callback(source,eventdata)

% Display mesh plot of the currently selected data.
mesh(current_data);

end

function contourbutton_Callback(source,eventdata)

% Display contour plot of the currently selected data.
contour(current_data);

end

The next topic shows you how to associate each callback with its specific
component.

Associating Callbacks with Their Components

When the GUI user selects a data set from the pop-up menu or clicks one of
the push buttons, MATLAB software executes the callback associated with
that particular event. But how does the software know which callback to
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execute? You must use each component’s Callback property to specify the
name of the callback with which it is associated.

1 To the uicontrol statement that defines the Surf push button, add the
property/value pair

'Callback', {@surfbutton_Callback}

so that the statement looks like this:
hsurf = uicontrol('Style', 'pushbutton','String', 'Surf',...

‘Position',[315,220,70,25],...
‘Callback',{@surfbutton_Callback});

Callback is the name of the property. surfbutton_Callback is the name
of the callback that services the Surf push button.

2 Similarly, to the uicontrol statement that defines the Mesh push button,
add the property/value pair

‘Callback', {@meshbutton_Callback}

3 To the uicontrol statement that defines the Contour push button, add
the property/value pair

‘Callback', {@contourbutton_Callback}

4 To the uicontrol statement that defines the pop-up menu, add the
property/value pair

‘Callback', {@popup_menu_Callback}

The next topic, “Running the Final GUI” on page 3-17, shows the final M-file
and runs the GUI.
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Running the Final GUI

In this section...
“Final M-File” on page 3-17
“Running the GUI” on page 3-20

Final M-File

This is what your final M-file should now look like:

function simple_gui2

% SIMPLE_GUI2 Select a data set from the pop-up menu, then

% click one of the plot-type push buttons. Clicking the button
% plots the selected data in the axes.

% Create and then hide the GUI as it is being constructed.
f = figure('Visible','off','Position',[360,500,450,285]);

% GConstruct the components.

hsurf = uicontrol('Style', 'pushbutton', 'String', 'Surf',...
'Position',[315,220,70,25],...
‘Callback', {@surfbutton_Callback});

hmesh = uicontrol('Style', 'pushbutton', 'String', 'Mesh', ...
'Position',[315,180,70,25],...
‘Callback', {@meshbutton_Callback});

hcontour = uicontrol('Style', 'pushbutton',...
'String', 'Countour', ...
'Position',[315,135,70,25],...
‘Callback', {@contourbutton_Callback});

htext = uicontrol('Style', 'text','String', 'Select Data',...
'"Position',[325,90,60,15]);

hpopup = uicontrol('Style', 'popupmenu’,...
'String',{'Peaks', 'Membrane', 'Sinc'},...
'Position',[300,50,100,25],...
‘Callback', {@popup_menu_Callback});

ha = axes('Units', 'Pixels', 'Position',[50,60,200,185]);

align([hsurf,hmesh,hcontour,htext,hpopup], 'Center', 'None');
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% Create the data to plot.
peaks_data = peaks(35);
membrane_data = membrane;
[x,y] = meshgrid(-8:.5:8);
r = sqrt(x."2+y.”2) + eps;
sinc_data = sin(r)./r;

% Initialize the GUI.

% Change units to normalized so components resize

% automatically.
set([f,ha,hsurf,hmesh,hcontour,htext,hpopup],...
‘Units', 'normalized');

%Create a plot in the axes.

current_data = peaks_data;

surf(current_data);

% Assign the GUI a name to appear in the window title.
set(f, 'Name','Simple GUI')

% Move the GUI to the center of the screen.

movegui(f, 'center')

% Make the GUI visible.

set(f,'Visible','on');

o°

Callbacks for simple gui2. These callbacks automatically
have access to component handles and initialized data
because they are nested at a lower level.

o°

o°

o°

Pop-up menu callback. Read the pop-up menu Value property
to determine which item is currently displayed and make it
the current data.
function popup_menu_Callback(source,eventdata)
% Determine the selected data set.
str = get(source, 'String');
val = get(source, 'Value');
% Set current data to the selected data set.
switch str{val};
case 'Peaks' % User selects Peaks.
current_data = peaks_data;
case 'Membrane’ User selects Membrane.
current_data membrane_data;
case 'Sinc' % User selects Sinc.

o°

o°

I o° 1
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current_data = sinc_data;
end
end

% Push button callbacks. Each callback plots current_data in
% the specified plot type.

function surfbutton_Callback(source,eventdata)

% Display surf plot of the currently selected data.
surf(current_data);

end

function meshbutton_Callback(source,eventdata)

% Display mesh plot of the currently selected data.
mesh(current_data);

end

function contourbutton_Callback(source,eventdata)

% Display contour plot of the currently selected data.
contour(current_data);

end

end
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Running the GUI

1 Run the simple GUI by typing the name of the M-file at the command line.

simple_gui2

) Figure 1: Simple GUI i =] 3|
File Edit Wew Insert Tools Deskiop ‘Window Help ]

Surf |
Mezh |

Countour |

Select Data

IPeaks - l

2 In the pop-up menu, select Membrane, and then click the Mesh button.
The GUI displays a mesh plot of the MATLAB logo.

) Figure 1: Simple GUL =] E3
]

File Edit Wiew Insert Tools Deskiop ‘Window Help

Countaur |

Select Data

IMembrane - I

3 Try other combinations before closing the GUI.
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Creating GUIs with GUIDE

Chapter 4, What Is GUIDE?
(p. 4-1)

Chapter 5, GUIDE Preferences
and Options (p. 5-1)

Chapter 6, Laying Out a GUIDE
GUI (p. 6-1)

Chapter 7, Saving and Running a
GUIDE GUI (p. 7-1)

Chapter 8, Programming a
GUIDE GUI (p. 8-1)

Chapter 9, Managing and
Sharing Application Data in
GUIDE (p. 9-1)

Chapter 10, Examples of GUIDE
GUIs (p. 10-1)

Introduces GUIDE

Describes briefly the available
MATLAB preferences and GUI
options.

Shows you how to start GUIDE
and from there how to populate
the GUI and create menus.
Provides guidance in designing
a GUI for cross-platform
compatibility.

Describes the files used to store
the GUI. Steps you through the
process for saving a GUI, and
lists the different ways in which
you can activate a GUL

Explains how user-written
callback routines control GUI
behavior. Shows you how to
associate callbacks with specific
components and explains callback
syntax and arguments. Provides
simple programming examples
for each kind of component.

Explains the mechanisms for
managing application-defined
data and explains how to share
data among a GUIs callbacks.

Illustrates techniques for
programming various behaviors.
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e “GUIDE: Getting Started” on page 4-2
e “GUIDE Tools Summary” on page 4-3
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GUIDE: Getting Started

In this section...

“GUI Layout” on page 4-2

“GUI Programming” on page 4-2

GUI Layout

GUIDE, the MATLAB graphical user interface development environment,
provides a set of tools for creating graphical user interfaces (GUIs). These
tools simplify the process of laying out and programming GUIs.

Using the GUIDE Layout Editor, you can populate a GUI by clicking and
dragging GUI components—such as axes, panels, buttons, text fields, sliders,
and so on—into the layout area. You also can create menus and context
menus for the GUIL. From the Layout Editor, you can size the GUI, modify
component look and feel, align components, set tab order, view a hierarchical
list of the component objects, and set GUI options.

GUI Programming

GUIDE automatically generates an M-file that controls how the GUI operates.
This M-file provides code to initialize the GUI and contains a framework for
the GUI callbacks—the routines that execute when a user interacts with a
GUI component. Using the M-file editor, you can add code to the callbacks

to perform the functions you want.

Note MATLAB software provides a selection of standard dialog boxes that
you can create with a single function call. For information about these
dialog boxes and the functions used to create them, see “Predefined Dialog
Boxes” in the GUI Development section of the MATLAB Function Reference
documentation.




GUIDE Tools Summary

GUIDE Tools Summary

Align Objects

@&f untitled.fig

The GUIDE tools are available from the Layout Editor shown in the figure
below. The tools are called out in the figure and described briefly below.
Subsequent sections show you how to use them.
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Use This
Tool...

To...

Layout
Editor

Select components from the component palette, at the left
side of the Layout Editor, and arrange them in the layout
area. See “Adding Components to the GUI” on page 6-19
for more information.

Figure
Resize Tab

Set the size at which the GUI is initially displayed when you
run it. See “Setting the GUI Size” on page 6-15 for more
information.

Menu Editor

Create menus and context, i.e., pop-up, menus. See
“Creating Menus” on page 6-100 for more information.

Align
Objects

Align and distribute groups of components. Grids and rulers
also enable you to align components on a grid with an
optional snap-to-grid capability. See “Aligning Components”
on page 6-88 for more information.

Tab Order
Editor

Set the tab and stacking order of the components in your
layout. See “Setting Tab Order” on page 6-97 for more
information.

Toolbar
Editor

Create Toolbars containing predefined and custom push
buttons and toggle buttons. See “Creating Toolbars” on page
6-121 for more information.

Icon Editor

Create and modify icons for tools in a toolbar. See “Creating
Toolbars” on page 6-121 for more information.

Property
Inspector

Set the properties of the components in your layout. It
provides a list of all the properties you can set and displays
their current values.

Object
Browser

Display a hierarchical list of the objects in the GUI. See
“Viewing the Object Hierarchy” on page 6-135 for more
information.

Run

Save and run the current GUI. See Chapter 7, “Saving and
Running a GUIDE GUI” for more information.
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Use This

Tool... To...

M-File Display, in your default editor, the M-file associated with

Editor the GUI. See “GUI Files: An Overview” on page 8-7 for more
information.

Position Continuously display the mouse cursor position and the

Readouts positions of selected objects

You can also set preferences that apply to all GUIs at creation, and options
that are GUI-specific. See Chapter 5, “GUIDE Preferences and Options” for
more information.
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GUIDE Preferences and
Options

e “GUIDE Preferences” on page 5-2
e “GUI Options” on page 5-9
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GUIDE Preferences

In this section...

“Setting Preferences” on page 5-2
“Confirmation Preferences” on page 5-2

“Backward Compatibility Preference” on page 5-4

“All Other Preferences” on page 5-6

Setting Preferences

You can set preferences for GUIDE by selecting Preferences from the File
menu. These preferences apply to GUIDE and to all GUIs you create.

The preferences are in different locations within the Preferences dialog box:

Confirmation Preferences

GUIDE provides two confirmation preferences. You can choose whether you
want to display a confirmation dialog box when you

e Activate a GUI from GUIDE.
e Export a GUI from GUIDE.
¢ Change a callback signature generated by GUIDE.



GUIDE Preferences

In the Preferences dialog box, click General > Confirmation Dialogs to
access the GUIDE confirmation preferences. Look for the word GUIDE in the
Tool column.

_ioix

EI--Gn:aneraI | General Confirmation Dialogs Preferences

firmation Dialogs The Fallowing dialog boxes require user confirmation. Select a check box if you wank |
--Source Control dialog bax to appear.
g--ﬁeyltnoard IDiang Box Description Tool &
-Fonts
- Colors Warn before deleting Command History items Cammand History
M-Lint Warn before clearing the Command Window Command Window
..... Toolbars Confirm when overwriting variables in MAT files Current Direckory
- Prompt when editing files that do not exist Editor
--Command Window _ o )
) Prompt ko exit debug mode when saving filz Editor
--Command History . ) 3 :
Shaow linking and brushing message bar Figure Window =

-Editor|Debugger
[+ |Debugg GUIDE

s d

--Help a
..... Web £ GUIDE
: Canfirm changing default callback implementation GUIDE
--Current Directory - -
_____ Variable Editor Confirm before exiting MATLAB General
..... Warkspace Warn about missing search databases Help
- GUIDE sz Confirm when deleting variables Waorkspace =
----- Time Series Tools - LI [ 5

QK I Cancel Apply | Help |

Prompt to Save on Activate

When you activate a GUI by clicking the Run button ™ in the Layout Editor,
a dialog box informs you of the impending save and lets you choose whether
or not you want to continue.

cuoe £

Activating will save changes to your figure and h-file.
Do you wish to continue?

™ Do not show this dialog again.

Yes Mo
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Prompt to Save on Export
When you select Export from the Layout Editor File menu, a dialog box
informs you of the impending save and lets you choose whether or not you

want to continue.

Gume x|

@ Exporting will save changes to your figure and hi-file.
Do you wish to continue?

™ Do not show this dialog again.

Y¥es Mo |

Backward Compatibility Preference

MATLAB Version 5 or Later Compatibility

GUI FIG-files created or modified with MATLAB 7.0 or a later MATLAB
version are not automatically compatible with Version 6.5 and earlier
versions. GUIDE automatically generates FIG-files, which are a kind of
MAT-file, to hold layout information for GUIs.
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To make a FIG-file backward compatible, you must go to the MATLAB
Preferences dialog box; select File > Preferences > General > MAT-Files
> MATLAB Version 5 or later (save -v6), as shown in the figure below.

) Preferences

[=l-General

£ MAT-Files
onfirmation Dialogs
Source Contral
[#-Keyboard
[+-Fonts

~Colors

- P-Link

----- Toolbars
--Command Window
-Command Hiskory
[#-Editor [Debugger
Help

..... Web

--Current Direckary
----- Variable Editar

Time Series Tools
[+-Figure Capy Template

GUIDE Preferences

¥ Show names in companent paletke
¥ Show file extension in window Eitle
I~ Show file path in window Eitle

¥ Add comments For newly generated callback functions

QK I Cancel Apply

=1alx]

Help

Note The -v6 option discussed in this section is obsolete and will be removed
in a future version of MATLAB
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All Other Preferences

GUIDE provides several other preferences for the Layout Editor interface
and M-file comments. In the Preferences dialog box, click GUIDE to access
these preferences.

il
El-General GUIDE Preferences
-MAT-Files
Confirmation Dialogs ¥ Show names in companent paletke
“-Source Contral
[+-Keyboard ¥ Show file extension in window title
[#-Fants
- Colors [~ Show file path in window kitle
--M-Link
_____ Toolbars ¥ Add comments for newly generated callback functions

--Command Window
- Command Hiskory
[+-Editor[Debugger
Help

..... Web

--{Zurrent Direckary
----- Variable Editor

----- Workspace

.....

----- Time Series Tools
[#-Figure Copy Template

QK I Cancel | Apply | Help |

The following topics describe the preferences in this dialog:

e “Show Names in Component Palette” on page 5-6

e “Show File Extension in Window Title” on page 5-7

e “Show File Path in Window Title” on page 5-7

¢ “Add Comments for Newly Generated Callback Functions” on page 5-7

Show Names in Component Palette

Displays both icons and names in the component palette, as shown below.
When unchecked, the icons alone are displayed in two columns, with tooltips.
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I k Select

3
[=£] Push Button =
e Siger Component palette with nomes ®
® Radio Button fecfe | e
b4 Check Box = =4
W Component palette without names i

THT Static Text

|4 |
o]

== Pop-up Menu
=l Listhox

[ Togole Button
is‘_‘ﬂA}ces

[Tl Panel

"% Eutton Group
ZX ActiveX Contral

Show File Extension in Window Title

Displays the GUI FIG-file filename with its file extension, .fig, in the Layout
Editor window title. If unchecked, only the filename is displayed.

Show File Path in Window Title

Displays the full file path in the Layout Editor window title. If unchecked,
the file path is not displayed.

Add Comments for Newly Generated Callback Functions
Callbacks are blocks of code or functions that execute in response to actions by
the GUT’s user, such as clicking buttons or manipulating sliders. By default,
GUIDE sets up templates for coding callbacks as function declarations. When
this preference is checked, GUIDE places comment lines at the beginning

of all callback functions that it adds to the M-file. Most of the comments

are similar to the following.

% --- Executes during object deletion, before destroying properties.
function figurei_DeleteFcn(hObject, eventdata, handles)
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% hObject handle to figurel (see GCBO)
% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

Some callbacks are added automatically because their associated components
are part of the original GUIDE template that you chose. Other commonly
used callbacks are added automatically when you add components. You can
also add callbacks explicitly by selecting them from View Callbacks on the
View menu or on the component’s context menu.

If this preference is unchecked, GUIDE includes comments only for callbacks
that are automatically included to support the original GUIDE template. No
comments are included for any other callbacks that are added to the M-file.

See “Callback Syntax and Arguments” on page 8-15 for more information
about callbacks and about the arguments described in the comments above.
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GUI Options

In this section...

“The GUI Options Dialog Box” on page 5-9
“Resize Behavior” on page 5-10
“Command-Line Accessibility” on page 5-10
“Generate FIG-File and M-File” on page 5-11
“Generate FIG-File Only” on page 5-14

The GUI Options Dialog Box

You can use the GUI Options dialog box to configure various behaviors that
are specific to the GUI you are creating. These options take effect when you
next save the GUIL

Access the dialog box by selecting GUI Options from the Layout Editor
Tools menu.

<) GUI Options IS it
Resize behavior: INun-resiza ble j
Command-ine accessikilty: IE‘.aIIbau:k (GUI becomes Current Figure within Callbacks) j

¥ Generate FIG-file and W-file
¥ Generate callback function prototypes
W GUl allows onhy ene inztance to run (zingleton)

v Use system color scheme for background (recommended)

' Generate FIG-file onhy

oK Cancel Help

The following sections describe the options in this dialog box:
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Resize Behavior

You can control whether users can resize the figure window containing your
GUI and how MATLAB software handles resizing. GUIDE provides three
options:

¢ Non-resizable — Users cannot change the window size (default).

¢ Proportional — The software automatically rescales the components in
the GUI in proportion to the new figure window size.

e Other (Use ResizeFcn) — Program the GUI to behave in a certain way
when users resize the figure window.

The first two options set figure and component properties appropriately and
require no other action. Other (Use ResizeFcn) requires you to write a
callback routine that recalculates sizes and positions of the components
based on the new figure size. For a discussion and examples of using a
ResizeFcn, see the GUIDE examples “Panel” on page 8-39 and “An Address
Book Reader” on page 10-81. Also see the example “Using Panel Containers in
Figures — Uipanels”, which does not use GUIDE, in the MATLAB Graphics
documentation.

Command-Line Accessibility

You can restrict access to a GUI figure from the command line or from an
M-file by using the GUIDE Command-line accessibility options.

Unless you explicitly specify a figure handle, many commands, such as plot,
alter the current figure, i.e., the figure specified by the root CurrentFigure
property and returned by the gcf command. The current figure is usually
the figure that is most recently created, drawn into, or clicked in. You can
programmatically designate a figure as the current figure in four ways:

1 set (0, 'CurrentFigure',h) — Makes figure h current, but does not
change its visibility or stacking with respect to other figures

2 figure(h) — Makes figure h current, visible, and displayed on top of other
figures

3 axes(h) — Makes existing axes h the current axes and displays the figure
containing it on top of other figures
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4 plot(h,...), or any plotting function that takes an axes as its first
argument, also makes existing axes h the current axes and displays the
figure containing it on top of other figures

The gcf function returns the handle of the current figure.

h = gcf

For a GUI created in GUIDE, set the Command-line accessibility option
to prevent users from inadvertently changing the appearance or content

of a GUI by executing commands at the command line or from an M-file,
such as plot. The following table briefly describes the four options for

Command-line accessibility.

Option

Description

Callback (GUI becomes Current
Figure within Callbacks)

The GUI can be accessed only
from within a GUI callback. The
GUI cannot be accessed from the
command line or from an M-script.
This is the default.

Off (GUI never becomes Current
Figure)

The GUI can not be accessed from a
callback, the command line, or an
M-script, without the handle.

On (GUI may become Current
Figure from Command Line)

The GUI can be accessed from a
callback, from the command line,
and from an M-script.

Other (Use settings from
Property Inspector)

You control accessibility by
setting the HandleVisibility and
IntegerHandle properties from the
Property Inspector.

Generate FIG-File and M-File

Select Generate FIG-file and M-file in the GUI Options dialog box if
you want GUIDE to create both the FIG-file and the GUI M-file (this is
the default). Once you have selected this option, you can select any of the
following items in the frame to configure the M-file:
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® “Generate Callback Function Prototypes” on page 5-12
e “GUI Allows Only One Instance to Run (Singleton)” on page 5-12
e “Use System Color Scheme for Background” on page 5-13

See “GUI Files: An Overview” on page 8-7 for information about these files.

Generate Callback Function Prototypes

If you select Generate callback function prototypes in the GUI Options
dialog, GUIDE adds templates for the most commonly used callbacks to the
GUI M-file for most components you add to the GUIL You must then write
the code for these callbacks.

GUIDE also adds a callback whenever you edit a callback routine from the
Layout Editor’s right-click context menu and when you add menus to the
GUI using the Menu Editor.

See “Callback Syntax and Arguments” on page 8-15 for general information
about callbacks.

Note This option is available only if you first select the Generate FIG-file
and M-File option.

GUI Allows Only One Instance to Run (Singleton)

This option allows you to select between two behaviors for the GUI figure:

e Allow MATLAB software to display only one instance of the GUI at a time.
e Allow MATLAB software to display multiple instances of the GUI.
If you allow only one instance, the software reuses the existing GUI figure

whenever the command to run the GUI is issued. If a GUI already exists, the
software brings it to the foreground rather than creating a new figure.

If you clear this option, the software creates a new GUI figure whenever you
issue the command to run the GUI.
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Even if you allow only one instance of a GUI to run at once, initialization can
take place each time you invoke it from the command line. For example, the
code in an OpeningFcn will run each time a GUIDE GUI runs unless you take
steps to prevent it from doing so. Adding a flag to the handles structure is one
way to control such behavior. You can do this in the OpeningFcn, which can
run initialization code if this flag doesn’t yet exist and skip that code if it does.

Note This option is available only if you first select the Generate FIG-file
and M-File option.

Use System Color Scheme for Background

The default color used for GUI components is system dependent. This option
enables you to make the figure background color the same as the default
component background color.

If you select Use system color scheme for background (the default),
GUIDE changes the figure background color to match the color of the GUI

components.

The following figures illustrate the results with and without system color
matching.
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Note This option is available only if you first select the Generate FIG-file
and M-File option.

Generate FIG-File Only

The Generate FIG-file only option enables you to open figures and GUIs
to perform limited editing. These can be any figures and need not be GUIs.
GUIs need not have been generated using GUIDE. This mode provides
limited editing capability and may be useful for GUIs generated in MATLAB
Versions 5.3 and earlier. See the guide function for more information.

GUIDE selects Generate FIG-file only as the default if you do one of the
following:

¢ Start GUIDE from the command line and provide one or more figure
handles as arguments.

guide (fh)

In this case, GUIDE selects Generate FIG-file only even though there
may be a corresponding M-file in the same location.
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¢ Start GUIDE from the command line and provide the name of a FIG-file for
which no M-file with the same name exists in the same location.

guide('myfig.fig')

e Use the GUIDE Open Existing GUI tab to open a FIG-file for which no
M-file with the same name exists in the same location.

When you save the figure or GUI with Generate FIG-file only selected,
GUIDE saves only the FIG-file. You must update any corresponding M-files
as appropriate.

If you want GUIDE to manage the GUI M-file for you, change the selection
to Generate FIG-file and M-file before saving the GUI. If there is no
corresponding M-file in the same location, GUIDE creates one. If an M-file
with the same name as the original figure or GUI exists in the same location,
GUIDE overwrites it. To prevent overwriting an existing M-file, save the GUI
using Save As from the File menu and select another filename. You must
update the new M-file as appropriate.

Callbacks for GUIs without M-files

Even when there is no M-file associated with a GUI FIG-file, you can still
provide callbacks for GUI components to make them perform actions when
used. In the Property Inspector, you can type callbacks in the form of strings,
built-in functions, or M-file names; when the GUI runs, it will execute them
if possible. If the callback is an M-file name, it can include arguments. For
example, setting the Callback property of a push button to sqrt(2) causes
the result of the expression to display in the Command Window:

ans =
1.4142

Any M-file that a callback executes must be in the current folder or on the

MATLAB path. For more information on how callbacks work, see “Callbacks:
An Overview” on page 8-2
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Laying Out a GUIDE GUI

® “Designing a GUI” on page 6-2

e “Starting GUIDE” on page 6-4

e “Selecting a GUI Template” on page 6-6

® “Setting the GUI Size” on page 6-15

¢ “Adding Components to the GUI” on page 6-19
® “Aligning Components” on page 6-88

e “Setting Tab Order” on page 6-97

¢ “Creating Menus” on page 6-100

e “Creating Toolbars” on page 6-121

* “Viewing the Object Hierarchy” on page 6-135
® “Designing for Cross-Platform Compatibility” on page 6-136
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Designing a GUI

Before creating the actual GUI, it is important to decide what it is you want
your GUI to do and how you want it to work. It is helpful to draw your GUI on
paper and envision what the user sees and what actions the user takes.

Note MATLAB software provides a selection of standard dialog boxes that
you can create with a single function call. For information about these dialog
boxes and the functions used to create them, see “Predefined Dialog Boxes” in
the MATLAB Function Reference documentation.

The GUI used in this example contains an axes component that displays
either a surface, mesh, or contour plot of data selected from the pop-up menu.
The following picture shows a sketch that you might use as a starting point
for the design.

Select Data
[peaks  [¥|—

| Menu for selecting
duto

B Plot Types
~ Axes - Punel to group push

: Ea

- Mesh >,__ Push buttons to select
N Pt fype

huttons

Contour

A panel contains three push buttons that enable you to choose the type of plot
you want. The pop-up menu contains three strings — peaks, membrane, and
sinc, which correspond to MATLAB functions. You can select the data to
plot from this menu.

Many Web sites and commercial publications such as the following provide
guidelines for designing GUIs:
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AskTog — Essays on good design and a list of First
Principles for good user interface design. The author, Bruce
Tognazzini, is a well-respected user interface designer.
http://www.asktog.com/basics/firstPrinciples.html.

Galitz, Wilbert, O., Essential Guide to User Interface Design. Wiley, New
York, NY, 2002.

GUI Design Handbook — A detailed guide to the use of GUI controls.
http://www.fast-consulting.com/desktop.htm.

Johnson, J., GUI Bloopers: Don’ts and Do’s for Software Developers and
Web Designers. Morgan Kaufmann, San Francisco, CA, 2000.

Usability Glossary — An extensive glossary of terms
related to GUI design, usability, and related topics.
http://www.usabilityfirst.com/glossary/main.cgi

UsabilityNet — Covers design principles, user-centered
design, and other usability and design-related topics.
http://www.usabilitynet.org/management/b_design.htm.


http://www.asktog.com/basics/firstPrinciples.html
http://www.fast-consulting.com/desktop.htm
http://www.usabilityfirst.com/glossary/main.cgi
http://www.usabilitynet.org/management/b_design.htm
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Starting GUIDE

There are many ways to start GUIDE. You can start GUIDE from the:

¢ Command line by typing guide

¢ Start menu by selecting MATLAB > GUIDE (GUI Builder)
e MATLAB File menu by selecting New > GUI

¢ MATLAB toolbar by clicking the GUIDE button =

However you start GUIDE, it displays the GUIDE Quick Start dialog box
shown in the following figure.

). GUIDE Quick Start I ] 3
Create New GUT | open Existing GUI |

GUIDE templates rPreview
<\ Blank GUI (Default)

<\ GUI with Uicontrols

4\ GUI with Axes and Menu
4\ Madal Question Dialag

BLANK

[~ Save new figure as: |C:\Work|GBT|GUIDE |examples|mygui.fig

QK I Cancel | Help

The GUIDE Quick Start dialog box contains two tabs:
¢ Create New GUI — Asks you to start creating your new GUI by choosing
a template for it. You can also specify the name by which the GUT is saved.

See “Selecting a GUI Template” on page 6-6 for information about the
templates.
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e Open Existing GUI — Enables you to open an existing GUI in GUIDE.
You can choose a GUI from your current folder or browse other directories.
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Selecting a GUI Template

In this section...

“Accessing the Templates” on page 6-6

“Template Descriptions” on page 6-7

Accessing the Templates

GUIDE provides several templates that you can modify to create your own
GUIs. The templates are fully functional GUIs; they are already programmed.

You can access the templates in two ways:

o Start GUIDE. See “Starting GUIDE” on page 6-4 for information.

¢ [f GUIDE is already open, select New from the File menu in the Layout
Editor.

In either case, GUIDE displays the GUIDE Quick Start dialog box with the
Create New GUI tab selected as shown in the following figure. This tab
contains a list of the available templates.

). GUIDE Quick Start =lox|
Create New GUL | Open Existing GUI |

GUIDE kemplates ~Preview
4\ Blank GUI (Default)

4\ GUI with Uicontrols

<\ GUI with Axes and Menu
4\ Madal Question Dialag

BLANK

I™ have new figure as; |C:\Work|GBT\GUIDE|examples|mygui.fig

QK I Cancel Help




Selecting a GUI Template

To use a template:
1 Select a template in the left pane. A preview displays in the right pane.

2 Optionally, name your GUI now by selecting Save new figure as and
typing the name in the field to the right. GUIDE saves the GUI before
opening it in the Layout Editor. If you choose not to name the GUI at this
point, GUIDE prompts you to save it and give it a name the first time
you run the GUIL

3 Click OK to open the GUI template in the Layout Editor.

Template Descriptions
GUIDE provides four fully functional templates. They are described in the

following sections:

¢ “Blank GUI” on page 6-8

¢ “GUI with Uicontrols” on page 6-9

¢ “GUI with Axes and Menu” on page 6-10

¢ “Modal Question Dialog” on page 6-13

“Out of the box,” none of the GUI templates include a menu bar or a toolbar.
Neither can they dock in the MATLAB desktop. You can, however, override
these GUIDE defaults to provide and customize these controls. See the

sections “Creating Menus” on page 6-100 and “Creating Toolbars” on page
6-121 for details.

Note To see how the template GUIs work, you can view their M-file code
and look at their callbacks. You can also modify the callbacks for your own
purposes. To view the M-file for any of these templates, open the template in
the Layout Editor and click the M-file Editor button & on the toolbar. For
information about using callbacks, see Chapter 8, “Programming a GUIDE
Gur.
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Blank GUI
The blank GUI template displayed in the Layout Editor is shown in the

following figure.

@ untitled.fig

File Edit View Layout Tools Help

=10l x|

EEFEE L B R

I k Select

Push Button
e Slider

#® Radio Button
B check Box
eelT Edit Text

T Skatic Text
== Pop-up Menu
= Listbox

Toggle Button
E Table
i{_‘d Axes

] Panel
|E Button Group

=X ActiveX Control

Tag: figural

sq 1

150

200 250

Current Poink: [55, 164]

Pasition: [520, 432, 450, 368]

Select the blank GUI if the other templates are not suitable starting points
for the GUI you are creating, or if you prefer to start with an empty GUI.
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i

File Edit Wiew Layout Toaols Help

GUI with Uicontrols

The following figure shows the template for a GUI with user interface controls
(uicontrols) displayed in the Layout Editor. User interface controls include
push buttons, sliders, radio buttons, check boxes, editable and static text
components, list boxes, and toggle buttons.

AE IR B EEIEERE

I ke Select

Push Butkon

SIIII lIIZIIZI lFD 2IIZIIII EFD SIIZIIJ SFD 400 -
T T T T T T T

rMeasures Units

e Slider

g_-_ Density( Do I 0 Ikficwin  |—| = English Unit System

#® Radio Button

= 51 Unt System
Salurme ) I 0 cuin

B CheckBox

o | I |

Lo I I I

[ Edit Text

Mass (D) 0 b Calcubie | Reset |

8T Skatic Text

== Pop-up Menu

=i Listbox

Taogale Bukkon

E] Table

i{_‘ﬂ Axes

(%] Panel

|§ Buktan Group

=X AckiveX Cantral

Tag: figurel

4 3
Current Poink: [399, 73] Position: [544, 485, 400, 140]
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When you run the GUI by clicking the Run button =, the GUI appears as
shown in the following figure.

) untitledt -0 x|

Meazures Units

Density(DY: | 0 Ihicwin =" Englizh Unit System
; %1 Unit System
Salume I 0 cuin |

Mass(D): 0 Calcuiste | Reset |

When a user enters values for the density and volume of an object, and clicks
the Calculate button, the GUI calculates the mass of the object and displays
the result next to Mass(D*V).

To view the M-file code for these user interface controls, open the template in
the Layout Editor and click the M-file Editor button & on the toolbar.

GUI with Axes and Menu

The template for a GUI with axes and menu is shown in the following figure.
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& untitled1.fig

Layouk

File Edit Wiew

Tools

Help

=101 %]

NCcH|sdRR20 | 2aB6d4SH% P

I ke Select

Push Butkan

e=m Slider

#® Radio Buktan

[ Check Box

[e]T Edit Texk

THT Skakic Text

== Pop-up Menu

=[] Listbaox

Togale Bukkon

E Table

i{_ﬂ Axes

(%] Panel

|E Button Group

=X ActiveX Cankral

Tag: figurel

50 00

150

Z?D ZFD 200

|
Iplnt{rand{ﬁj)
I

I
lj

I
Update

169

1179

3]

axes]

132

4

Current Point: [58, 9]

Position: [644, 454, 313, 219]

When you run the GUI by clicking the Run button » on the toolbar, the
GUI displays a plot of five lines, each of which is generated from random
numbers using the MATLAB rand(5) command. The following figure shows

an example.
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) untitled 2= lolx|

File
| plotfrand;5 1) =l Update |

1

0.8

0.6

0.4

0.2

You can select other plots in the pop-up menu. Clicking the Update button
displays the currently selected plot on the axes.

The GUI also has a File menu with three items:

¢ Open displays a dialog box from which you can open files on your computer.

® Print opens the Print dialog box. Clicking OK in the Print dialog box
prints the figure.

® (Close closes the GUI.

To view the M-file code for these menu choices, open the template in the
Layout Editor and click the M-file Editor button & on the toolbar.
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Modal Question Dialog

The modal question dialog template displayed in the Layout Editor is shown
in the following figure.

g untitled2.fig -0l x|

File Edit WView Layout Tools Help

AEL IR B EEEEIEERIE

50 100 150 Z0n 250 20 .
IkSeIect i
] B
Push Button ] [ you wwant to create a question dialog?
e Slider &1

#® Radio Button

[ checkBox

[ec]T Edit Text

8T Skatic Text

== Pop-up Menu
Ei Listbox

Toggle Butkon
E] Table
i{'ﬂ Axes

(%] Panel

|§ Button Group

=X ActiveX Cantral

4 3
Tag: figurel Current Poink: [0, 0] Position: [657, 532, 280, 103]

Running the GUI displays the dialog box shown in the following figure:
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Do ywou want to creste a question dialog?

Yes Mo

The GUI returns the text string Yes or No, depending on which button you
click.

Select this template if you want your GUI to return a string or to be modall.
Modal GUIs are blocking, which means that the current M-file stops executing

until the GUI restores execution; this means that the user cannot interact
with other MATLAB windows until one of the buttons is clicked.

Note Modal dialog boxes (figures with WindowStyle set to 'modal') cannot
display menus or toolbars.

To view the M-file code for these capabilities, open the template in the Layout
Editor and click the M-file Editor button &l on the toolbar. See “Using a
Modal Dialog Box to Confirm an Operation” on page 10-98 for an example

of using this template with another GUI. Also see the figure WindowStyle
property for more information.


file:///B:/matlab/doc/src/toolbox/matlab/ref/figure_props.html%23WindowStyle

Setting the GUI Size

Setting the GUI Size

Set the size of the GUI by resizing the grid area in the Layout Editor.
Click the lower-right corner and drag it until the GUI is the desired size. If
necessary, make the window larger.

~Ioix

File Edit Wew Layout Tools Help
B % | b

EEFIEE L

sg 100 150 zo0 250 200 250 200
k Select

Push Button

e Slider

#® Radio Button

b4 checkBox
el Edit Text

T Static Text
= Pop-up Menu
£l Listbax

Togale Bukkon
E Table
i{'ﬁ Axes

] Panel

|E Button Group

=X ActiveX Control

Tag: figurel Current Point: [55, 164] Position: [520, 432, 450, 368]

As you drag the corner handle, the readout in the lower right corner shows
the current position of the GUI in pixels.
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Note Many of the following steps show you how to use the Property Inspector
to set properties of a GUI and its components. If you are not familiar with
using this too and its context-sensitive help, see “Property Inspector” on page
6-91

If you want to set the position or size of the GUI to an exact value, do the
following:

1 Select Property Inspector from the View menu or click the Property
Inspector button B,

2 Scroll to the Units property and note whether the current setting is
characters or normalized. Click the button next to Units and then
change the setting to inches from the pop-up menu.

Es Inspector: figure (Untitled)

B8] e =t

Ul ontextMenu Mone [

Inits characters -

Wisible centimebers

. -
Vi =] normalized

poinks
pixels
characters

3 In the Property Inspector, click the + sign next to Position. The elements
of the component’s Position property are displayed.
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E# Inspector: figure {Untitled)

HDlnterbnépeHDtbpnt [ [1x2 dauble array] ”
[103.8 29,154 112 32,308]
x 103.5 &
y 29,154 &
width 112.0 & -
hieight 32,305 P
Renderer Mone L

4 Type the x and y coordinates of the point where you want the lower-left

corner of the GUI to appear, and its width and height.

5 Reset the Units property to its previous setting, either characters or

normalized.

Note Setting the Units property to characters (nonresizable GUIs) or
normalized (resizable GUIs) gives the GUI a more consistent appearance
across platforms. See “Cross-Platform Compatible Units” on page 6-138 for

more information.
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Maximizing the Layout Area

You can make maximum use of space within the Layout Editor by hiding

the GUIDE toolbar, status bar, or both. To do this, deselect Show Toolbar
and/or Show Status Bar from the View menu. Showing only tool icons on
the component palette gives you more room as well. To show only tool icons
on the component palette, select Preferences from the GUIDE File menu
and deselect Show names in component palette. If you do all these things,
the layout editor looks like this.

_laix

File Edit Wiew Layout Tools Help

50 100 150 200 250 200 250 400 450 S00 550 &

®|E 7|

&

=
=
=
=
5

ENRE

H
|

I

[osi
b




Adding Components to the GUI

Adding Components to the GUI

In this section...

“Available Components” on page 6-20

“A Working GUI with Many Components” on page 6-24
“Adding Components to the GUIDE Layout Area” on page 6-31
“Defining User Interface Controls” on page 6-38

“Defining Panels and Button Groups” on page 6-55

“Defining Axes” on page 6-61

“Defining Tables” on page 6-65

“Adding ActiveX Controls” on page 6-76

“Working with Components in the Layout Area” on page 6-79

“Locating and Moving Components” on page 6-82

“Resizing Components” on page 6-85

Other topics that may be of interest:

¢ “Aligning Components” on page 6-88
e “Setting Tab Order” on page 6-97
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Available Components

The component palette at the left side of the Layout Editor contains the
components that you can add to your GUI. You can display it with or without
names.

I k select

Push Button

e Slider

® Radio Button
[ Check Box

Comp t palette with names

[eefr Edlit Text

THT! Static Text Gomonent palette without names

=3 Pop-up Menu

#Blo|g|e|E ]
]

=
=1 Listbox [E
Togals Buttan p—
g | 2x
E Table
i{i Axes
[T Panel

|§ Button Graup

=X ActiveX! Control

When you first open the Layout Editor, the component palette contains only
icons. To display the names of the GUI components, select Preferences
from the File menu, check the box next to Show names in component
palette, and click OK.

See “Creating Menus” on page 6-100 for information about adding menus
to a GUL
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Note This section provides information about using components to lay out a
GUI For information about programming these components see Chapter 8,
“Programming a GUIDE GUT”.

Component | Icon Description

Push Button Push buttons generate an action when clicked.
For example, an OK button might apply settings
and close a dialog box. When you click a push
button, it appears depressed; when you release
the mouse button, the push button appears raised.

Slider = Sliders accept numeric input within a specified
range by enabling the user to move a sliding bar,
which is called a slider or thumb. Users move the
slider by clicking the slider and dragging it, by
clicking in the trough, or by clicking an arrow.
The location of the slider indicates the relative
location within the specified range.

Radio Button | @ Radio buttons are similar to check boxes, but
radio buttons are typically mutually exclusive
within a group of related radio buttons. That

1s, when you select one button the previously
selected button is deselected. To activate a radio
button, click the mouse button on the object. The
display indicates the state of the button. Use a
button group to manage mutually exclusive radio
buttons.

Check Box %] Check boxes can generate an action when checked
and indicate their state as checked or not checked.
Check boxes are useful when providing the

user with a number of independent choices, for
example, displaying a toolbar.
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Component

Icon

Description

Edit Text

ED|T

Edit text components are fields that enable users
to enter or modify text strings. Use edit text when
you want text as input. Users can enter numbers
but you must convert them to their numeric
equivalents.

Static Text

THT

Static text controls display lines of text. Static
text 1s typically used to label other controls,
provide directions to the user, or indicate values
associated with a slider. Users cannot change
static text interactively.

Pop-Up Menu

Pop-up menus open to display a list of choices
when users click the arrow.

List Box

List boxes display a list of items and enable users
to select one or more items.

Toggle
Button

Toggle buttons generate an action and indicate
whether they are turned on or off. When you click
a toggle button, it appears depressed, showing
that it 1s on. When you release the mouse button,
the toggle button remains depressed until you
click it a second time. When you do so, the button
returns to the raised state, showing that it is off.
Use a button group to manage mutually exclusive
toggle buttons.

Table

Use the table button to create a table component.
Refer to the uitable function for more
information on using this component.
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Component

Icon

Description

Axes

Axes enable your GUI to display graphics such
as graphs and images. Like all graphics objects,
axes have properties that you can set to control
many aspects of its behavior and appearance.
See “Axes Properties” in the MATLAB Graphics
documentation and commands such as the
following for more information on axes objects:
plot, surf, line, bar, polar, pie, contour,
and mesh. See Functions — By Category in the
MATLAB Function Reference documentation for
a complete list.

Panel

Panels arrange GUI components into groups. By
visually grouping related controls, panels can
make the user interface easier to understand. A
panel can have a title and various borders.

Panel children can be user interface controls and
axes as well as button groups and other panels.
The position of each component within a panel
1s interpreted relative to the panel. If you move
the panel, its children move with it and maintain
their positions on the panel.

Button Group

Button groups are like panels but are used to
manage exclusive selection behavior for radio
buttons and toggle buttons.

Toolbar

You can create toolbars containing push buttons
and toggle buttons. Use the GUIDE Toolbar
Editor to create toolbar buttons. Choose between
predefined buttons, such as Save and Print, and
buttons which you customize with your own icons
and callbacks.

ActiveX®
Component

ActiveX components enable you to display ActiveX
controls in your GUI. They are available only on
the Microsoft® Windows® platform.
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Component | Ilcon Description

An ActiveX control can be the child only of a
figure, i.e., of the GUI itself. It cannot be the child
of a panel or button group.

See “ActiveX Control” on page 8-48 in this
document for an example. See “Creating COM
Objects” in the MATLAB External Interfaces
documentation to learn more about ActiveX
controls.

A Working GUI with Many Components

To see what GUI components look like and how they work, you can open in
GUIDE and run an example GUI that demonstrates more than a dozen of
them. When you run the GUI, all its component callbacks tell your actions
using the GUI and some also update the plot it displays. The GUI, called
controlsuite, includes all the components listed in the table in the previous
section, “Available Components” on page 6-20, except for ActiveX controls.

It consists of a FIG-file (controlsuite.fig) that opens in GUIDE, and an
M-file (controlsuite.m) that opens in the MATLAB Editor.

Viewing the controlsuite Layout and GUI M-File
If you are reading this in the MATLAB Help browser, click the following

links to display the GUIDE Layout Editor and the MATLAB Editor with a
completed version of the controlsuite example.

® (Click here to display the controlsuite GUI in the GUIDE Layout Editor.
¢ (Click here to display the controlsuite GUI M-file in the MATLAB Editor.

® (lick here to run the controlsuite GUI

Note If you want to experiment with the controlsuite GUI, first save a
copy of the FIG-file and the M-file in a writable folder on your MATLAB path
and work with those copies.
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When you open controlsuite.fig in GUIDE, it looks like this in the Layout
Editor. Click any control outlined in yellow in the following figure to read
about how that type of component is programmed, as described in the section
“Examples: Programming GUIDE GUI Components” on page 8-30. Several of
the controls are also discussed later in this section.

i

File Edit View Layout Tools Help

SE IR R R

IT 5|0 lIUU l.ISD ZIIJU 2.|50 GIUU 3.|50 ‘lIUU 4.|50 SIUU S.ISD EIUU E.ISU -
| | | | | | | | | I | | |
~Buttons—— ~Action Pangl —Membrane data table and plot————
[: 1o ]
oz 5] _pesnsuon |- Action e T2 T 5 T |4
1 | 01668 01729 01743 a
[ecfr | e o | 2 | 01224 01217 0167
=1 _ | '3 | -noves -008o7 00583 |
== | El T Toggle Bution 4 | -00%7 -00192 -00019
[~ Check Box 5 | 0010 00275 00497
= & | 00480 00633 0.0944 |
| Bl || Roten sram——————————— ~Edlit Boxes 7 | 00772 01015 04304
A = § | 00998 01257 01560 =
& |=x ] = ¥ Top Radio button Eclit Text 4 »
=1 . _ Al |
2
= Middle Radio button Mutting ]
o " Bottom Radio button et
a1 —_ Text — ]
rListhox
=] o » axesl |
o
=
-
i T h
~Plat Cortrols
-
| R | il
Icool vl
2 _ _

B
4 |>i

Tag: figural Current Poink: [406, 46] Pasition: [S520, 429, 670, 500]

The GUI contains 15 controls organized within seven panels. The Action
Panel contains a static text component that changes to describe the actions a
user makes when manipulating the controls. For example, selecting Charlie
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in the Listbox panel places the word Charlie in the Action Panel. The
Membrane data table and plot panel on the right side displays a 3-D surface
plot (generated by the membrane function) in an axes at its bottom, and the
data for that plot in the table above it. The user can control the view azimuth
and the colormap using the two controls in the Plot Controls panel at the
bottom center.

Running the controlsuite GUI

When you click the Run Figure P button in the Layout Editor, the GUI
opens, initializes, and displays itself as shown in the following figure.

il

— Buttonz . Action Pangl — Membrane data table and plot
push Button | Action B[ 1 | 2 | 3 |
1 01689 04729 01748 =
L | 2 | -01224 01217 -01167 j
3 | -00766 -00697 -00583
TEIE BT 4 | -00317 -00192 -00019
[~ Check Box 5 00101 00275 00497
[ 00489 00683 00944
— Button Group — Edit Boxe 7 00772 01015 01304
8 00995 04257 01560 =
% Top Radio button Eclt Test _‘u _,l_l
= Middle Raclio button MG ﬂ
" Bottom Radio button it
Text

— Listhax

)
ki

%
— Plat Caontrals

] E—

LY
""“l““
‘:“1‘““ “‘

; 1:‘3“‘1 -

The following sections describe several controls and the code they execute
(their callbacks). Study the sections of code and click the links to the callbacks
below to learn the how the controlsuite M-file controls the GUI.



Adding Components to the GUI

The Push Button. When the user clicks the Push Button button, the result
show up in the Action Panel as

— Buttons - — Action Panel

Push button pushed

Toggle Button |

[T Check Box

The M-code that generates the message is part of the pushbutton1_Callback,
shown below:

function pushbuttoni_Callback(hObject, eventdata, handles)

% hObject handle to pushbutton1 (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

set(handles.textStatus, 'String', 'Push button pushed')

This callback is activated when pushbuttonl is clicked. It places the string
'"Push button pushed' in the static text field named textStatus using the
set function. All the controls in controlsuite perform this action, but some of
them do other things as well.

The Toggle Button. When the user clicks the Toggle Button button, this
is the result.

— Buttons

- — Action Panel

Push Button Toggle down

_Push Buton |
L_I
1

[T Check Box
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The callback for this button, togglebuttoni, contains this M-code:

function togglebuttoni_Callback(hObject, eventdata, handles)
hObject handle to togglebuttoni (see GCBO)

eventdata reserved - to be defined in a future version of MATLAB
handles structure with handles and user data (see GUIDATA)

o° o°

o°

% Hint: get(hObject, 'Value') returns toggle state of togglebuttont
isDown = get(hObject, 'Value');

if isDown

set(handles.textStatus, 'string', 'Toggle down')
else

set(handles.textStatus, 'string', 'Toggle up')
end

The if block tests the variable isDown, which has been set to the Value
property of the toggle button, and writes a different message depending on
whether the value is true or false.

The Plot Controls. The two components of the Plot Controls panel affect
the plot of the peaks function as well as rewrite the text in the Action Panel.

® A popup menu to select a built-in colormap by name

e A slider to rotate the view around the z-axis

The popup, named popupmenui, contains a list of seven colormap names in its
String property, which you can set in the Property Inspector by clicking its

Edit iconl = Typing the strings into the edit dialog and clicking OK sets
all seven colormap names at once.
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x|

ool -
Spring
summer
autumn
inter
pink
hone

4| 2

] Cancel

The popup’s callback controls its behavior. GUIDE generates this much of
the callback.

function popupmenul_Callback(hObject, eventdata, handles)

hObject handle to popupmenuil (see GCBO)

eventdata reserved - to be defined in a future version of MATLAB
handles structure with handles and user data (see GUIDATA)

o°® o°

o°

o°

Hints: contents = get(hObject, 'String') returns popupmenui
contents as cell array
contents{get(hObject, 'Value')} returns selected item
from popupmenui

o°® o°

o°

The callbacks’s code adds these statements.

contents get(hObject, 'String');
selectedText = contents{get(hObject, 'Value')};
colormapStatus = [selectedText ' colormap'];
set(handles.textStatus, 'string', colormapStatus);
colormap(selectedText)

The String data is retrieved as a cell array and assigned to contents. The
Value property indexes the member of contents that the user just selected to
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retrieve the name of the colormap That name, selectedText, is composed
into a message and placed in the textStatus static text field, and used by
the colormap function to reset the colormap. For example, if the user selects
autumn from the popup, the surface changes to shades of yellow, orange, and
red, as shown in the following cutout from the GUI.

Muttiline ;|
Eclit
Text
hd
— Plat Controls

4| | PI

CET |

The slider control sets the viewing azimuth, causing the plot to rotate when
the user moves its “thumb” or clicks its arrows. Its name is slider1 and its
callback is slider1_Callback.

The Data Table. The table in the upper right corner is a uitable component.
When the GUI is created, the table’s CreateFcn loads the same membrane
data into the table that the plot in the axes below it displays.

The table is by default not editable, but by clicking the small Edit toggle
button in its upper left corner the user can edit table values, one at a
time. This button is placed on top of the table, but is not actually part

of it. The table’s CellEditCallback responds to each table cell edit by
updating the surface plot and displaying the result of the edit in the Action
Panel. Clicking the Edit button again makes the table not editable. See
togglebutton2_Callback in the controlsuite M-file for details on how this
works.
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For another example describing how to couple uitables with graphics, see
“GUI to Interactively Explore Data in a Table” on page 10-31.

Find more about how to work with the GUI components used in controlsuite
in “Examples: Programming GUIDE GUI Components” on page 8-30 and in
the following sections:

® “Defining User Interface Controls” on page 6-38

® “Defining Panels and Button Groups” on page 6-55

® “Defining Axes” on page 6-61

e “Defining Tables” on page 6-65

Adding Components to the GUIDE Layout Area

This topic tells you how to place components in the GUIDE layout area and
give each component a unique identifier.

Note See “Creating Menus” on page 6-100 for information about adding
menus to a GUI. See “Creating Toolbars” on page 6-121 for information about
working with the toolbar.

1 Place components in the layout area according to your design.
®* Drag a component from the palette and drop it in the layout area.

® (Click a component in the palette and move the cursor over the layout
area. The cursor changes to a cross. Click again to add the component in
its default size, or click and drag to size the component as you add it.

Once you have defined a GUI component in the layout area, selecting it
automatically shows it in the Property Inspector. If the Property Inspector
is not open or is not visible, double-clicking a component raises the
inspector and focuses it on that component.

The components listed in the following table have additional considerations;
read more about them in the sections described there.
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If You Are Adding... Then...

Panels or button groups See “Adding a Component to a
Panel or Button Group” on page
6-34.

Menus See “Creating Menus” on page
6-100

Toolbars See “Creating Toolbars” on page
6-121

ActiveX controls See “Adding ActiveX Controls” on
page 6-76.

See “Grid and Rulers” on page 6-95 for information about using the grid.

2 Assign a unique identifier to each component. Do this by setting the value
of the component Tag properties. See“Assigning an Identifier to Each
Component” on page 6-37 for more information.

3 Specify the look and feel of each component by setting the appropriate
properties. The following topics contain specific information.

“Defining User Interface Controls” on page 6-38

® “Defining Panels and Button Groups” on page 6-55
® “Defining Axes” on page 6-61

e “Defining Tables” on page 6-65

¢ “Adding ActiveX Controls” on page 6-76
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This 1s an example of a GUI in the Layout Editor. Components in the Layout
Editor are not active. Chapter 7, “Saving and Running a GUIDE GUI”
describes how to generate a functioning GUI.

=
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Using Coordinates to Place Components
The status bar at the bottom of the GUIDE Layout Editor displays:

¢ Current Point — The current location of the mouse relative to the lower
left corner of the grid area in the Layout Editor.

¢ Position — The Position property of the selected component, a 4-element
vector: [distance from left, distance from bottom, width, height], where
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distances are relative to the parent figure, panel, or button group. All
values are given in pixels. Rulers also display pixels.

If you select a single component and move it, the first two elements of the
position vector (distance from left, distance from bottom) are updated as you
move the component. If you resize the component, the last two elements of
the position vector (width, height) are updated as you change the size. The
first two elements may also change if you resize the component such that the
position of its lower left corner changes. If no components are selected, the
position vector is that of the figure.

For more information, see “Using Coordinate Readouts” on page 6-82.

Adding a Component to a Panel or Button Group

To add a component to a panel or button group, select the component in the
component palette then move the cursor over the desired panel or button
group. The position of the cursor determines the component’s parent.
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GUIDE highlights the potential parent as shown in the following figure. The
highlight indicates that if you drop the component or click the cursor, the
component will be a child of the highlighted panel, button group, or figure.
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Note Assign a unique identifier to each component in your panel or button
group by setting the value of its Tag property. See “Assigning an Identifier to
Each Component” on page 6-37 for more information.
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Including Existing Components in Panels and Button Groups. When
you add a new component or drag an existing component to a panel or
button group, it will become a member, or child, of the panel or button group
automatically, whether fully or partially enclosed by it. However, if the
component is not entirely contained in the panel or button group, it appears to
be clipped in the Layout Editor. When you run the GUI, the entire component
1s displayed and straddles the panel or button group border. The component
1s nevertheless a child of the panel and behaves accordingly. You can use the
Object Browser to determine the child objects of a panel or button group.
“Viewing the Object Hierarchy” on page 6-135 tells you how.

You can add a new panel or button group to a GUI in order to group any of its
existing controls. In order to include such controls in a new panel or button
group, do the following. The instructions refer to panels, but you do the same
for components inside button groups.

1 Select the New Panel or New Button Group tool and drag out a rectangle to
have the size and position you want.

The panel will not obscure any controls within its boundary unless they
are axes, tables, or other panels or button groups. Only overlap panels you
want to nest, and then make sure the overlap is complete.

2 You can use Send Backward or Send to Back on the Layout menu to
layer the new panel behind components you do not want it to obscure,
if your layout has this problem. As you add components to it or drag
components into it, the panel will automatically layer itself behind them.

Now is a good time to set the panel’s Tag and String properties to whatever
you want them to be, using the Property Inspector.

3 Open the Object Browser from the View menu and find the panel you just
added. Use this tool to verify that it contains all the controls you intend it
to group together. If any are missing, perform the following steps.

4 Drag controls that you want to include but don’t fit within the panel inside
it to positions you want them to have. Also, slightly move controls that are
already in their correct positions to group them with the panel.
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The panel highlights when you move a control, indicating it now contains
the control. The Object Browser updates to confirm the relationship. If you
now move the panel, its child controls move with it.

Tip You need to move controls with the mouse to register them with the
surrounding panel or button group, even if only by a pixel or two. Selecting
them and using arrow keys to move them does not accomplish this. Use the
Object Browser to verify that controls are properly nested.

See “Defining Panels and Button Groups” on page 6-55 for more information
on how to incorporate panels and button groups into a GUI.

Assigning an Identifier to Each Component

Use the Tag property to assign each component a unique meaningful string
identifier.

When you place a component in the layout area, GUIDE assigns a default
value to the Tag property. Before saving the GUI, replace this value with a
string that reflects the role of the component in the GUI.

The string value you assign Tag is used in the M-file code to identify the
component and must be unique in the GUI. To set Tag:

1 Select Property Inspector from the View menu or click the Property
Inspector button B,

2 In the layout area, select the component for which you want to set Tag.
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3 In the Property Inspector, select Tag and then replace the value with the
string you want to use as the identifier. In the following figure, Tag is
set to mybutton.

B 2] i =t

EpE e [T O] "
String £ | Push Button
Skyle pushbutkon -
TralbinShrin i

Defining User Interface Controls

User interface controls include push buttons, toggle buttons, sliders, radio
buttons, edit text controls, static text controls, pop-up menus, check boxes,
and list boxes.

To define user interface controls, you must set certain properties. To do this:

1 Use the Property Inspector to modify the appropriate properties. Open the
Property Inspector by selecting Property Inspector from the View menu

or by clicking the Property Inspector button

2 In the layout area, select the component you are defining.

Subsequent topics describe commonly used properties of user interface
controls and offer a simple example for each kind of control:

¢ “Commonly Used Properties” on page 6-39

e “Push Button” on page 6-40

e “Slider” on page 6-42

¢ “Radio Button” on page 6-43

® “Check Box” on page 6-45

e “Edit Text” on page 6-46
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e “Static Text” on page 6-48

¢ “Pop-Up Menu” on page 6-49

e “List Box” on page 6-51

® “Toggle Button” on page 6-53

Note See “Available Components” on page 6-20 for descriptions of these
components. See “Examples: Programming GUIDE GUI Components” on
page 8-30 for basic examples of programming these components.

Commonly Used Properties
The most commonly used properties needed to describe a user interface
control are shown in the following table. Instructions for a particular control
may also list properties that are specific to that control.

Property Value Description
Enable on, inactive, off. Determines whether the
Default is on. control is available to
the user

Max Scalar. Default is 1. Maximum value.
Interpretation depends
on the type of
component.

Min Scalar. Default is 0. Minimum value.
Interpretation depends
on the type of
component.

Position 4-element vector: Size of the component

[distance from left,
distance from bottom,
width, height].

and its location relative
to its parent.
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Property

Value

Description

String

String. Can also be a
cell array or character
array of strings.

Component label. For
list boxes and pop-up
menus it is a list of the
items.

Units

characters,
centimeters, inches,
normalized, pixels,
points. Default is
characters.

Units of measurement
used to interpret the
Position property
vector

Value

Scalar or vector

Value of the component.
Interpretation depends
on the type of
component.

For a complete list of properties and for more information about the properties
listed in the table, see Uicontrol Properties in the MATLAB documentation.
Properties needed to control GUI behavior are discussed in Chapter 8,
“Programming a GUIDE GUTI”

Push Button

To create a push button with label Button 1, as shown in this figure:

Fil Ed ¥ie Inse Toc Desk Wind He

=10l x|

Button 1 |

¢ Specify the push button label by setting the String property to the desired
label, in this case, Button 1.
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E Inspector: uicontrol {(mybutton “Button 1*)
2 | LI +:
. = ey
Sliderstep [0.010.1]
Skyle pushbutkon -
Tan rrweh kb i

To display the & character in a label, use two & characters in the string.
The words remove, default, and factory (case sensitive) are reserved.
To use one of these as a label, prepend a backslash (\) to the string. For
example, \remove yields remove.

The push button accommodates only a single line of text. If you specify
more than one line, only the first line is shown. If you create a push button
that is too narrow to accommodate the specified String, MATLAB software
truncates the string with an ellipsis.

Butto...

If you want to set the position or size of the component to an exact value,
then modify its Position property. See “Locating and Moving Components
on page 6-82 and “Resizing Components” on page 6-85 for details.

”

To add an image to a push button, assign the button’s CData property an
m-by-n-by-3 array of RGB values that defines a truecolor image. You must
do this programmatically in the opening function of the GUI M-file. For
example, the array img defines a 16-by-64-by-3 truecolor image using
random values between 0 and 1 (generated by rand).

img = rand(16,64,3);
set(handles.pushbuttont, 'CData',img);

where pushbuttont is the push button’s Tag property.
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Note Create your own icon with the icon editor described in “Icon Editor”
on page 15-62. See ind2rgb for information on converting a matrix X and
corresponding colormap, i.e., an (X, MAP) image, to RGB (truecolor) format.

Slider

To create a slider as shown in this figure:

) Figure 1 [_ [O] x|
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e Specify the range of the slider by setting its Min property to the minimum

value of the slider and its Max property to the maximum value. The Min
property must be less than Max.

Specify the value indicated by the slider when it is created by setting the
Value property to the appropriate number. This number must be less than
or equal to Max and greater than or equal to Min. If you specify Value
outside the specified range, the slider is not displayed.

Control the amount the slider Value changes when a user clicks the arrow
button to produce a minimum step or the slider trough to produce a
maximum step by setting the S1liderStep property. Specify SliderStep as
a two-element vector, [min_step,max_step], where each value is in the
range [0, 1] to indicate a percentage of the range.
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Arrow hutton
(min_step)

1 F

Trough

(max_step)

If you want to set the position or size of the component to an exact value,
then modify its Position property. See “Locating and Moving Components”
on page 6-82 and “Resizing Components” on page 6-85 for details.

Note On Mac® platforms, the height of a horizontal slider is constrained.
If the height you set in the position vector exceeds this constraint, the
displayed height of the slider is the maximum allowed. The height element
of the position vector is not changed.

Note The slider component provides no text description or data entry
capability. Use a “Static Text” on page 6-48 component to label the slider.
Use an “Edit Text” on page 6-46 component to enable a user to provide a
value for the slider.

Radio Button

To create a radio button with label Indent nested functions, as shown
in this figure:

<} Figure 1 M=l E3

File Edi Wig Inse Too Deskt Wind Hel =~

% Indert nested functions.

¢ Specify the radio button label by setting the String property to the desired
label, in this case, Indent nested functions.
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Eé Inspector: uicontrol (radiobuttoni "Indent nested fu... [E[=] B3
2 | LI +:
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To display the & character in a label, use two & characters in the string.
The words remove, default, and factory (case sensitive) are reserved.
To use one of these as a label, prepend a backslash (\) to the string. For
example, \remove yields remove.

The radio button accommodates only a single line of text. If you specify
more than one line, only the first line is shown. If you create a radio button
that is too narrow to accommodate the specified String, MATLAB software
truncates the string with an ellipsis.

{* Indert nested functio. ..

Create the radio button with the button selected by setting its Value
property to the value of its Max property (default is 1). Set Value to Min
(default is 0) to leave the radio button unselected. Correspondingly, when
the user selects the radio button, the software sets Value to Max, and to Min
when the user deselects it.

If you want to set the position or size of the component to an exact value,
then modify its Position property. See “Locating and Moving Components
on page 6-82 and “Resizing Components” on page 6-85 for details.

”

To add an image to a radio button, assign the button’s CData property
an m-by-n-by-3 array of RGB values that defines a truecolor image. You
must do this programmatically in the opening function of the GUI M-file.
For example, the array img defines a 16-by-24-by-3 truecolor image using
random values between 0 and 1 (generated by rand).

img = rand(16,24,3);
set(handles.radiobuttoni, 'CData',img);
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Note To manage exclusive selection of radio buttons and toggle buttons,
put them in a button group. See “Button Group” on page 6-59 for more

information.

Check Box

To create a check box with label Display file extension that is initially
checked, as shown in this figure:

) rigure 1SR
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[+ Dizplary file extension

® Specify the check box label by setting the String property to the desired
label, in this case, Display file extension.
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To display the & character in a label, use two & characters in the string.
The words remove, default, and factory (case sensitive) are reserved.
To use one of these as a label, prepend a backslash (\) to the string. For

example, \remove yields remove.

The check box accommodates only a single line of text. If you specify a
component width that is too small to accommodate the specified String,

MATLAB software truncates the string with an ellipsis.
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[v Cizplay file...

® Create the check box with the box checked by setting the Value property
to the value of the Max property (default is 1). Set Value to Min (default is
0) to leave the box unchecked. Correspondingly, when the user clicks the
check box, the software sets Value to Max when the user checks the box
and to Min when the user clears it.

¢ If you want to set the position or size of the component to an exact value,
then modify its Position property. See “Locating and Moving Components
on page 6-82 and “Resizing Components” on page 6-85 for details.

”

Edit Text
To create an edit text component that displays the initial text Enter your
name here, as shown in this figure:

) Figure 1 = E
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Eriter your natme here.

® Specify the text to be displayed when the edit text component is created
by setting the String property to the desired string, in this case, Enter
your name here.
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Ei Inspector: uicontrol (edit1 "Enter your name here™)  [H =] B4
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To display the & character in a label, use two & characters in the string.
The words remove, default, and factory (case sensitive) are reserved.
To use one of these as a label, prepend a backslash (\) to the string. For
example, \remove yields remove.

To enable multiple-line input, specify the Max and Min properties so that
their difference is greater than 1. For example, Max = 2, Min = 0. Max
default is 1, Min default is 0. MATLAB software wraps the string and adds
a scroll bar if necessary. On all platforms, when the user enters a multiline
text box via the Tab key, the editing cursor is placed at its previous location
and no text highlights.

Enter your name and ;I
address here. LI

If Max-Min 1is less than or equal to 1, the edit text component admits only a
single line of input. If you specify a component width that is too small to
accommodate the specified string, MATLAB software displays only part of
the string. The user can use the arrow keys to move the cursor through the
entire string. On all platforms, when the user enters a single-line text box
via the Tab key, the entire contents is highlighted and the editing cursor is
at the end (right side) of the string.

E addrezs here.

If you want to set the position or size of the component to an exact value,
then modify its Position property. See “Locating and Moving Components”
on page 6-82 and “Resizing Components” on page 6-85 for details.
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® You specify the text font to display in the edit box by typing the name of
a font residing on your system into the FontName entry in the Property
Inspector. On Microsoft Windows platforms, the default is MS Sans Serif;
on Macintosh® and UNIX® platforms, the default is Helvetica.

Tip To find out what fonts are available, type uisetfont at the MATLAB
prompt; a dialog displays containing a list box from which you can select
and preview available fonts. When you select a font, its name and other
characteristics are returned in a structure, from which you can copy the
FontName string and paste it into the Property Inspector. Not all fonts
listed may be available to users of your GUI on their systems.

Static Text

To create a static text component with text Select a data set, as shown
in this figure:

<) Figure 1 M=] E3
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Select & data set.

e Specify the text that appears in the component by setting the component
String property to the desired text, in this case Select a data set.

4 Inspector: uicontrol (textl "Select a data set™) M=l E3
S == g 18 1 o e
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To display the & character in a list item, use two & characters in the string.
The words remove, default, and factory (case sensitive) are reserved.

To use one of these as a label, prepend a backslash (\) to the string. For
example, \remove yields remove.

If your component is not wide enough to accommodate the specified String,
MATLAB software wraps the string.

Zelect a data
et

¢ If you want to set the position or size of the component to an exact value,
then modify its Position property. See “Locating and Moving Components
on page 6-82 and “Resizing Components” on page 6-85 for details.

”

® You can specify a text font, including its FontName, FontWeight, FontAngle,
FontSize, and FontUnits properties. For details, see the previous topic,
“Edit Text” on page 6-46, and for a programmatic approach, the section
“Setting Font Characteristics” on page 11-18.

Pop-Up Menu
To create a pop-up menu (also known as a drop-down menu or combo box)
with items one, two, three, and four, as shown in this figure:

) rgwe 1 SIaIEY
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¢ Specify the pop-up menu items to be displayed by setting the String
property to the desired items. Click the
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button to the right of the property name to open the Property Inspector

editor.
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To display the & character in a menu item, use two & characters in the
string. The words remove, default, and factory (case sensitive) are
reserved. To use one of these as a label, prepend a backslash (\) to the
string. For example, \remove yields remove.

If the width of the component is too small to accommodate one or more of
the specified strings, MATLAB software truncates those strings with an

ellipsis.

To select an item when the component is created, set Value to a scalar
that indicates the index of the selected list item, where 1 corresponds to
the first item in the list. If you set Value to 2, the menu looks like this

when 1t 1s created:
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frwo =]

¢ If you want to set the position and size of the component to exact values,
then modify its Position property. See “Locating and Moving Components”
on page 6-82 and “Resizing Components” on page 6-85 for details. The
height of a pop-up menu is determined by the font size. The height you
set in the position vector is ignored.

Note The pop-up menu does not provide for a label. Use a “Static Text” on
page 6-48 component to label the pop-up menu.

List Box

To create a list box with items one, two, three, and four, as shown in this
figure:

) rgure 1 R[aTE
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® Specify the list of items to be displayed by setting the String property to
the desired list. Use the Property Inspector editor to enter the list. You can

open the editor by clicking the button to the right of the property name.
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To display the & character in a label, use two & characters in the string.
The words remove, default, and factory (case sensitive) are reserved.

To use one of these as a label, prepend a backslash (\) to the string. For
example, \remove yields remove.

If the width of the component is too small to accommodate one or more of
the specified strings, MATLAB software truncates those strings with an
ellipsis.

® Specify selection by using the Value property together with the Max and
Min properties.

= To select a single item when the component is created, set Value to
a scalar that indicates the index of the selected list item, where 1
corresponds to the first item in the list.
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= To select more than one item when the component is created, set Value
to a vector of indices of the selected items. Value = [1,3] results in the
following selection.

WO

four

=

To enable selection of more than one item, you must specify the Max and
Min properties so that their difference is greater than 1. For example,
Max = 2, Min = 0. Max default is 1, Min default is 0.

= If you want no initial selection, set the Max and Min properties to enable
multiple selection, i.e., Max - Min > 1, and then set the Value property
to an empty matrix [].

e If the list box is not large enough to display all list entries, you can set the
ListBoxTop property to the index of the item you want to appear at the
top when the component is created.

e If you want to set the position or size of the component to an exact value,
then modify its Position property. See “Locating and Moving Components
on page 6-82 and “Resizing Components” on page 6-85 for details.

”»

Note The list box does not provide for a label. Use a “Static Text” on page
6-48 component to label the list box.

Toggle Button
To create a toggle button with label Left/Right Tile, as shown in this figure:
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¢ Specify the toggle button label by setting its String property to the desired

label, in this case, Left/Right Tile.

Ea Inspector: uicontrol (togglebuttonl "Left /Right Tile™) =] B3
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To display the & character in a label, use two & characters in the string.
The words remove, default, and factory (case sensitive) are reserved.

To use one of these as a label, prepend a backslash (\) to the string. For
example, \remove yields remove.

The toggle button accommodates only a single line of text. If you specify
more than one line, only the first line is shown. If you create a toggle button
that is too narrow to accommodate the specified String, MATLAB software
truncates the string with an ellipsis.

LeftiRight ...

® (Create the toggle button with the button selected (depressed) by setting

its Value property to the value of its Max property (default is 1). Set
Value to Min (default is 0) to leave the toggle button unselected (raised).
Correspondingly, when the user selects the toggle button, MATLAB
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software sets Value to Max, and to Min when the user deselects it. The
following figure shows the toggle button in the depressed position.

Left/Right Tile

If you want to set the position or size of the component to an exact value,
then modify its Position property. See “Locating and Moving Components
on page 6-82 and “Resizing Components” on page 6-85 for details.

”»

To add an image to a toggle button, assign the button’s CData property
an m-by-n-by-3 array of RGB values that defines a truecolor image. You
must do this programmatically in the opening function of the GUI M-file.
For example, the array img defines a 16-by-64-by-3 truecolor image using
random values between 0 and 1 (generated by rand).

img = rand(16,64,3);
set(handles.togglebuttont, 'CData’',img);

where togglebutton1i is the toggle button’s Tag property.

Note To manage exclusive selection of radio buttons and toggle buttons,
put them in a button group. See “Button Group” on page 6-59 for more
information.

Defining Panels and Button Groups

Panels and button groups are containers that arrange GUI components into
groups. If you move the panel or button group, its children move with it and
maintain their positions relative to the panel or button group.

To define panels and button groups, you must set certain properties. To do
this:
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1 Use the Property Inspector to modify the appropriate properties. Open the
Property Inspector by selecting Property Inspector from the View menu
or by clicking the Property Inspector button . B

2 In the layout area, select the component you are defining.

Note See “Available Components” on page 6-20 for descriptions of these
components. See “Examples: Programming GUIDE GUI Components” on
page 8-30 for basic examples of programming these components.

Subsequent topics describe commonly used properties of panels and button
groups and offer a simple example for each component.

¢ “Commonly Used Properties” on page 6-56

* “Panel” on page 6-57

e “Button Group” on page 6-59

Commonly Used Properties

The most commonly used properties needed to describe a panel or button
group are shown in the following table:

Property Values Description

Position 4-element vector: Size of the component
[distance from left, and its location relative
distance from bottom, to its parent.
width, height].

Title String Component label.
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Property Values Description

TitlePosition lefttop, centertop, Location of title string
righttop, leftbottom, | in relation to the panel
centerbottom, or button group.
rightbottom. Default
1s lefttop.

Units characters, Units of measurement
centimeters, inches, | used to interpret the
normalized, pixels, Position property
points. Default is vector
characters.

For a complete list of properties and for more information about the properties
listed in the table, see the Uipanel Properties and Uibuttongroup Properties
in the MATLAB reference documentation. Properties needed to control GUI
behavior are discussed in theChapter 8, “Programming a GUIDE GUI”.

Panel
To create a panel with title My Panel as shown in the following figure:
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® Specify the panel title by setting the Title property to the desired string,
in this case My Panel.

Ed Inspector: uipanel (uipanell "Panel™)

5

- [&] || m¥ m*
HEE

ShadowCalor o -
Tag uipanell -
= nypar -
TitlePosition lefttop -

To display the & character in the title, use two & characters in the string.
The words remove, default, and factory (case sensitive) are reserved. To
use one of these as a label, prepend a backslash (\) to the string. For

example, \remove yields remove.
¢ Specify the location of the panel title by selecting one of the available

TitlePosition property values from the pop-up menu, in this case
lefttop. You can position the title at the left, middle, or right of the top or

bottom of the panel.

E Inspector: vipanel {uipanell "My Panel")

S
Tag

uipanell Fl=
Title E | My Panel

TitlePosition lefttop

UIConkextMenu

centertbop

righttop
leftboktom
centerbotkom
rightboktorm
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e If you want to set the position or size of the panel to an exact value, then
modify its Position property. See “Locating and Moving Components” on
page 6-82 and “Resizing Components” on page 6-85 for details.

Note For more information and additional tips and techniques, see
“Adding a Component to a Panel or Button Group” on page 6-34 and the
uipanel reference documentation.

Button Group

To create a button group with title My Button Group as shown in the
following figure:
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¢ Specify the button group title by setting the Title property to the desired
string, in this case My Button Group.
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Eé Inspector: uvitools.uibuttongroup (uipanel? "My Butto... =] B3

AN

ShadowCalor o -
Tag uvipanelz -
= | My Button Group .
TitlePosition lefttop -

To display the & character in the title, use two & characters in the string.
The words remove, default, and factory (case sensitive) are reserved. To
use one of these as a label, prepend a backslash (\) to the string. For
example, \remove yields remove.

¢ Specify the location of the button group title by selecting one of the
available TitlePosition property values from the pop-up menu, in this
case lefttop. You can position the title at the left, middle, or right of the

top or bottom of the button group.

E Inspector: uitools.uibuttongroup {uipanel? "My Butto... =] E3

ANEL

Title: = | My Button Group -
TitlePosition lefttop
UIConkesxkMeny M
nits centerbop -
righttop
leftboktomn
centerbottom
rightboktom

¢ [f you want to set the position or size of the button group to an exact value,
then modify its Position property. See “Locating and Moving Components”
on page 6-82 and “Resizing Components” on page 6-85 for details.
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Note For more information and additional tips and techniques, see
“Adding a Component to a Panel or Button Group” on page 6-34 and the
uibuttongroup reference documentation.

Defining Axes
Axes enable your GUI to display graphics such as graphs and images using
commands such as: plot, surf, 1line, bar, polar, pie, contour, and mesh.

To define an axes, you must set certain properties. To do this:

1 Use the Property Inspector to modify the appropriate properties. Open the
Property Inspector by selecting Property Inspector from the View menu
or by clicking the Property Inspector button=.

2 In the layout area, select the component you are defining.

Note See“Available Components” on page 6-20 for a description of this
component.

Subsequent topics describe commonly used properties of axes and offer a
simple example.

¢ “Commonly Used Properties” on page 6-61

* “Axes” on page 6-62

Commonly Used Properties
The most commonly used properties needed to describe an axes are shown
in the following table:
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Property Values Description

NextPlot add, replace, Specifies whether
replacechildren. plotting adds graphics,
Default is replace replaces graphics and

resets axes properties
to default, or replaces
graphics only.

Position 4-element vector: Size of the component
[distance from left, and its location relative
distance from bottom, to its parent.
width, height].

Units normalized, Units of measurement
centimeters, used to interpret
characters, inches, position vector

pixels, points.
Default is normalized.

For a complete list of properties and for more information about the properties
listed in the table, see Axes Properties in the MATLAB documentation.
Properties needed to control GUI behavior are discussed in Chapter 8,
“Programming a GUIDE GUT”.

See commands such as the following for more information on axes objects:
plot, surf, line, bar, polar, pie, contour, imagesc, and mesh. See “Function
Reference” in the MATLAB Function Reference documentation for a complete
list.

Many of these graphing functions reset axes properties by default, according
to the setting of its NextPlot property, which can cause unwanted behavior in
a GUI, such as resetting axis limits and removing axes context menus and
callbacks. See the next section and also “Adding Axes” on page 11-38 in the
Creating GUIs Programmatically section for information on details on setting
the NextPlot axes property.

Axes

To create an axes as shown in the following figure:
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) untitled [_ | |

0.8
0.5
0.4

0.2

¢ Allow for tick marks to be placed outside the box that appears in the Layout
Editor. The axes above looks like this in the layout editor; placement allows
space at the left and bottom of the axes for tick marks. Functions that draw
in the axes update the tick marks appropriately.
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¢ Use the title, xlabel, ylabel, zlabel, and text functions in the GUI
M-file to label an axes component. For example,

xlh = (axes_handle, 'Years')

labels the X-axis as Years. The handle of the X-axis label is x1h. See
“Callback Syntax and Arguments” on page 8-15 for information about
determining the axes handle.

The words remove, default, and factory (case sensitive) are reserved. To
use one of these in component text, prepend a backslash (\) to the string.
For example, \remove yields remove.

¢ If you want to set the position or size of the axes to an exact value, then
modify its Position property. See “Locating and Moving Components” on
page 6-82 and “Resizing Components” on page 6-85 for details.
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¢ If you customize axes properties, some of them (or example, callbacks, font
characteristics, and axis limits and ticks) may get reset to default every
time you draw a graph into the axes when the NextPlot property has its
default value of 'replace'. To keep customized properties as you want
them, set NextPlot to 'replacechildren' in the Property Inspector, as
shown here.

=
=) = =
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Inkerruptible an -
Layer baktom -

LineStyleQrder S

Lin='Width 0.5 &
MinorGridLineStyle ! = s
MextPlot replace -
OuterPosition new
PlotBoxAspectR, .. add
PlotBoxAspectR. .. replace
postion |_replacechidren

2 -

Defining Tables

Tables enable you to display data in a two dimensional table. You can use the
Property Inspector to get and set the object property values.

Commonly Used Properties

The most commonly used properties of a table component are listed in the
table below. These are grouped in the order they appear in the Table Property
Editor. Please refer to uitable command documentation for detail of all

the table properties:
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Group Property Values Description
Column ColumnName 1-by-n cell array | The header label
of strings | of the column.
{numbered’} |
empty matrix ([])
ColumnFormat Cell array of Determines
strings display and
editablility of
columns
ColumnWidth 1-by-n cell array | Width of each
or 'auto’ column in
pixels; individual
column widths
can also be set to
"auto’
ColumnEditable | logical 1-by-n Determines data
matrix | scalar in a column as
logical value | editable
empty matrix
(I}
Row RowName 1-by-n cell array | Row header label
of strings names
Color BackgroundColor| n-by-3 matrix of | Background color
RGB triples of cells
RowStriping {on} | off Color striping of
table rows
Data Data Matrix or cell Table data.
array of numeric,
logical, or
character data

Creating a Table

To create a GUI with a table in GUIDE as shown, do the following:
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JRguel =10/ x]

Fil=: Edit View Insert Tools Desktop Window Help u
Rate | Arnounk | Available | Fixed/Adj |
1 £.1250 456 .35 i [ Fixed |
2 §.7500 510.23 r [Adusta.. -
3 7] §58.20 - [ Fixed -1

Drag the table icon on to the Layout Editor and right click in the table. Select
Table Property Editor from its pop-up context menu. You can also select
Table Property Editor from the Tools menu when you select a table by
itself.
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Using the Table Property Editor. When you open it this way, the Table

Property Inspector by clicking one of its Table Property Editor icons =
which case the Table Property Editor opens to display the pane appropriate
for the property you clicked.

Clicking items in the list on the left hand side of the Table Property Editor
changes the contents of the pane to the right . Use the items to activate
controls for specifying the table’s Columns, Rows, Data, and Color options.

The Columns and Rows panes each have a data entry area where you can
type names and set properties. on a per-column or per-row basis. You can edit
only one row or column definition at a time. These panes contain a vertical
group of five buttons for editing and navigating:
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Button | Purpose Accelerator Keys
Windows | Macintosh
Insert Inserts a new column or row Insert Insert
definition entry below the current
one
Delete Deletes the current column or row | Ctrl+D Cmd+D
definition entry (no undo)
Copy Inserts a Copy of the selected Ctrl+P Cmd+P
entrv in a new row below it
Up Moves selected entry up one row Ctrl+ Cmd+
uparrow uparrow
Down Moves selected entry down one Ctrl+ Cmd+
row downarrow| downarrow

Keyboard equivalents only operate when the cursor is in the data entry area.
In addition to those listed above, typing Ctrl+T or Cmd+T selects the entire
field containing the cursor for editing (if the field contains text).

To save changes to the table you make in the Table Property Editor, click OK,
or click Apply commit changes and keep on using the Table Property Editor.

Set Column Properties. Click Insert to add two more columns.
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l?f'Tahle Property Editor E
Columns
Rows
Data 0 Unless column names are specified below, the number of columns appearing in the table is determined by the number of columns in
Calors Data,

Column Headers

~ Do not show column headers
* Show numbered column headers

~ Show names entered below as the column headers: Clickto insert more columns

Column Definitions

0_.

# Mame Auko Width Width (px) Editable Farmat + Insert '
1 I O Let MATLAE Choose
2 Il O Let MATLAE Choose =2 Copy
3 v O Let MATLAE Choaose
4 ™ [Let MATLAB Choose = Delete |

‘ Down
&8 Edit...

FLf

QK | Cancel | Apply | Help |

Select Show names entered below as the column headers and set the
ColumnName by entering Rate, Amount, Available, and Fixed/Adj in Name
group. for the Available and Fixed/Adj columns set the ColumnEditable
property to on. Lastly set the ColumnFormat for the four columns
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;{l‘ Table Property Editor X

Calumns
Raows
Data
Calors

Columns

in Data.

0 Unless column names are specified below, the number of columns appearing in the table is determined by the number of columns

Column Headers

= Do not show column headers

Select this option to display

= Show numbered colu column names
+ Show names entered below as the column headers:

Column Definitions

Enter column names here

columns editable

K |

# Name Auto Width Width (px) Edtable |/~ “ormat + Insert |
1 fRat= v T fumeric Y

2 | lamount | v | Custom... | B copy |
3 ||availsble | rd /¥ ™ |Let MATLAE fhoose

4 \Fixed/adi/ v ¥ ) [hoice List./ = Delete |

/ =
Make the third and féurth Specify the display of

4+

the column here & Dow

&% Edit...

i

Cancel | Apply | Help |

For the Rate column, select Numeric. For the Amount Column select
Custom and in the Custom Format Editor, choose Bank.
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n?i' Custom Format Editor

Select an autput farmat For numeric values:

short 3.1416 Scaled Fixed point with 4 digits precision

long 3.14159265358979 Scaled Fixed point with 7/14 digits precision

short 3.1416e+000 Floating paint with 4 digits precision

long & 3.141592653589793e+000 Floating paint with 714 digits precision

short g 3.1416 Best af fixed or floating point with 4 digits precision
long q 3.14159265358979 Best af fixed or floating point with 7/14 digits precision
short eng 3. 1416e+000 Engineering Farmat with 4 digits precision

long eng  3.141592653589792+000 Engineering Format with 714 digits precision

bank 314 Fixed dollars and cents

rat 355/113 Ratio of small integers

+ + + For positive, - for negative, blank for zero

Example: PI displays as 3.14 |

Ok Cancel |

Leave the Available column at the default value. This allows MATLAB to
chose based on the value of the Data property of the table. For the Fixed/Ad]
column select Choice List to create a pop-up menu. In the Choice List
Editor, click Insert to add a second choice and type Fixed and Adjustable
as the 2 choices.
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wif Choice List Editor

Enter options ko appear in the choice list:

# Choice + Inserk

1 |Fixed
“Adjustable % Copy
= Delete

+w

‘ Down

Qk Cancel

Note The In order for a user to select items from a choice list, the
ColumnEditable property of the column the list occupies must be set to
"true'. The pop-up control only appears when the column is editable.

Set Row Properties. In the Row tab, leave the default RowName, Show
numbered row headers.
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;{i‘ Table Property Editor ]
Calumns Rows
Raows
Data

Calors

|0 Unless row names are specified below, the number of rows appearing in the kable is determined by the number of rows in data. |

¢ Do not show row headers  Default row name seletion: gives

r_/—’_"yuu numberd rows
» Show numbered row headers

~ Show names entered below as the row headers:

Mame + Insert

=5 Copy

| ra ||

= Delete

%+ Up
‘ Dawn

il

QK | Cancel Apply | Help |

Set Data Properties. Specify the value of the Data you want in the table.
You need create Data in the MATLAB command window before you specify it
in GUIDE. For this example, type:

dat = {6.125, 456.3457, true, 'Fixed';...
6.75, 510.2342, false, 'Adjustable';...
7, 658.2, false, 'Fixed';};

In the Table Property Editor, select the data that you defined and select
Change data value to the selected workspace variable below.


file:///B:/matlab/doc/src/toolbox/matlab/ref/uitableproperties.html%23Data
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o To load data from a filz, or to create data manually, Firsk skare the data in a workspace variablz,
{0

O

Set Color Properties. Specify the BackgroundColor and RowStriping for
your table in the Color tab.
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You can change other uitable properties to the table via the Property
Inspector.

Adding ActiveX Controls

When you drag an ActiveX component from the component palette into the
layout area, GUIDE opens a dialog box, similar to the following, that lists the
registered ActiveX controls on your system.
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Note If MATLAB software is not installed locally on your computer — for
example, if you are running the software over a network — you might not
find the ActiveX control described in this example. To register the control,
see “Registering Controls and Servers” in the MATLAB External Interfaces
documentation.

Select an ActiveX Control x|

ActiveX Control List: Preview:

hdicrozoft Slider Cortrol, version 6.0 ;I
hicrosoft StatusBar Contral, version 6.
hicrosoft TakStrip Contral, version 6.0
hicrosoft Toolkar Control, wersion 6.0
hicrosoft TreeMiew Control, version 6.

Label

hicrosoft Wieb Broveser
hicrosoft Windowes Report Control

O

Mwesarpd Control
Methesting Application
s Post Data

Olelnztall Class

Outlook Express Mime Editar
Popup Cantral

Preview Class

PriSum Clazs
Rat Cortrol Prugram ICv: b= P bl zampCrl 1
RefEdit Ctrl Location: | matiakibintwin32mwsarmp ocx

FegizCtrl -
TN M awven e e
kil I _'*I_I

Create Cancel Helgp
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1 Select the desired ActiveX control. The right panel shows a preview of
the selected control.

2 Click Create. The control appears as a small box in the Layout Editor.

3 Resize the control to approximately the size of the square shown in the
preview pane. You can do this by clicking and dragging a corner of the
control, as shown in the following figure.

activexl

—— Resize the control by cicking and drogging

When you select an ActiveX control, you can open the ActiveX Property Editor
by right-clicking and selecting ActiveX Property Editor from the context
menu or clicking the Tools menu and selecting it from there.

Note What an ActiveX Property Editor contains and looks like is
dependent on what user controls that the authors of the particular ActiveX
object have created and stored in the GUI for the object. In some cases, a GUI
without controls or no GUI at all appears when you select this menu item.

See “ActiveX Control” on page 8-48 for information about programming a
sample ActiveX control and an example.
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Working with Components in the Layout Area
This topic provides basic information about selecting, copying, pasting, and

deleting components in the layout area.

e “Selecting Components” on page 6-79

® “Copying, Cutting, and Clearing Components” on page 6-80
e “Pasting and Duplicating Components” on page 6-80

* “Front-to-Back Positioning” on page 6-81

Other topics that may be of interest are

“Locating and Moving Components” on page 6-82

“Resizing Components” on page 6-85

“Aligning Components” on page 6-88

“Setting Tab Order” on page 6-97

Selecting Components
You can select components in the layout area in the following ways:

¢ (Click a single component to select it.

¢ Press Ctrl+A to select all child objects of the figure. This does not select
components that are child objects of panels or button groups.

¢ (Click and drag the cursor to create a rectangle that encloses the components
you want to select. If the rectangle encloses a panel or button group, only
the panel or button group is selected, not its children. If the rectangle
encloses part of a panel or button group, only the components within the
rectangle that are child objects of the panel or button group are selected.

¢ Select multiple components using the Shift and Ctrl keys.
In some cases, a component may lie outside its parent’s boundary. Such a
component is not visible in the Layout Editor but can be selected by dragging

a rectangle that encloses it or by selecting it in the Object Browser. Such a
component is visible in the active GUI.
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See “Viewing the Object Hierarchy” on page 6-135 for information about the
Object Browser.

Note You can select multiple components only if they have the same parent.
To determine the child objects of a figure, panel, or button group, use the
Object Browser.

Copying, Cutting, and Clearing Components

Use standard menu and pop-up menu commands, toolbar icons, keyboard
keys, and shortcut keys to copy, cut, and clear components.

Copying. Copying places a copy of the selected components on the clipboard.
A copy of a panel or button group includes its children.

Cutting. Cutting places a copy of the selected components on the clipboard
and deletes them from the layout area. If you cut a panel or button group, you
also cut its children.

Clearing. Clearing deletes the selected components from the layout area. It

does not place a copy of the components on the clipboard. If you clear a panel
or button group, you also clear its children.

Pasting and Duplicating Components

Pasting. Use standard menu and pop-up menu commands, toolbar icons,
and shortcut keys to paste components. GUIDE pastes the contents of the
clipboard to the location of the last mouse click. It positions the upper-left
corner of the contents at the mouse click.

Consecutive pastes place each copy to the lower right of the last one.

Duplicating. Select one or more components that you want to duplicate,
then do one of the following:

* Copy and paste the selected components as described above.
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¢ Select Duplicate from the Edit menu or the pop-up menu. Duplicate
places the copy to the lower right of the original.

¢ Right-click and drag the component to the desired location. The position
of the cursor when you drop the components determines the parent of all
the selected components. Look for the highlight as described in “Adding a
Component to a Panel or Button Group” on page 6-34.

Front-to-Back Positioning

MATLAB figures maintain separate stacks that control the front-to-back
positioning for different kinds of components:

e User interface controls such as buttons, sliders, and pop-up menus

¢ Panels, button groups, and axes

® ActiveX controls

You can control the front-to-back positioning of components that overlap only

if those components are in the same stack. For overlapping components that
are in different stacks:

e User interface controls always appear on top of panels, button groups,
and axes that they overlap.

e ActiveX controls appear on top of everything they overlap.

The Layout Editor provides four operations that enable you to control
front-to-back positioning. All are available from the Layout menu, which is
shown in the following figure.

Layout Tools Help

v Snap to Grid

Bring to Front  Ckrl+F
Send to Back  Ckrl+B
Bring Forward
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Bring to Front — Move the selected object(s) in front of nonselected
objects (available from the right-click context menu, the Layout menu, or
the Ctrl+F shortcut).

Send to Back — Move the selected object(s) behind nonselected objects
(available from the right-click context menu, the Layout menu, or the
Ctrl+B shortcut).

Bring Forward — Move the selected object(s) forward by one level, i.e., in
front of the object directly forward of it, but not in front of all objects that
overlay it (available from the Layout menu).

Send Backward — Move the selected object(s) back by one level, i.e.,
behind the object directly in back of it, but not behind all objects that are
behind it (available from the Layout menu).

Note Changing front-to-back positioning of components also changes their
tab order. See “Setting Tab Order” on page 6-97 for more information.

Locating and Moving Components
You can locate or move components in one of the following ways:

“Using Coordinate Readouts” on page 6-82

“Dragging Components” on page 6-83

“Using Arrow Keys to Move Components” on page 6-84
“Setting the Component’s Position Property” on page 6-84

Another topic that may be of interest is

“Aligning Components” on page 6-88

Using Coordinate Readouts

Coordinate readouts indicate where a component is placed and where the

mouse pointer is located. Use these readouts to position and align components

manually. The coordinate readout in the lower right corner of the Layout
Editor shows the position of a selected component or components as [xleft
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ybottom width height]. These values are displayed in units of pixels,
regardless of the coordinate units you select for components.

If you drag or resize the component, the readout updates accordingly. The
readout to the left of the component position readout displays the current
mouse position, also in pixels. The following readout example shows a
selected component that has a position of [35, 30, 180, 1801, a 180-by-180
pixel object with a lower left corner at x=35 and y=30, and locates the mouse
position at [200, 30].

|Current Point: [200,301  |Pasition: [35, 30, 180, 1801

When you select multiple objects, the Position readout displays numbers for
X, ¥, width and height only if the objects have the same respective values;
in all other cases it displays 'MULTI'. For example, if you select two check
boxes, one with Position [250, 140, 76, 20] pixels and the other with
position [250, 190, 68, 20] pixels, the Position readout indicates [250,
MULTI, MULTI, 20].

Dragging Components

Select one or more components that you want to move, then drag them to the
desired position and drop them. You can move components from the figure
into a panel or button group. You can move components from a panel or
button group into the figure or into another panel or button group.

The position of the cursor when you drop the components also determines the
parent of all the selected components. Look for the highlight as described in
“Adding a Component to a Panel or Button Group” on page 6-34.

In some cases, one or more of the selected components may lie outside its
parent’s boundary. Such a component is not visible in the Layout Editor but
can be selected by dragging a rectangle that encloses it or by selecting it in
the Object Browser. Such a component is visible in the active GUI.

See “Viewing the Object Hierarchy” on page 6-135 for information about the
Object Browser.
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Note To select multiple components, they must have the same parent. That
1s, they must be contained in the same figure, panel, or button group.

Using Arrow Keys to Move Components

Select one or more components that you want to move, then press and hold
the arrow keys until the components have moved to the desired position. Note
that the components remain children of the figure, panel, or button group
from which you move them, even if they move outside its boundaries.

Setting the Component’s Position Property

Select one or more components that you want to move. Then open the Property
Inspector from the View menu or by clicking the Property Inspector button E.

1 In the Property Inspector, scroll to the Units property and note whether
the current setting is characters or normalized. Click the button next to
Units and then change the setting to inches from the pop-up menu.

i Inspector: figure {Untitled)

Ll antextiMenu Mone w7

Inits characters -

Wisible centimehers

Wi =] niarmalized

-

poinks
pixels

characters
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2 Click the + sign next to Position. The Property Inspector displays the
elements of the Position property.

E# Inspector: figure {Untitled)

B8] e =t

Pointer shapeHotspot [ [1x2 dauble array] ”
B Position [103.8 29,154 112 32,308]
x 103.5 &
y 29,154 &
width 112.0 & -
hieight 32,305 P
Renderer Mone L

3 If you have selected

¢ Only one component, type the x and y coordinates of the point where you
want the lower-left corner of the component to appear.

® More than one component, type either the x or the y coordinate to align
the components along that dimension.

4 Reset the Units property to its previous setting, either characters or
normalized.

Note Setting the Units property to characters (nonresizable GUIs) or
normalized (resizable GUIs) gives the GUI a more consistent appearance
across platforms. See “Cross-Platform Compatible Units” on page 6-138 for
more information.

Resizing Components
You can resize components in one of the following ways:

® “Dragging a Corner of the Component” on page 6-86
e “Setting the Component’s Position Property” on page 6-86
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Dragging a Corner of the Component
Select the component you want to resize. Click one of the corner handles and

drag it until the component is the desired size.
I

Puszh Button

|- | B Resize the campanant by clicking and dragging
[

Setting the Component’s Position Property

Select one or more components that you want to resize. Then open the
Property Inspector from the View menu or by clicking the Property Inspector
button E3.

1 In the Property Inspector, scroll to the Units property and note whether
the current setting is characters or normalized. Click the button next to
Units and then change the setting to inches from the pop-up menu.

Es Inspector: figure (Untitled)

01 = =

Ll ontextMenu MNone [

Inits characters -

Visible centimebers

. -
Vi 12l normalized

pioinks
pixels
characters

6-86



Adding Components to the GUI

2 Click the + sign next to Position. The Property Inspector displays the
elements of the Position property.

E# Inspector: figure {Untitled)

B8] e =t

Pointer shapeHotspot [ [1x2 dauble array] ”
B Position [103.8 29,154 112 32,308]
x 103.5 &
y 29,154 &
width 112.0 & -
hieight 32,305 P
Renderer Mone L

3 Type the width and height you want the components to be.

4 Reset the Units property to its previous setting, either characters or
normalized.

Note To select multiple components, they must have the same parent.
That is, they must be contained in the same figure, panel, or button group.
See “Selecting Components” on page 6-79 for more information. Setting the
Units property to characters (nonresizable GUIs) or normalized (resizable
GUIs) gives the GUI a more consistent appearance across platforms. See
“Cross-Platform Compatible Units” on page 6-138 for more information.
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Aligning Components

In this section...

“Alignment Tool” on page 6-88
“Property Inspector” on page 6-91
“Grid and Rulers” on page 6-95

“Guide Lines” on page 6-95

Alignment Tool

The Alignment Tool enables you to position objects with respect to each other
and to adjust the spacing between selected objects. The specified alignment
operations apply to all components that are selected when you press the
Apply button.

Note To select multiple components, they must have the same parent. That
is, they must be contained in the same figure, panel, or button group. See
“Selecting Components” on page 6-79 for more information.




Aligning Components

<} Align Objects =101 x|

~ertical
Align IF'JIII_EI BA8| ol
Distriute §:¢|g:t e =
r Setapacinglzﬂ pixels

~ Horizontal
e
Distribute Elﬂlle,F' i Y
r Setspacinglzﬂ pixels

appty | cancel

The alignment tool provides two types of alignment operations:

® Align — Align all selected components to a single reference line.
¢ Distribute — Space all selected components uniformly with respect to

each other.

Both types of alignment can be applied in the vertical and horizontal
directions. In many cases, it is better to apply alignments independently to
the vertical and horizontal using two separate steps.
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Align Options

There are both vertical and horizontal align options. Each option aligns
selected components to a reference line, which is determined by the bounding
box that encloses the selected objects. For example, the following picture of
the layout area shows the bounding box (indicated by the dashed line) formed
by three selected push buttons.

a0
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FS
e

270

2E0

270

e
Push Buttan I
| .
m
| Push Button |
I = I L
I I .
5 Push Euitton . Bounding box for the

selected components

220

& 170

-

All of the align options (vertical top, center, bottom and horizontal left, center,
right) place the selected components with respect to the corresponding edge
(or center) of this bounding box.

Distribute Options
Distributing components adds equal space between all components in the

selected group. The distribute options operate in two different modes:
e Equally space selected components within the bounding box (default)

® Space selected components to a specified value in pixels (check Set spacing
and specify a pixel value)



Aligning Components

Both modes enable you to specify how the spacing is measured, as indicated
by the button labels on the alignment tool. These options include spacing
measured with respect to the following edges:

e Vertical — inner, top, center, and bottom

¢ Horizontal — inner, left, center, and right

Property Inspector

About the Property Inspector

In GUIDE, as in MATLAB generally, you can see and set most components’
properties using the Property Inspector. To open it from the GUIDE Layout
Editor, do any of the following:

e Select the component you want to inspect, or double-click it to open the
Property Inspector and bring it to the foreground

e Select Property Inspector from the View menu

¢ (Click the Property Inspector button =

The Property Inspector window opens, displaying the properties of the
selected component. For example, here is a view of a push button’s properties.
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=10 x|
2= (8] = =
BackgroundCalor ﬂ 1 I~
BeingDeleted aff
BusyAckion queus -
ButtonDownFcn ﬁ &
CData Eﬂ [0x0 double array] &
Callback: g YeauUkomatic &
Clipping N an -
CreateFon @ﬁ &
DeleteFeon g &
Enable D an -
Extent [0012.41.385]
Fontangle narmal -
Fonthame M5 Sans Serif P
FankSize 8.0 &
FontUniks poinks -
FontWeight narmal -
ForegroundCalar ﬂ [ ]
Handlevisibility an -
HitTesk an -
HorizantalAlignment center -
Interruptible an -
KewvPressFrn ‘:«Eﬁl o

Scroll down to see additional properties. Click any property value or icon to
the left of one to set its value, either directly in that field or via a modal GUI
such as a pop-up menu, text dialog, or color picker. Click the plus boxes on
the left margin to expand multiline properties, such as BackgroundColor,
Extent, and Position.
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The Property Inspector provides context-sensitive help for individual
properties. Right-clicking a property name or value opens a context menu
item saying What’s This?. Clicking it opens a Help window displaying
documentation for the property you selected. For example, on the right is
context-sensitive help for the push button ButtonDownFcn obtained from the
Property Inspector as shown on the left.

o |m||Fq - ) Uicontrol Properties = Functions (MATLABE) x|
L ButtonDownFcn :l
string or function handle (GUIDE sets this property)

Ei Inspector: uicontrol (pushbuttoni "Push B

BackgroundCalar & =
BeingDeleted off Butfon-press callback routine. A callback routine that
i can execute when you press a mouse button while the
BusyAction queus - - B - ; . =
pointer is on or near a uicontrol. Specifically:

ButtonDownFcn @é &

CData H [MM " ¢ [fthe uicontrol's Enable property is set to on,
callback | Pbaukomati s the ButtonDownFen callback executes when

allbad oduUtomaric

you click the right or left mouse button in a
5-pixel border around the uicentrol or when you
click the right mouse button on the control
itself.

If the vicontrol's Enakble property is set to
inactive of off, the ButtonDownFen
executes when you click the right or left mouse
button in the 5-pixel border or on the control
itself.

This is useful for implementing actions to interactively
modify control object properties, such as size and
position, when they are clicked on (using

. -
selertmnveracize for exvamnlel
“| | 4

For more information, see “Accessing Object Properties with the Property
Inspector” in the MATLAB Graphics documentation.

Using the Property Inspector to Align Components

The Property Inspector enables you to align components by setting their
Position properties. A component’s Position property is a 4-element vector
that specifies the location of the component on the GUI and its size: [distance
from left, distance from bottom, width, height]. The values are given in the
units specified by the Units property of the component.
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6-94

1 Select the components you want to align. See “Selecting Components” on
page 6-79 for information.

2 Select Property Inspector from the View menu or click the Property
Inspector button .

3 In the Property Inspector, scroll to the Units property and note its current
setting, then change the setting to inches.

4 Scroll to the Position property. A null value means that the element
differs in value for the different components. This figure shows the
Position property for multiple components of the same size.

g Inspector: Multiple objects selected
| L
r il < Y
(=] Position
% Pt &
y Flki -
widkh 13.8 .f?-—l
hizight: 1.769 &
-
Cmlmmbimm ik liab -

5 Change the value of x to align their left sides. Change the value of y to
align their bottom edges. For example, setting x to 2.0 aligns the left sides
of the components 2 inches from the left side of the GUI.

6 When the components are aligned, change the Units property back to its
original setting.
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Grid and Rulers

The layout area displays a grid and rulers to facilitate component layout.
Grid lines are spaced at 50-pixel intervals by default and you can select from
a number of other values ranging from 10 to 200 pixels. You can optionally
enable snap-to-grid, which causes any object that is moved close to a grid line
to jump to that line. Snap-to-grid works with or without a visible grid.

«) Grid and Rulers =101 ]

[ Show rulers

W Show guides

WV Show grid

Grid Size (in Pixels): ISIII Yl
r

]2 | Cancel |

Use the Grid and Rulers dialog (select Grid and Rulers from the Tools
menu) to:

¢ Control visibility of rulers, grid, and guide lines

® Set the grid spacing

® Enable or disable snap-to-grid

Guide Lines

The Layout Editor has both vertical and horizontal snap-to guide lines.
Components snap to the line when you move them close to the line.

Guide lines are useful when you want to establish a reference for component
alignment at an arbitrary location in the Layout Editor.
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Creating Guide Lines

To create a guide line, click the top or left ruler and drag the line into the

layout area.
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Setting Tab Order

A GUT’s tab order is the order in which components of the GUI acquire focus
when a user presses the Tab key on the keyboard. Focus is generally denoted
by a border or a dotted border.

You can set, independently, the tab order of components that have the same
parent. The GUI figure and each panel and button group in it has its own tab
order. For example, you can set the tab order of components that have the
figure as a parent. You can also set the tab order of components that have a
panel or button group as a parent.

If, in tabbing through the components at the figure level, a user tabs to a panel
or button group, then subsequent tabs sequence through the components of
the panel or button group before returning to the level from which the panel
or button group was reached.

Note Axes cannot be tabbed. From GUIDE, you cannot include ActiveX
components in the tab order.

When you create a GUI, GUIDE sets the tab order at each level to be the
order in which you add components to that level in the Layout Editor. This
may not be the best order for the user.

Note Tab order also affects the stacking order of components. If components
overlap, those that appear lower in the tabbing order, are drawn on top of
those that appear higher in the order. See “Front-to-Back Positioning” on
page 6-81 for more information.
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The figure in the following GUI contains an axes component, a slider, a panel,
static text, and a pop-up menu. Of these, only the slider, the panel, and the
pop-up menu at the figure level can be tabbed. The panel contains three
push buttons, which can all be tabbed.

@il simple_gui_tab.fig - |EI|5|
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To examine and change the tab order of the panel components, click the panel
background to select it, then select Tab Order Editor in the Tools menu
of the Layout Editor.

I x]

e -
| ] -

EA vicontrol (surf_pushbutton "Surf™)
uicontral {mesh_pushbuttan "Mesh™
uiconkral {contour_pushbutton "Contour™)

== uicontrol {plot_popup "peaks™)

The Tab Order Editor displays the panel’s components in their current tab
order. To change the tab order, select a component and press the up or down
arrow to move the component up or down in the list. If you set the tab order
for the first three components in the example to be

1 Surf push button
2 Contour push button
3 Mesh push button

the user first tabs to the Surf push button, then to the Contour push button,
and then to the Mesh push button. Subsequent tabs sequence through the
remaining components at the figure level.
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Creating Menus

In this section...

“Menus for the Menu Bar” on page 6-102

“Context Menus” on page 6-113

You can use GUIDE to give GUIs menu bars with pull-down menus as well as
context menus that you attach to components. You can create both types of
menus using the Menu Editor. Access the Menu Editor from the Tools menu
or click the Menu Editor button E
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Create a new menu item Move selected menu item

Create a new context menu

Create a new menu

Delete selected item

Menu Ed tor

~Properties
Click New Menu bufton Mothing selected.

on foofbar

Menu Bar Context Menus

[ | [oes]

Note In general, programming conventions described for components in
Chapter 8, “Programming a GUIDE GUI” also apply to menu items. See
“Menu Item” on page 8-58 and “Updating a Menu Item Check” on page 8-59
for information about programming and basic examples.
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Menus for the Menu Bar

e “How Menus Affect Figure Docking” on page 6-102

¢ “Adding Standard Menus to the Menu Bar” on page 6-103
e “Creating a Menu” on page 6-105

e “Adding Items to a Menu” on page 6-108

e “Additional Drop-Down Menus” on page 6-110

e “Cascading Menus” on page 6-111

When you create a drop-down menu, GUIDE adds its title to the GUI menu
bar. You then can create menu items for that menu. Each menu item can
have a cascading menu, also known as a submenu, and these items can have
cascading menus, and so on.

How Menus Affect Figure Docking

By default, when you create a GUI with GUIDE, it does not create a menu
bar for that GUIL You might not need menus for your GUI, but if you want
the user to be able to dock or undock the GUI, it must contain a menu bar or
a toolbar. This is because docking is controlled by the docking icon, a small
curved arrow near the upper-right corner of the menu bar or the toolbar,

as the following illustration shows.

>;IQI£I

Figure windows with a standard menu bar also have a Desktop menu from
which the user can dock and undock them.

To display the docking arrow and the Desktop > Dock Figure menu item,
use the Property Inspector to set the figure property DockControls to 'on'.
You must also set the MenuBar and/or ToolBar figure properties to 'on' to
display docking controls.
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The WindowStyle figure property also affects docking behavior. The default is
'normal’, but if you change it to 'docked', then the following applies:

e The GUI opens docked in the desktop when you run it.

® The DockControls property is set to 'on' and cannot be turned off until
WindowStyle is no longer set to 'docked"'.

¢ If you undock a GUI created with WindowStyle 'docked', it will have not
have a docking arrow unless the figure displays a menu bar or a toolbar
(either standard or customized). When it has no docking arrow, users can
undock it from the desktop, but will be unable to redock it there.

However, when you provide your own menu bar or toolbar using GUIDE, it
can display the docking arrow if you want the GUI to be dockable. See the
following sections and “Creating Toolbars” on page 6-121 for details.

Note GUIs that are modal dialogs (figures with WindowStyle set to 'modal')
cannot have menu bars, toolbars, or docking controls.

For more information, see the DockControls, MenuBar, ToolBar, and
WindowStyle property descriptions on the figure properties reference page, or
select the figure background in GUIDE right-click these property names in
the Property Inspector.

Adding Standard Menus to the Menu Bar

The figure MenuBar property controls whether your GUI displays the
MATLAB standard menus on the menu bar. GUIDE initially sets the value
of MenuBar to none. If you want your GUI to display the MATLAB standard
menus, use the Property Inspector to set MenuBar to figure.

o [f the value of MenuBar is none, GUIDE automatically adds a menu bar that
displays only the menus you create.

¢ [f the value of MenuBar is figure, the GUI displays the MATLAB standard
menus and GUIDE adds the menus you create to the right side of the menu
bar.
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In either case, you can enable users of your GUI to dock and undock it using
its docking arrow by setting the figure’s DockControls property to 'on'.
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Creating a Menu

1 Start a new menu by clicking the New Menu button in the toolbar. A menu
title, Untitled 1, appears in the left pane of the dialog box.

E# Menu Editor
HE|e=t 0| %
wi flenu ~Properties
TICE NMew Many button Mothing selecked,
oh toolbay

mMenu Bar Context Menus

Ik Help

Note By default, GUIDE selects the Menu Bar tab when you open the
Menu Editor.

6-105



6 Laying Out o GUIDE GUI

2 Click the menu title to display a selection of menu properties in the right
pane.

Ei Menu Editor

E=fE|e=10 I |X

~UIMenu Properties

o Label: IFiIe

Taqg: IFiIe_menu|

Acceleratar; Chrl +|I"-.I|:une LI
[~ Separator above this ikem
[~ Check mark this item

[ Enable this item

Callback; I".-’-:-aut-:umatic Wiew |

Mare properkies ...

mMenu Bar Context Menus

Ik Help

3 Fill in the Label and Tag fields for the menu. For example, set Label to
File and set Tag to file_menu. Click outside the field for the change to

take effect.

Label is a string that specifies the text label for the menu item. To display
the & character in a label, use two & characters in the string. The words
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remove, default, and factory (case sensitive) are reserved. To use one
of these as labels, prepend a backslash (\) to the string. For example,
\remove yields remove.

Tag is a string that is an identifier for the menu object. It is used in the
code to identify the menu item and must be unique in the GUI.
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Adding ltems to a Menu

Use the New Menu Item tool to create menu items that are displayed in
the drop-down menu.

1 Add an Open menu item under File, by selecting File then clicking the

New Menu Item button in the toolbar. A temporary numbered menu
item label, Untitled, appears.

E# Menu Editor

BlHE| = 1 1| %
H

Mew Menu term ~UIMenu Properties
EJrms Label; IFiIe

Tag: IFiIe_menu

Accelerator; Ckrl +|I"-J|:|ne ll
[T Separator abowve this ikem
[ check mark this item

[+ Enable this item

Callback: |%autormatic Wign |
Mare properkies ... |
mMenu Bar Context Menus
K Help
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2 Fill in the Label and Tag fields for the new menu item. For example, set
Label to Open and set Tag to menu_file open. Click outside the field
for the change to take effect.

Ei Menu Editor

SRERSHRERS AR

= ~UIMenu Properties
= ElFile Label; IOpen
I_ =i (] F'“:.n

Taqg: Ihenu_FiIe_npen

Acceleratar; Chrl +IO LI
[~ Separator above this ikem
[~ Check mark this item

[ Enable this item

Callback; I".-’-:-aut-:umatic Wiew |

Mare properkies ... |

mMenu Bar Context Menus

Ik Help

You can also
® Choose an alphabetic keyboard accelerator for the menu item with the

Accelerator pop-up menu. In combination with Ctrl, this is the keyboard
equivalent for a menu item that does not have a child menu. Note that
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some accelerators may be used for other purposes on your system and that
other actions may result.

Display a separator above the menu item by checking Separator above
this item.

Display a check next to the menu item when the menu is first opened by
checking Check mark this item. A check indicates the current state of
the menu item. See the example in “Adding Items to the Context Menu” on
page 6-115.

Enable this item when the menu is first opened by checking Enable this
item. This allows the user to select this item when the menu is first
opened. If you clear this option, the menu item appears dimmed when the
menu 1s first opened, and the user cannot select it.

Specify a string for the routine, i.e., the Callback, that performs the
action associated with the menu item. If you have not yet saved the GUI,
the default value is %automatic. When you save the GUI, and if you
have not changed this field, GUIDE automatically sets the value using

a combination of the Tag field and the GUI filename. See “Menu Item”
on page 8-58 for more information about specifying this field and for
programming menu items.

The View button displays the callback, if there is one, in an editor. If you
have not yet saved the GUI, GUIDE prompts you to save it.

Open the Property Inspector, where you can change all menu properties,
by clicking the More options button. For detailed information about the
properties, see Uimenu Properties in the MATLAB documentation.

Note In general, programming conventions described for components in
Chapter 8, “Programming a GUIDE GUI” also apply to menu items. See
“Menu Item” on page 8-58 and “Updating a Menu Item Check” on page 8-59
for programming information and basic examples.

Additional Drop-Down Menus

To create additional drop-down menus, use the New Menu button in the same
way you did to create the File menu. For example, the following figure also
shows an Edit drop-down menu.
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Cascading Menus

To create a cascading menu, select the menu item that will be the title for the
cascading menu, then click the New Menu Item button. In the example
below, Copy is a cascading menu.

E# Menu Editor

=g et 1| X

~UIMenu Properties

FileClose Label; Itu:u File
— & Dpen
e Close Tag: Ieu:llt_c-:upy_tul:lle
— = Save Accelerator; Ckrl +|I"-J|:|ne ll
=] Edit
. [T Separator abowve this ikem
— &= Cut
= & Copy [T Check mark this item

=i to cliphoard

o file

[+ Enable this item

“eaubomakic Wiew |

Mare properkies ... |

Callback:

Menu Bar Context Menus

K Help
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Note See “Menu Item” on page 8-58 for information about programming
menu items.

The following Menu Editor illustration shows three menus defined for the
figure menu bar.

Ei Menu Editor

SEERSHRERS I

~UIMenu Properties

B FileClose Label: IT::u:uI Palette
— & Qpen
e Close Taqg: Imenu_wew_tu:u:ulpalette
— = Save Acceleratar; Chrl +|I"-.I|:une LI
= [E] Edit
. [~ Separator above this ikem
— &= Cut
- = Copy [~ Check mark this iterm
= {o clipboard
. [ Enable this item
= o file
= ] Wiew Callback:l".-’-:-aut-:umatic Wiew |
= Menuhar
& Toolbar Mare properkies ... |

mMenu Bar Context Menus

Ik Help

When you run the GUI, the menu titles appear in the menu bar.
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File Edit Yiew

Context Menus

A context menu is displayed when a user right-clicks the object for which the
menu 1s defined. The Menu Editor enables you to define context menus and
associate them with objects in the layout. The process has three steps:

1 “Creating the Parent Menu” on page 6-113
2 “Adding Items to the Context Menu” on page 6-115

3 “Associating the Context Menu with an Object” on page 6-119

Note See “Menus for the Menu Bar” on page 6-102 for information about
defining menus in general. See “Menu Item” on page 8-58 for information
about defining callback subfunctions for your menus.

Creating the Parent Menu

All items in a context menu are children of a menu that is not displayed on
the figure menu bar. To define the parent menu:

6-113



6 Laying Out o GUIDE GUI

1 Select the Menu Editor’s Context Menus tab and select the New Context
Menu button from the toolbar.

= ): Menu Editor =100 x|
HE(e=1 V| X
0

—| Mewy Context Menu
= = Mathing selected.

~Propetties

Mgnu Bar Context Menus

034 Help
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2 Select the menu and specify the Tag field to identify the context menu
(axes_context_menu in this example).

« ): Menu Editor =100 x|

~UIContextienu Properties

Tao: Iaxes_cnntext_menu

Callback:l%adumaﬁc Wiy

Maore options ==

Menu Ear Context Menus |

0]34 Helg

Adding Items to the Context Menu

Use the New Menu Item button to create menu items that are displayed
in the context menu.

1 Add a Blue background color menu item to the menu by selecting

axes_context_menu and clicking the New Menu Item tool. A temporary
numbered menu item label, Untitled, appears.
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+ ) Menu Editor =100 x|

BB~ 1| X

~UIContextienu Properties

Mew Menu lterm

Tao: Iaxes_cnntext_menu

Callback:l%adumaﬁc Wiy

Maore options ==

Menu Bar Context Menus

0]34 Helg
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2 Fill in the Label and Tag fields for the new menu item. For example, set
Label to Blue background color and set Tag to blue background. Click
outside the field for the change to take effect.

«,): Menu Editor

BeBE|le=1 1 |X%

=10 x|

E-E] axes_context_menu

(.

SIEIue hackground color

Menu Bar Context Menus

~Ihenu Properies

Lakel; IEFIuE! background calor

Tag: Ihlue_ban::kgrn:nund
| Separatar above this item
[T Check mark this item

[ Enable this item

Callback: [Yautomatic Wiy

hare optionzs ==

0]34 Helg

You can also

¢ Display a separator above the menu item by checking Separator above

this item.

¢ Display a check next to the menu item when the menu is first opened by
checking Check mark this item. A check indicates the current state of
the menu item. See the example in “Adding Items to the Context Menu”
on page 6-115. See “Updating a Menu Item Check” on page 8-59 for a code

example.

¢ Enable this item when the menu is first opened by checking Enable this
item. This allows the user to select this item when the menu is first
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opened. If you clear this option, the menu item appears dimmed when the
menu is first opened, and the user cannot select it.

e Specify a Callback for the menu that performs the action associated with
the menu item. If you have not yet saved the GUI, the default value
1s %automatic. When you save the GUI, and if you have not changed
this field, GUIDE automatically creates a callback in the M-file using a
combination of the Tag field and the GUI filename. The callback’s name
does not display in the Callback field of the Menu Editor, but selecting the
menu item does trigger it.

You can also type an unquoted string into the Callback field to serve as
a callback. It can be any valid MATLAB expression or command. For
example, the string

set(gca, 'Color', 'y')

sets the current axes background color to yellow. However, the preferred
approach to performing this operation is to place the callback in the GUI
M-file. This avoids the use of gca, which is not always reliable when several
figures or axes exist. Here is the M-file version of this callback:

function axesyellow_Callback(hObject, eventdata, handles)

% hObject handle to axesyellow (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)
set(handles.axes1, 'Color','y")

This code sets the background color of the GUI axes with Tag axes1 no
matter to what object the context menu is attached to.

If you enter a callback string in the Menu Editor, it overrides the callback
for the item in the M-file, if any has been saved. If you delete a string you
have entered in the Callback field, the M-file’s callback for the item is
executed when GUI runs and the item is selected.

See “Menu Item” on page 8-58 for more information about specifying

this field and for programming menu items. For another example of
programming context menus in GUIDE, see “GUI to Interactively Explore
Data in a Table” on page 10-31.

The View button displays the callback, if there is one, in an editor. If you
have not yet saved the GUI, GUIDE prompts you to save it.
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® Open the Property Inspector, where you can change all menu properties
except callbacks, by clicking the More options button. For detailed
information about these properties, see Uicontextmenu Properties in the
MATLAB documentation.

Associating the Context Menu with an Object

1 In the Layout Editor, select the object for which you are defining the
context menu.

2 Use the Property Inspector to set this object’s UIContextMenu property to
the name of the desired context menu.

The following figure shows the UIContextMenu property for the axes object
with Tag property axest.

0EE
Tag axwesl Fr- s
TickDir in -
TickDirMode auto -
TickLength [:1 [o0.01;0.025]

TightInset [4.41.231 1 0.615]
UIConkextMe axes_conkexk_rmenu T

<Mone >

axes_conkext_menu

!

In the GUI M-file, complete the callback subfunction for each item in the
context menu. Each callback executes when a user selects the associated
context menu item. See “Menu Item” on page 8-58 for information on defining
the syntax.
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Note In general, programming conventions described for components in
Chapter 8, “Programming a GUIDE GUI” also apply to menu items. See
“Menu Item” on page 8-58 and “Updating a Menu Item Check” on page 8-59
for programming information and basic examples.
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Creating Toolbars

In this section...
“Creating Toolbars with GUIDE” on page 6-121

“Editing Tool Icons” on page 6-130

Creating Toolbars with GUIDE

You can add a toolbar to a GUI you create in GUIDE with the Toolbar Editor,
which you open from the GUIDE Layout Editor toolbar.

R

File Edit View Layout Tools Help

Dod s§Bmo o (aBhERH% | P

50 100 [Toolbar Editor | 250 200 250 ang as0
k Select

Push Button

= Slider

@ Radio Button

B Check Box
[exlr Edit Text

T Skatic Text
== Pop-up Menu
£ Listbaox

Toggle Button
E Table
i{_‘ﬂ Axes

[B] Panel

|E Button Group

=X ActiveX Control

Taa: figural Current Poink: [93, 401] Position: [680, 696, 502, 402]

You can also open the Toolbar Editor from the Tools menu.
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The Toolbar Editor gives you interactive access to all the features of the
uitoolbar, uipushtool, and uitoggletool functions. It only operates in the
context of GUIDE; you cannot use it to modify any of the built-in MATLAB
toolbars. However, you can use the Toolbar Editor to add, modify, and delete
a toolbar from any GUI in GUIDE.

Currently, you can add one toolbar to your GUI in GUIDE. However, your
GUI can also include the standard MATLAB figure toolbar. If you need to, you
can create a toolbar that looks like a normal figure toolbar, but customize its
callbacks to make tools (such as pan, zoom, and open) behave in specific ways.



Creating Toolbars

Note You do not need to use the Toolbar Editor if you simply want your GUI
to have a standard figure toolbar. You can do this by setting the figure’s
ToolBar property to 'figure', as follows:

1 Open the GUI in GUIDE.
2 From the View menu, open Property Inspector.
3 Set the ToolBar property to 'figure' using the drop-down menu.

4 Save the figure

If you later want to remove the figure toolbar, set the ToolBar property to
'auto' and resave the GUI. This will not remove or hide your custom toolbar
should the GUI have one. See “Creating Toolbars” on page 11-86 for more
information about creating a toolbar with M-code.

If you want users to be able to dock and undock a GUI on the MATLAB
desktop, it must have a toolbar or a menu bar, which can either be the
standard ones or ones you create in GUIDE. In addition, the figure property
DockControls must be turned on. For details, see “How Menus Affect Figure
Docking” on page 6-102.

Using the Toolbar Editor

The Toolbar Editor contains three main parts:

¢ The Toolbar Layout preview area on the top
¢ The Tool Palette on the left
* Two tabbed property panes on the right
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adi Toolbar Editor
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To add a tool, drag an icon from the Tool Palette into the Toolbar Layout
(which initially contains the text prompt shown above), and edit the tool’s

properties in the Tool Properties pane.




Creating Toolbars

When you first create a GUI, no toolbar exists on it. When you open the
Toolbar Editor and place the first tool, a toolbar is created and a preview of
the tool you just added appears in the top part of the window. If you later
open a GUI that has a toolbar, the Toolbar Editor shows the existing toolbar,
although the Layout Editor does not.

Adding Tools

You can add a tool to a toolbar in three ways:

¢ Drag and drop tools from the Tool Palette.
e Select a tool in the palette and click the Add button.
® Double-click a tool in the palette.

Dragging allows you to place a tool in any order on the toolbar. The other two
methods place the tool to the right of the right-most tool on the Toolbar
Layout. The new tool is selected (indicated by a dashed box around it) and
its properties are shown in the Tool Properties pane. You can select only
one tool at a time. You can cycle through the Tool Palette using the tab key
or arrow keys on your computer keyboard. You must have placed at least
one tool on the toolbar.

After you place tools from the Tool Palette into the Toolbar Layout area,

the Toolbar Editor shows the properties of the currently selected tool, as the
following illustration shows.
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Predefined and Custom Tools
The Toolbar Editor provides two types of tools:
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® Predefined tools, having standard icons and behaviors

e Custom tools, having generic icons and no behaviors

Predefined Tools. The set of icons on the bottom of the Tool Palette
represent standard MATLAB figure tools. Their behavior is built in.
Predefined tools that require an axes (such as pan and zoom) do not exhibit
any behavior in GUIs lacking axes. The callback(s) defining the behavior of
the predefined tool are shown as %default, which calls the same function
that the tool calls in standard figure toolbars and menus (to open files, save
figures, change modes, etc.). You can change %default to some other callback
to customize the tool; GUIDE warns you that you will modify the behavior of
the tool when you change a callback field or click the View button next to it,
and asks if you want to proceed or not.

Custom Tools. The two icons at the top of the Tool Palette create pushtools
and toggletools. These have no built-in behavior except for managing their
appearance when clicked on and off. Consequently, you need to provide your
own callback(s) when you add one to your toolbar. In order for custom tools to
respond to clicks, you need to edit their callbacks to create the behaviors you
desire. Do this by clicking the View button next to the callback in the Tool
Properties pane, and then editing the callback in the Editor window.

Adding and Removing Separators

Separators are vertical bars that set off tools, enabling you to group them
visually. You can add or remove a separator in any of three ways:

e Right-click on a tool’s preview and select Show Separator, which toggles
its separator on and off.

® Check or clear the check box Separator to the left in the tool’s property
pane.

® Change the Separator property of the tool from the Property Inspector
After adding a separator, that separator appears in the Toolbar Layout

to the left of the tool. The separator is not a distinct object or icon; it is a
property of the tool.
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Moving Tools
You can reorder tools on the toolbar in two ways:

* Drag a tool to a new position.
e Select a tool in the toolbar and click one of the arrow buttons below the

right side of the toolbar.

If a tool has a separator to its left, the separator moves with the tool.

Removing Tools
You can remove tools from the toolbar in three ways:

® Select a tool and press the Delete key.
e Select a tool and click the Delete button on the GUI.

¢ Right-click a tool and select Delete from the context menu.

You cannot undo any of these actions.

Editing a Tool’s Properties
You edit the appearance and behavior of the currently selected tool using

the Tool Properties pane, which includes controls for setting the most
commonly used tool properties:

¢ CData — The tool’s icon

e Tag — The internal name for the tool

® Enable — Whether users can click the tool

e Separator — A bar to the left of the icon for setting off and grouping tools
® (Clicked Callback — The function called when users click the tool

¢ Off Callback (uitoggletool only) — The function called when the tool is put

in the off state

® On Callback (uitoggletool only) — The function called when the tool is
put in the on state
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See “Callbacks: An Overview” on page 8-2 for details on programming the tool
callbacks. You can also access these and other properties of the selected tool
with the Property Inspector. To open the Property Inspector, click the More
Properties button on the Tool Properties pane.

Editing Tool Icons

To edit a selected toolbar icon, click the Edit button in the Tool Properties
pane, next to CData (icon) or right-click the Toolbar Layout and select
Edit Icon from the context menu. The Icon Editor opens with the tool’s
CData loaded into it. For information about editing icons, see “Using the
Icon Editor” on page 6-132.

Editing Toolbar Properties
If you click an empty part of the toolbar or click the Toolbar Properties
tab, you can edit two of its properties:

® Tag — The internal name for the toolbar

® Visible — Whether the toolbar is displayed in your GUI

The Tag property is initially set to uitoolbar1. The Visible property is set
to on. When on, the Visible property causes the toolbar to be displayed on
the GUI regardless of the setting of the figure’s Toolbar property. If you
want to toggle a custom toolbar as you can built-in ones (from the View
menu), you can create a menu item, a check box, or other control to control its
Visible property.

To access nearly all the properties for the toolbar in the Property Inspector,
click More Properties.

Testing Your Toolbar

To try out your toolbar, click the Run button in the Layout Editor. The
software asks if you want to save changes to its .fig file first.
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Removing a Toolbar

You can remove a toolbar completely—destroying it—from the Toolbar Editor,
leaving your GUI without a toolbar (other than the figure toolbar, which is
not visible by default). The are two ways to remove a toolbar:

® (Click the Remove button ﬁ on the right end of the toolbar.

¢ Right-click a blank area on the toolbar and select Remove Toolbar from
the context menu.

If you remove all the individual tools in the ways shown in “Removing Tools”
on page 6-128 without removing the toolbar itself, your GUI will contain
an empty toolbar.

Closing the Toolbar Editor
You can close the Toolbar Editor window in two ways:

® Press the OK button.
e (Click the Close box in the title bar.

When you close the Toolbar Editor, the current state of your toolbar is saved
with the GUI you are editing. You do not see the toolbar in the Layout Editor;
you need to run the GUI to see or use it.

Editing Tool Icons

GUIDE includes its own Icon Editor, a GUI for creating and modifying icons
such as icons on toolbars. You can access this editor only from the Toolbar
Editor. This figure shows the Icon Editor loaded with a standard Save icon.
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Note There are examples that show how to create your own icon editor. See

the example in “Icon Editor” on page 15-62 and the discussion of sharing
data among multiple GUIs in the Creating GUIs Programmatically portion

of the GUI Building documentation.
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Using the Icon Editor
The Icon Editor GUI includes the following components:

¢ Icon file name — The icon image file to be loaded for editing

¢ Import button — Opens a file dialog to select an existing icon file for
editing
® Drawing tools — A group of four tools on the left side for editing icons

Pencil tool — Color icon pixels by clicking or dragging

Eraser tool — Erase pixels to be transparent by clicking or dragging

Paint bucket tool — Flood regions of same-color pixels with the current
color

Pick color tool — Click a pixel or color palette swatch to define the
current color

¢ Icon Edit pane — A n-by-m grid where you color an icon
¢ Preview pane — A button with a preview of current state of the icon
¢ Color Palette — Swatches of color that the pencil and paint tools can use

® More Colors button — Opens the Colors dialog box for choosing and
defining colors

¢ OK button — Dismisses the GUI and returns the icon in its current state

¢ Cancel button — Closes the GUI without returning the icon

To work with the Icon Editor,

1 Open the Icon Editor for a selected tool’s icon.

2 Using the Pencil tool, color the squares in the grid:
e (Click a color cell in the palette.
® That color appears in the Color Palette preview swatch.

¢ (Click in specific squares of the grid to transfer the selected color to
those squares.
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® Hold down the left mouse button and drag the mouse over the grid to
transfer the selected color to the squares that you touch.

® Change a color by writing over it with another color.

3 Using the Eraser tool, erase the color in some squares
® (lick the Eraser button on the palette.
¢ (lick in specific squares to erase those squares.
® (Click and drag the mouse to erase the squares that you touch.

® (Click a another drawing tool to disable the Eraser.

4 Click OK to close the GUI and return the icon you created or click Cancel
to close the GUI without modifying the selected tool’s icon.

The three GUIs are shown operating together below, before saving a
uipushtool icon:
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Viewing the Object Hierarchy

Viewing the Object Hierarchy

The Object Browser displays a hierarchical list of the objects in the figure,
including both components and menus. As you lay out your GUI, check the
object hierarchy periodically, especially if your GUI contains menus, panes, or
button groups. Open it from View > Object Browser or by click the Object

Py
Browser icon - # on the GUIDE toolbar.

The following illustration shows a figure object and its child objects. It also
shows the child objects of a uipanel.
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uicantral (mesh_pushbuttan "Mesh™)
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Tag: uipanell Current Point: [315, 327] Position: [296, 78, 159, 220]

To determine a component’s place in the hierarchy, select it in the Layout
Editor. It is automatically selected in the Object Browser. Similarly, if you
select an object in the Object Browser, it is automatically selected in the
Layout Editor.
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Designing for Cross-Platform Compatibility

6-136

In this section...

“Default System Font” on page 6-136
“Standard Background Color” on page 6-137
“Cross-Platform Compatible Units” on page 6-138

Default System Font

By default, user interface controls (uicontrols) use the default font for the
platform on which they are running. For example, when displaying your GUI
on PCs, uicontrols use MS San Serif. When your GUI runs on a different
platform, it uses that computer’s default font. This provides a consistent look
with respect to your GUI and other application GUIs.

If you have set the FontName property to a named font and want to return
to the default value, you can set the property to the string default. This

ensures that the software uses the system default at run-time.

You can use the Property Inspector to set this property:

E Inspector: uvicontrol {pushbuttond4 "“Push Button™) M=l E3
= 5¥ @t
B | Ta ¥y
Fontangle normal r &
FonkSize 3.0 &
FontUnits points T .

Or you can use the set command to set the property in the GUI M-file. For
example, if there is a push button in your GUI and its handle is stored in the
pushbuttoni field of the handles structure, then the statement

set(handles.pushbuttont, 'FontName', 'default')

sets the FontName property to use the system default.
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Specifying a Fixed-Width Font

If you want to use a fixed-width font for a user interface control, set its
FontName property to the string fixedwidth. This special identifier ensures
that your GUI uses the standard fixed-width font for the target platform.

You can find the name of the fixed-width font that is used on a given platform
by querying the root FixedWidthFontName property.

get (0, 'FixedWidthFontName')

Using a Specific Font Name

You can specify an actual font name (such as Times or Courier) for the
FontName property. However, doing so may cause your GUI to not look as
you intended when run on a different computer. If the target computer does
not have the specified font, it will substitute another font that may not look
good in your GUI or may not be the standard font used for GUIs on that
system. Also, different versions of the same named font may have different
size requirements for a given set of characters.

Standard Background Color

The default component background color is the standard system background
color on which the GUI is running. This color varies on different computer
systems, e.g., the standard shade of gray on the PC differs from that on UNIX
system, and may not match the default GUI background color.

If you use the default component background color, you can use that same
color as the background color for your GUI. This provides a consistent look
with respect to your GUI and other application GUIs. To do this in GUIDE,
check Options > Use system color scheme for background on the Layout
Editor Tools menu.

Note This option is available only if you first select the Generate FIG-file
and M-File option.
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The following figures illustrate the results with and without system color
matching.
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[T Check Box 1 [T Check Box 1
[T Check Box 2 [T Check Box 2

Withau t system calar matching With system colar matching

Cross-Platform Compatible Units

Cross-platform compatible GUIs should look correct on computers having
different screen sizes and resolutions. Since the size of a pixel can vary on
different computer displays, using the default figure Units of pixels does not
produce a GUI that looks the same on all platforms.

For this reason, GUIDE defaults the Units property for the figure to
characters.

System-Dependent Units

Character units are defined by characters from the default system font. The
width of a character unit equals the width of the letter x in the system font.
The height of a character unit is the distance between the baselines of two
lines of text. Note that character units are not square.


file:///B:/matlab/doc/src/toolbox/matlab/ref/figure_props.html%23Units
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Units and Resize Behavior

If you set your GUTI’s resize behavior from the GUI Options dialog box,
GUIDE automatically sets the units for the GUI's components in a way that
maintains the intended look and feel across platforms. To specify the resize
behavior option, select GUI Options from the Tools menu, then specify
Resize behavior by selecting Non-resizable, Proportional, or Other
(Use ResizeFcn).

If you choose Non-resizable, GUIDE defaults the component units to
characters. If you choose Proportional, it defaults the component units to
normalized. In either case, these settings enable your GUI to automatically
adjust the size and relative spacing of components as the GUI displays on
different computers.

If you choose Other (Use ResizeFcn), GUIDE defaults the component
units to characters. However, you must provide a ResizeFcn callback to
customize the GUT’s resize behavior.

Note GUIDE does not automatically adjust component units if you modify
the figure’s Resize property programmatically or in the Property Inspector.

At times, it may be convenient to use a more familiar unit of measure, e.g.,
inches or centimeters, when you are laying out the GUI. However, to preserve
the look of your GUI on different computers, remember to change the figure
Units property back to characters, and the components’ Units properties

to characters (nonresizable GUIs) or normalized (resizable GUIs) before
you save the GUI.
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e “Naming a GUI and Its Files” on page 7-2
e “Saving a GUI” on page 7-4
¢ “Running a GUI” on page 7-10
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Naming a GUI and Its Files

In this section...

“The GUI Files” on page 7-2
“File and GUI Names” on page 7-3
“Renaming GUIs and GUI Files” on page 7-3

The GUI Files

By default, GUIDE stores a GUI in two files which are generated the first
time you save or run the GUI:

e A FIG-file, with extension .fig, that contains a complete description of the
GUI layout and the GUI components, such as push buttons, axes, panels,
menus, and so on. The FIG-file is a binary file and you cannot modify it
except by changing the layout in GUIDE. Note that a FIG-file is a kind
of MAT-file.

® An M-file, with extension .m, that contains the code that controls the GUI,
including the callbacks for its components.

These two files have the same name and usually reside in the same folder.

They correspond to the tasks of laying out and programming the GUI. When
you lay out the GUI in the Layout Editor, your work is stored in the FIG-file.
When you program the GUI, your work is stored in the corresponding M-file.

Note GUI M-files created by GUIDE always contain functions that the
FIG-file calls when the user loads it and operates the GUI. They are never
scripts (sequences of MATLAB commands that can be executed but do not
define functions).

Note that if your GUI includes ActiveX components, GUIDE also generates
a file for each ActiveX component. See “ActiveX Control” on page 8-48 for
more information.
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For more information about these files, see “GUI Files: An Overview” on
page 8-7.

File and GUI Names

The M-file and the FIG-file that define your GUI must have the same name.
This name is also the name of your GUI.

For example, if your files are named mygui.fig and mygui.m, then the
name of the GUI is mygui, and you can run the GUI by typing mygui at the
command line. This assumes that the M-file and FIG-file are in the same
folder and that the folder is in your path.

Names are assigned when you save the GUI the first time. See “Ways to Save
a GUI” on page 7-4 for information about saving GUIs.

Renaming GUIs and GUI Files

To rename a GUI, rename the GUI FIG-file using Save As from the Layout
Editor File menu. When you do this, GUIDE renames both the FIG-file and
the GUI M-file, updates any callback properties that contain the old name
to use the new name, and updates all instances of the file name in the body
of the M-file. See “Saving a GUI” on page 7-4 for more information on ways
to save GUIs from GUIDE.

Note Do not rename GUI files by changing their names outside of GUIDE or
the GUI will fail to function properly.
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Saving a GUI

In this section...

“Ways to Save a GUI” on page 7-4
“Saving a New GUI” on page 7-5

“Saving an Existing GUI” on page 7-8

Ways to Save a GUI
You can save a GUI in GUIDE in any of these ways:

¢ From the GUIDE Quick Start dialog box. Before you select a template,
GUIDE lets you select a name for your GUI. When you click OK, GUIDE
saves the GUI M-file and FIG-file using the name you specify.

=100

Create New GUL | Open Existing GUI |

GUIDE kemplates ~Preview
4\ Blank GUI (Default)

4\ GUI with Uicontrols

<\ GUI with Axes and Menu
4\ Madal Question Dialag

BLANK

[~ 5ave new figure as: |C:\Work|GBT|GUIDE|examples|mygui.fig

QK I Cancel Help

¢ The first time you save the files by
= Clicking the Save icon E on the Layout Editor toolbar

= Selecting the Save or Save as options on the File menu
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In either case, GUIDE prompts you for a name before saving the GUI,
and saves both a .fig file and a .m file using the name you specify, for
example, mygui.fig and mygui.m,

® The first time you run the GUI by
= Clicking the Run icon ® on the Layout Editor toolbar
= Selecting Run from the Tools menu
In each case, GUIDE prompts you for a name and saves the GUI files
before activating the GUI.

In all cases, GUIDE creates a template M-file and opens it in your default
editor. See “Naming of Callback Functions” on page 8-16 for more information
about the template M-file.

Note In most cases you should save your GUI to your current folder or to
your path. GUIDE-generated GUIs cannot run correctly from a private folder.
GUI FIG-files that are created or modified with MATLAB 7.0 or a later
MATLAB version, are not automatically compatible with Version 6.5 and
earlier versions. To make a FIG-file, which is a kind of MAT-file, backward
compatible, you must check General > MAT-Files > MATLAB Version 5
or later (save -v6) in the MATLAB Preferences dialog box before saving
the file. Button groups, panels and tables were introduced in MATLAB 7, and
you should not use them in GUIs that you expect to run in earlier MATLAB
versions.

Be aware that the -v6 option is obsolete and will be removed in a future
version of MATLAB

Saving a New GUI

Follow these steps if you are saving a GUI for the first time, or if you are
using Save as from the File menu.
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Note If you select Save as from the File menu or click the Save button

B on the toolbar, GUIDE saves the GUI without activating it. However, if
you select Run from the Tools menu or click the Run icon ™ on the toolbar,
GUIDE saves the GUI before activating it.

1 If you have made changes to the GUI and elect to activate the GUI by
selecting Run from the Tools menu or by clicking the Run icon ™ on the
toolbar, GUIDE displays the following dialog box. Click Yes to continue.

cuoe x|

Activating will save changes to your figure and M-file.
Do vou wish to continue?

" Do not show this dialog again.

¥es Mo |

2 If you clicked Yes in the previous step, if you are saving the GUI without
activating it, or if you are using Save as from the File menu, GUIDE opens
a Save As dialog box and prompts you for a FIG-file name.

Save As: n
Save in I 0wk j Lo cf E9-

File: name: Save I
Save az type: IFigures [.fial j Cancel |

3 Change the folder if you choose, and then enter the name you want to use
for the FIG-file. Be sure to choose a writable folder. GUIDE saves both the
FIG-file and the M-file using this name.
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4 If you choose an existing filename, GUIDE displays a dialog box that asks
you if you want to replace the existing FIG-file. Click Yes to continue.

Savens: i

] L YorklGuideuntitled]  fig already exists,
[ Do vl wank ko replace it?

Yes | Mo I

5 If you chose Yes in the previous step, GUIDE displays a dialog that asks if

you want to replace the existing M-file or append to it. The most common
choice is Replace.

If you choose Append, GUIDE adds callbacks to the existing M-file for

components in the current layout that are not present in the existing M-file.

Before you append the new components, ensure that their Tag properties
do not duplicate Tag values that appear in callback function names in
the existing M-file. See “Assigning an Identifier to Each Component” on
page 6-37 for information about specifying the Tag property. See “Naming
of Callback Functions” on page 8-16 for more information about callback
function names.

Guoe x|
File:

& D ¥arkGUidewntitied] m

already exists, Do you want to replace it or append to it?

Append Cancel
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6 If you chose to activate the GUI by selecting Run from the Tools menu
or by clicking the Run button ™ on the toolbar, and if the folder in which
you save the GUI is not on the MATLAB path, GUIDE opens a dialog box,
giving you the option of changing the current working folder to the folder
containing the GUI files, or adding that folder to the top or bottom of the
MATLAB path.

Guoe x
& File O:\Wyaorkisimple_gui.m
is notin current directory or MATLAB path

To continue activation, select one of the following:
ol Change MATLAB current directory

 Add directory to the top of the MATLABR path

 Add directory to the hottorn of the WMATLAB path

QK Cancel

7 After you save the files, GUIDE opens the GUI M-file in your default editor.
If you elected to run the GUI, it also activates the GUI.

Saving an Existing GUI

Follow these steps if you are saving an existing GUI to its current location. See
“Saving a New GUI” on page 7-5 if you are using Save as from the File menu.

If you have made changes to a GUI and choose to save and activate the GUI
by selecting Run from the Tools menu or by clicking the Run button ™ on the
toolbar, GUIDE saves the GUI and then activates it. It does not automatically
open the M-file, even if you added new components.
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If you select Save from the File menu or click the Save button B on the
toolbar, GUIDE saves the GUI without activating it.

savens: i

' L YorklGuideuntitled]  fig already exists,
[ Do vl wank ko replace it?

Yes | Mo I
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Running a GUI

In this section...

“Executing the M-file” on page 7-10
“From the GUIDE Layout Editor” on page 7-10

“From the Command Line” on page 7-11

“From an M-file” on page 7-11

Executing the M-file

Generally, you run your GUI by executing the M-file that GUIDE generates.
This M-file contains the commands to load the GUI and provides a framework
for the component callbacks. See “GUI Files: An Overview” on page 8-7 for
more information about the M-file.

When you execute the M-file, a fully functional GUI displays on the screen.
You can run a GUI in three ways, as described in the following sections.

Note You can display the GUI figure by double-clicking its file name in the
Current Folder Browser. You can also display it by executing openfig, open,
or hgload. These functions load a FIG-file into the MATLAB workspace and
open the figure for viewing. If the displayed figure is a GUIDE GUI, you can
manipulate its components, but nothing happens because no corresponding
M-file is running to initalize the GUI or execute component callbacks.

From the GUIDE Layout Editor
Run your GUI from the GUIDE Layout Editor by:

¢ (Clicking the ® button on the Layout Editor toolbar

¢ Selecting Run from the Tools menu

In either case, if the GUI has changed or has never been saved, GUIDE saves
the GUI files before activating it and opens the GUI M-file in your default
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editor. See “Saving a GUI” on page 7-4 for information about this process. See
“GUI Files: An Overview” on page 8-7 for more information about GUI M-files.

From the Command Line

Run your GUI from its M-file by executing the GUI M-file. For example, if
your GUI M-file is mygui.m, enter:

mygui

at the command line. The files must reside on your path or in your current
folder. If you want the GUI to be invisible when it opens, enter:

mygui('Visible, 'off')

If a GUI accepts arguments when it is run, they are passed to the GUT'’s
opening function. See “Opening Function” on page 8-25 for more information.

Note Consider whether you want to allow more than one copy of the GUI
to be active at the same time. If you want only one GUI to be active, select
Options > GUI Allows Only One Instance to Run (Singleton) from
the Layout Editor View menu. See “GUI Options” on page 5-9 for more
information.

From an M-file

Run your GUI from an M-file by executing the GUI M-file. For example, if
your GUI M-file is mygui.m, include the following statement in your M-file
script.

mygui
If you want the GUI to be invisible when it opens, use this statement:
mygui('Visible, 'off')

The M-file must reside on the MATLAB path or in the current MATLAB
folder where the GUI is run.
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If a GUI accepts arguments when it is run, they are passed to the GUT’s
opening function. See “Opening Function” on page 8-25 for more information.

Note Consider whether you want to allow more than one copy of the GUI

to be active at the same time. If you want only one GUI to be active, select
Options from the Layout Editor View menu, then select GUI Allows Only
One Instance to Run (Singleton). See “GUI Options” on page 5-9 for more
information.
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e “Callbacks: An Overview” on page 8-2

e “GUI Files: An Overview” on page 8-7

® “Associating Callbacks with Components” on page 8-11

e “Callback Syntax and Arguments” on page 8-15

e “Initialization Callbacks” on page 8-25

¢ “Examples: Programming GUIDE GUI Components” on page 8-30
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Callbacks: An Overview

In this section...

“Programming GUIs Created Using GUIDE” on page 8-2
“What Is a Callback?” on page 8-2

“Kinds of Callbacks” on page 8-2

Programming GUIs Created Using GUIDE

After you have laid out your GUI, program its behavior. The code you write
controls how the GUI responds to events. Events include button clicks,
slider movements, menu item selections, and the creation and deletion of
components. This programming takes the form of a set of functions, called
callbacks, for each component and for the GUI figure itself.

What Is a Callback?

A callback 1s a function that you write and associate with a specific GUI
component or with the GUI figure. It controls GUI or component behavior
by performing some action in response to an event for its component. This
programming approach is often called event-driven programming.

When an event occurs for a component, MATLAB software invokes the
component’s callback that the event triggers. As an example, suppose a GUI
has a button that triggers the plotting of some data. When the GUI user
clicks the button, the software calls the callback you associated with clicking
that button. The callback, which you have programmed, then gets the data
and plots it.

A component can be any control device such as a push button, list box, or
slider. For purposes of programming, it can also be a menu or a container
such as a panel or button group. See “Available Components” on page 6-20 for
a list and descriptions of components.

Kinds of Callbacks

The GUI figure and each type of component can trigger specific kinds of
callbacks. The callbacks that are available for each component are properties
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of that component. For example, a push button has five callback properties:
ButtonDownFcn, Callback, CreateFcn, DeleteFcn, and KeyPressFcn. A
panel has four callback properties: ButtonDownFcn, CreateFcn, DeleteFcn,
and ResizeFcn. You can—but do not have to—create a callback function for
each of these properties, including callbacks for the GUI figure itself.

Each callback has a triggering mechanism or event that causes it to execute.
The following table lists the callback properties that are available, their
triggering events, and the components to which they apply. Links in the first
column lead to documentation search results for each type of callback. These
links only operate when you are using the MATLAB Help Browser.

Callback Property

Triggering Event

Components

ButtonDownFcn Executes when the GUI Axes, figure,
user presses a mouse button group,
button while the pointer is | panel, user
on or within five pixels of a | interface controls
component or figure.

Callback Control action. Executes, Context menu,
for example, when a GUI menu user
user clicks a push button or | interface controls
selects a menu item.

CellEditCallback Reports any edit made to uitable
a value in a table with
editable cells; uses event
data.

CellSelectionCallback | Reports indices of cells uitable

selected by mouse gesture
in a table; uses event data.

ClickedCallback

Control action. Executes
when the push tool or
toggle tool is clicked.
For the toggle tool,
executing the callback
is state-independent.

Push tool, toggle
tool

CloseRequestFcn

Executes when the figure
closes.

Figure
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Callback Property

Triggering Event

Components

CreateFcn Initializes the component Axes, button
when a function creates group, context
it. It executes after the menu, figure,
component or figure is menu, panel,
created, but before it push tool, toggle
displays. tool, toolbar, user

interface controls

DeleteFcn Performs cleanup Axes, button
operations just before group, context
the component or figure is | menu, figure,
destroyed. menu, panel,

push tool, toggle
tool, toolbar, user
interface controls

KeyPressFcn Executes when the GUI Figure, user
user presses a keyboard interface controls
key and the component or
figure with this callback
has focus.

KeyReleaseFcn Executes when the GUI Figure
user releases a keyboard
key and the figure has
focus.

0ffCallback Control action. Executes Toggle tool
when the State of a toggle
tool changes to off.

OnCallback Control action. Executes Toggle tool
when the State of a toggle
tool changes to on.

ResizeFcn Executes when a GUI user | Figure, button

resizes a panel, button
group, or figure whose
figure Resize property is
on.

group, panel
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Callback Property

Triggering Event

Components

SelectionChangeFcn

Executes when a GUI user
selects a different radio
button or toggle button in a
button group component.

Button group

WindowButtonDownFcn

Executes when you press
a mouse button while the
pointer is in the figure
window.

Figure

WindowButtonMotionFcn

Executes when you move
the pointer within the
figure window.

Figure

WindowButtonUpFcn

Executes when you release
a mouse button.

Figure

WindowKeyPressFcn

Executes when you press
a key when the figure or
any of its child objects has
focus.

Figure

WindowKeyReleaseFcn

Executes when you release
a key when the figure or
any of its child objects has
focus.

Figure

WindowScrollWheelFcn

Executes when the GUI
user scrolls the mouse
wheel while the figure has
focus.

Figure
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Note User interface controls include push buttons, sliders, radio buttons,
check boxes, editable text boxes, static text boxes, list boxes, and toggle
buttons. They are sometimes referred to as uicontrols.

For details on specific callbacks, follow the links in the preceding table,
right-click the property name in the Property Inspector and select the
What’s this? pop-up menu, or consult the properties reference page for
your component, for example, Figure Properties, Uicontrol Properties,
Uibuttongroup Properties, or Uitable Properties.

For additional discussion of how callbacks work and the forms they can take,
see “What Is a Callback?” on page 12-9 and following sections in the Creating
GUIs Programmatically portion of this documentation.
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GUI Files: An Overview

In this section...

“M-Files and FIG-Files” on page 8-7

“GUI M-File Structure” on page 8-8

“Adding Callback Templates to an Existing GUI M-File” on page 8-9
“About GUIDE-Generated Callbacks” on page 8-9

M-Files and FIG-Files

By default, the first time you save or run a GUI, GUIDE stores the GUI in
two files:

¢ A FIG-file, with extension .fig, that contains a complete description of the
GUI layout and each GUI component, such as push buttons, axes, panels,
menus, and so on. The FIG-file is a binary file and you cannot modify it
except by changing the layout in GUIDE. FIG-files are specializations of
MAT-files. See for more information.

e An M-file, with extension .m, that initially contains initialization code and
templates for some callbacks that control GUI behavior. You generally add
callbacks you write for your GUI components to this file. As the callbacks
are functions, the GUI M-file can never be a MATLAB script.

When you save your GUI the first time, GUIDE automatically opens the
M-file in your default editor.

The FIG-file and the M-file must have the same name. These two files
usually reside in the same folder, and correspond to the tasks of laying out
and programming the GUIL. When you lay out the GUI in the Layout Editor,
your components and layout is stored in the FIG-file. When you program the
GUI, your code is stored in the corresponding M-file.

If your GUI includes ActiveX components, GUIDE also generates a file

for each ActiveX component. See “ActiveX Control” on page 8-48 for more
information.
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For more information about naming and saving a GUI, see Chapter 7, “Saving
and Running a GUIDE GUI”. If you want to change the name of your GUI
and its files, see “Renaming GUIs and GUI Files” on page 7-3.

GUI M-File Structure

The GUI M-file that GUIDE generates is a function file. The name of the
main function is the same as the name of the M-file. For example, if the name
of the M-file 1s mygui.m, then the name of the main function is mygui. Each
callback in the file is a subfunction of the main function.

When GUIDE generates an M-file, it automatically includes templates for the
most commonly used callbacks for each component. The M-file also contains
initialization code, as well as an opening function callback and an output
function callback. It is your job to add code to the component callbacks for
your GUI to work as you want. You can also add code to the opening function
callback and the output function callback. The GUI M-file orders functions as
shown in the following table.

Section Description

Comments Displayed at the command line in response to the help
command. Edit comments as necessary for your GUIL.

Initialization GUIDE initialization tasks. Do not edit this code.

Opening function Performs your initialization tasks before the GUI user
has access to the GUL

Output function Returns outputs to the MATLAB command line after
the opening function returns control and before control
returns to the command line.

Component and Control the behavior of the GUI figure and of
figure callbacks individual components. MATLAB software calls
a callback in response to a particular event for a
component or for the figure itself.

Utility/helper Perform miscellaneous functions not directly
functions associated with an event for the figure or a component.
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Adding Callback Templates to an Existing GUI M-File

When you save the GUI, GUIDE automatically adds templates for some
callbacks to the M-file. If you want to add other callbacks to the M-file, you
can easily do so.

Within GUIDE, you can add a callback subfunction template to the GUI
M-file in any of the following ways. Select the component for which you want
to add the callback, and then:

® (Click the right mouse button to display the Layout Editor context menu.
Select the desired callback from the View callbacks submenu.

¢ In the View menu, select the desired callback from the View callbacks
submenu.

® Double-click a component to show its properties in the Property Inspector.

In the Property Inspector, click the pencil-and-paper icon 4 next to the
name of the callback you wish to install in the M-file.

¢ For toolbar buttons, in the Toolbar Editor, click the View button next
to Clicked Callback (for Push Tool buttons) or On Callback, or Off
Callback (for Toggle Tools).

When you perform any of these actions, GUIDE adds the callback template to
the GUI M-file and opens the M-file for editing at the callback you just added.
If you select a callback that currently exists in the GUI M-file, GUIDE adds
no callback, but opens the M-file for editing at the callback you select.

For more information, see “Associating Callbacks with Components” on page
8-11.

About GUIDE-Generated Callbacks

Callbacks created by GUIDE for GUI components are similar to callbacks
created programmatically, with certain differences.

¢ GUIDE generates callbacks as function templates within the GUI M-file,
which GUI components call via function handles.

GUIDE names callbacks based on the callback type and the component
Tag property. For example, togglebuttoni_Callback is such a default
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callback name. If you change a component Tag, GUIDE renames all its
callbacks in the M-file to contain the new tag. You can change the name of
a callback, replace it with another function, or remove it entirely using the
Property Inspector.

GUIDE provides three arguments to callbacks, always named the same.

You can append arguments to GUIDE-generated callbacks, but never alter
or remove the ones that GUIDE places there.

You can rename a GUIDE-generated callback by editing its name or by
changing the component Tag.

You can delete a callback from a component by clearing it from the Property
Inspector; this action does not remove any code in the M-file.

You can specify the same callback function for multiple components to
enable them to share code.

After you delete a component in GUIDE, all callbacks it had remain in the
M-file. If you are sure that no other component uses the callbacks, you can
then remove the callback code manually. For details, see “Deleting Callbacks
from a GUI M-File” on page 8-14. If you need a way to remove a callback

wi
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Associating Callbacks with Components

In this section...

“GUI Components” on page 8-11
“Setting Callback Properties Automatically” on page 8-11
“Deleting Callbacks from a GUI M-File” on page 8-14

GUI Components

A GUI can have many components. GUIDE provides a way of specifying which
callback runs in response to a particular event for a particular component.
The callback that runs when the GUI user clicks a Yes button is not the one
that runs for the No button. Similarly, each menu item usually performs a
different function. See “Kinds of Callbacks” on page 8-2 for a list of callback
properties and the components to which each applies.

Setting Callback Properties Automatically

GUIDE initially sets the value of the most commonly used callback properties
for each component to %automatic. For example, a push button has five
callback properties, ButtonDownFcn, Callback, CreateFcn, DeleteFcn, and
KeyPressFcn. GUIDE sets only the Callback property, the most commonly
used callback, to %automatic. You can use the Property Inspector to set the
other callback properties to %automatic. To do so, click the pencil-and-paper

icon i next to the callback name. GUIDE immediately replaces %Sautomatic
with a MATLAB expression that is the GUI calling sequence for the callback.
Within the calling sequence, it constructs the callback name, for example,
the subfunction name, from the component Tag property and the name of
the callback property.

8-11



8 Programming a GUIDE GUI

8-12

The following figure shows a push button’s properties in the GUIDE
Property Inspector prior to saving the GUIL. GUIDE set the Tag property
to pushbutton1. Before saving the GUI, Callback property displays as
%automatic, indicating that GUIDE will generate a name for it when you
save the GUL

Note If you change the string %automatic before saving the GUI, GUIDE
does not automatically add a callback for that component or menu item. It is
up to you to provide a callback yourself. That callback has to be the same as
the string you enter.

E# Inspector: uicontrol (pushbuttonl "Push Button™) =101 %]

240 | =) =

Style/Appearance =

[-] Base Properties
BeingDeleted aff
BusyAckion queues -
ButtonDownFen @ &
Clipping an -
CreateFcn @ &
DeleteFen @ &
HandleVisibility an -
HitTest an -
Interruptible an -
SelectionHighlight an -
Tag pushbutkani &
UIContextMeanu =Mane > -
UzerDatka ﬂ [0x0 double array] &
Visible an -

[= Control
Calback J %aautornatic &
Enable an -
EeyPressFon @ &
ListhoxTop 1.0 &

Position

Data :




Associating Callbacks with Components

E Inspector: vicontrol (pushbuttonl "Push Button™

=+
¥

=] 4 | =l

When you save the GUI, GUIDE constructs the name of the callback by
appending an underscore () and the name of the callback property to the
value of the component’s Tag property. For example, the MATLAB expression
for the Callback property for a push button in the GUI untitled with Tag
property pushbuttont is

untitled('pushbutton1_Callback',hObject,eventdata,guidata(hObject))

=10l %

Style/Appearance
Base Properties

= Control

Callback

Enable

KeyPressFon
ListboxTap
Position
Data

<«_‘§ untitled{'pushbuttun1_Ca|||:uack'.h0|:uject.eventl':lata.guidata{hObjectJ: &

an

%

1.0

-

&
&

In this case, untitled is the name of the GUI M-file as well as the name of
the main function for that GUI. The remaining arguments generate input
arguments for pushbuttoni_Callback. Specifically,

® hObject is the handle of the callback object (in this case, pushbuttoni).

eventdata passes a MATLAB struct containing event data. If the object
does not generate event data, eventdata contains an empty matrix. The

eventdata struct has contents (field names) specific to each type of object
that provides it.

guidata(hObject) obtains the handles structure for this GUI and passes
it to the callback.

See “Input Arguments” on page 8-21 and “Callback Function Signatures” on
page 8-17 for more details about callback arguments and how to customize
them.
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When you save the GUI, GUIDE also opens the GUI M-file in your editor. The
M-file then contains a template for the Callback callback for the component
whose Tag 1s pushbuttoni. If you activate the GUI, clicking the push button
triggers the execution of the Callback callback for the component.

For information about changing the callback name after GUIDE assigns it,
see “Changing Callbacks Assigned by GUIDE” on page 8-20. For information
about adding callback templates to the GUI M-file, see “Adding Callback
Templates to an Existing GUI M-File” on page 8-9.

The next topic, “Callback Syntax and Arguments” on page 8-15, provides more
information about the callback template.

Deleting Callbacks from a GUI M-File

There are times when you want to delete a callback from a GUI M-file. You
can delete callbacks whether they are manually or automatically generated.
Some common reasons for wanting to delete a callback are:

® You delete the component or components to which the callback responded

* You want the component to execute different a callback function, which you
1dentify in the appropriate callback property in the Property Inspector. See
“Changing Callbacks Assigned by GUIDE” on page 8-20 for instructions
and guidelines.

Only delete a callback if you are sure that the callback is not used. To ensure
that the callback is not used elsewhere in the GUI:

e Search for occurrences of the name of the callback in the GUI M-file.

e Open the GUI in GUIDE and use the Property Inspector to check whether
any component uses the callback you want to delete.

In either case, if you find a reference to the callback, either remove the
reference or retain the callback in the GUI M-file. Once you have assured
yourself that the GUI does not need the code, manually delete the entire
callback function from the M-file.
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Callback Syntax and Arguments

In this section...

“Callback Templates” on page 8-15

“Naming of Callback Functions” on page 8-16
“Changing Callbacks Assigned by GUIDE” on page 8-20
“Input Arguments” on page 8-21

Callback Templates

GUIDE defines conventions for callback syntax and arguments and
implements these conventions in the callback templates it adds to the M-file.
Each template is like this one for the Callback subfunction for a push button.

% --- Executes on button press in pushbuttoni.

function pushbuttoni_Callback(hObject, eventdata, handles)

% hObject handle to pushbuttoni (see GCBO)

% eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

The first comment line describes the event that triggers execution of the
callback. This is followed by the function definition line. The remaining
comments describe the input arguments. Insert your code after the last
comment.

Certain figure and GUI component callbacks provide event-specific data in
the eventdata argument. As an example, this is the template for a push
button KeyPressFcn callback.

% --- Executes on key press with focus on pushbuttoni

function pushbuttoni_KeyPressFcn(hObject, eventdata, handles)

s hObject handle to pushbuttoni (see GCBO)

s eventdata structure with the following fields (see UICONTROL)
Key: name of the key that was pressed, in lower case

o o° o°

o°

Character: character interpretation of the key(s) that was pressed

e

s Modifier: name(s) of the modifier key(s)(i.e., control, shift)
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% pressed
% handles structure with handles and user data (see GUIDATA)

Callbacks that provide event data and the components to which they apply
are listed in the following table. See the appropriate property reference pages
for detailed information.

GUI Component | Callbacks with Event Property Reference
Data Pages
Figure KeyPressFcn, Figure Properties
KeyReleaseFcn,
WindowKeyPressFcn,
WindowKeyReleaseFcn,
WindowScrollWheel
User interface KeyPressFcn Uicontrol Properties
control
(uicontrol)
Button group SelectionChangeFcn Uibuttongroup Properties
(uibuttongroup)
Table (uitable) CellEditCallback, Uitable Properties
CellSelectionCallback

Note You can avoid automatic generation of the callback comment lines for
new callbacks. In the Preferences dialog box, select GUIDE and uncheck Add
comments for newly generated callback functions.

Naming of Callback Functions
The previous callback example includes the following function definition:

function pushbuttoni_Callback(hObject,eventdata,handles)

When GUIDE generates the template, it creates the callback name by
appending an underscore (_) and the name of the callback property to the
component’s Tag property. In the example above, pushbuttont is the Tag
property for the push button, and Callback is one of the push button’s callback
properties. The Tag property uniquely identifies a component within the GUI.
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The first time you save the GUI after adding a component, GUIDE adds
callbacks for that component to the M-file and generates the callback names
using the current value of the Tag property. If you change the default Tag
for any component, make sure that you have not duplicated any other
component’s Tag value before you save your GUI. GUIDE issues a warning if
1t determines that duplicate tags exist.

See “Changing Callbacks Assigned by GUIDE” on page 8-20 and “Associating
Callbacks with Components” on page 8-11 for more information.

Callback Function Signatures

A function signature itemizes a function’s name, the number, order, and types
of its parameters, and any qualifiers that apply to the function. When you
use the Property Inspector to view a component of a GUI that you have

saved at least once, you see that its Callback property is already set. When
GUIDE saves a GUI, it

® Generates a callback signature and assigns it as the value of the Callback
property

e Adds to the GUI M-file a template for the function to which the signature
point

The component may have other callbacks, for example a CreateFcn or a
DeleteFcn, which GUIDE populates the same way. It is up to you to add code
to the template to make a callback do something.

For example, if you click the pencil-and-paper icon i for a push button’s
Callback property in the Property Inspector, GUIDE presents the GUI's
M-file in the MATLAB Editor and positions the cursor at the first line of the
callback. When GUIDE defines the function in the M-file as:

function pushbuttoni_Callback(hObject, eventdata, handles)

then the function signature for the Callback property, shown in the Property
Inspector, is

@(hObject,eventdata)mygui('pushbuttoni_Callback',hObject,eventdata,guidata(hObject))
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The syntax @(hObject,eventdata) indicates that this is an anonymous
function. The signature enables MATLAB to execute the right callback when
the user clicks this push button by providing the following information.

® The name of the M-file in which the callback function resides ('mygui')

® The name of the callback function within the M-file
('pushbuttoni_Callback')

® The argument list to pass to the callback function:

1 hObject — The handle of the component issuing the callback (a push
button, in this case)

2 eventdata — A structure containing event data generated by the
component (for push buttons and other components that generate no
event data, this argument contains an empty matrix)

3 guidata(hObject) — The “handles Structure” on page 8-23 for the GUI,
used to communicate component handles between callbacks

The following figure illustrates how these elements relate to one another.
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Saving a GUI with a push button in GUIDE...

mf mygui.fig
File Edit Wew Layout Tools Help

New... Chrl+N | & B B |
Open... Ctrl+0 150 T
Close Chrw |
L] L ]
Save As...
B creates a having this
callback template “\_signature ...
Preferences. .. ) .
In mygur.m ...
Prink... Ctri+P
1 C:\...\examplesimygui.fig
/}J:-'l-‘ =h=eebbebrnngui. Fig
75
T8 % ——— Executes on button press in pushbuttonl.
77 function pu nl Callb ject, eventdata, hand
78 % hObqject handle to pushbuttonl
79 % eventdata reserved - to be defined in a future version of MATLAB
80 % handles structure with handles and user data (see GUIDATA)
a1

@ (hObject, eventdata)mygui ('pushbuttonl Callback',hObject,eventdata,guidata (hObject))

BusyAction queus

ButtonDownFon

oo e

Clipping an
CreateFon
DeleteFon
Enable on

Ea [0x0 double array]
[1x1 Function_handle array] @{hObject, eventdata)pushbuttongui’. ..

that displays in the Property Inspector like this

-

&
&
&

4

&
&

-

See “Input Arguments” on page 8-21 for details about GUIDE-generated

callbacks.
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Changing Callbacks Assigned by GUIDE

As described in “Naming of Callback Functions” on page 8-16, GUIDE
generates a name for a callback by concatenates the component’s Tag property
(checkbox1) and its callback type. Although you cannot change a callback’s
type, you can change its Tag, which will change the callback’s name the next
time you save the GUI.

Change a component’s Tag property to give its callbacks more meaningful
names; for example, you might change the Tag property from checkbox1 to
warnbeforesave. If possible, change the Tag property before saving the GUI
to cause GUIDE to automatically create callback templates having names you
prefer. However, if you decide to change a Tag property after saving the GUI,
GUIDE updates the following items according to the new Tag, provided that
all components have distinct tags:

¢ The component’s callback functions in the M-file

® The value of the component’s callback properties, which you can view in
the Property Inspector

e References in the M-file to the field of the handles structure that contains
the component’s handle. See “handles Structure” on page 8-23 for more
information about the handles structure.

To rename a particular callback function without changing the Tag property,

¢ In the Property Inspector, replace the name string in the callback property
with the new name. For example, if the value of the callback property for
a push button in mygui is

mygui( 'pushbutton1_Callback',hObject,eventdata,guidata(hObject))
the string pushbuttoni_Callback is the name of the callback function.
Change the name to the desired name, for example, closethegui.
® As necessary, update instances of the callback function name in the M-file
(for example, to function closethegui in its function definition).
After you alter a callback signature, whenever you click its pencil-and-paper

icon % to go to the function definition in the GUI M-file, GUIDE presents a
dialog box for you to confirm the changes you made.
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=101 ]

The current walue of Callback haz been manually modified.

Do you want ta replace it with the GUIDE auta-generated callback? Click
'z to get the auto-generated callback. Click Mo to keep the Callback
value az it s,

Click Yes to revert to the GUIDE auto-generated callback. click No to keep
the modified callback.

Note Remember to change the callback function definition in the GUI M-file
if you change its signature in the Property Inspector unless you are pointing a
callback to another function that exists in the M-file. For example, you might
want several toggle buttons or menu items to use the same callback.

Input Arguments

All callbacks in a GUIDE-generated GUI M-file have the following standard
input arguments:

® hObject — Handle of the object, e.g., the GUI component, for which the
callback was triggered. For a button group SelectionChangeFcn callback,
hObject is the handle of the selected radio button or toggle button.

® egventdata — Sequences of events triggered by user actions such as table
selections emitted by a component in the form of a MATLAB struct (or an
empty matrix for components that do not generate eventdata)

® handles — A MATLAB struct that contains the handles of all the objects
in the GUI, and may also contain application-defined data. See “handles
Structure” on page 8-23 for information about this structure.

Object Handle

The first argument is the handle of the component issuing the callback. Use
it to obtain relevant properties that the callback code uses and change them
as necessary. For example,
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theText = get(hObject, 'String');

places the String property (which might be the contents of static text or name
of a button) into the local variable theText. You can change the property by
setting it, for example

set(hObject, 'String',date)

This particular code changes the text of the object to display the current date.

Event Data
Event data is a stream of data describing user gestures, such as key presses,

scroll wheel movements, and mouse drags. The auto-generated callbacks of
GUIDE GUIs can access event data for Handle Graphics® and uicontrol and
uitable object callbacks. The following ones receive event data when triggered:
® CellEditCallback in a uitable

® CellSelectionCallback in a uitable

® KeyPressFcn in uicontrols and figures

® KeyReleaseFcn in a figure

® SelectionChangeFcn in a uibuttongroup

® WindowKeyPressFcn in a figure or any of its child objects

* WindowKeyReleaseFcn in a figure or any of its child objects

® WindowScrollWheelFcn in a figure

Event data is passed to GUIDE-generated callbacks as the second of three
standard arguments. For components that issue no event data the argument
is empty. For those that provide event data, the argument contains a

structure, which varies in composition according to the component that
generates it and the type of event.

For example, the event data for a key-press provides information on the
key(s) currently being pressed. Here is a GUIDE-generated KeyPressFcn
callback template:

% --- Executes on key press with focus on checkbox1 and none of its controls.
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function checkbox1_KeyPressFcn(hObject, eventdata, handles)
% hObject handle to checkbox1 (see GCBO)
% eventdata structure with the following fields (see UICONTROL)

% Key: name of the key that was pressed, in lower case

% Character: character interpretation of the key(s) that was pressed

% Modifier: name(s) of the modifier key(s) (i.e., control, shift) pressed
% handles structure with handles and user data (see GUIDATA)

The eventdata structure passed in has three fields, identifying the Character
being pressed (such as '='), the key Modifier (such as 'control'), and the
Key name (spelled out, such as 'equals’).

Components that provide event data use different structures with
event-specific field names to pass data. Callbacks with event data usually are
repeatedly issued as long as the event persists or sometimes at the beginning
of an event and thereafter only when its values change.

Learn how callbacks use event data by looking at the GUIDE uitable
example “GUI to Interactively Explore Data in a Table” on page 10-31 and
the programmatic uitable example “GUI that Displays and Graphs Tabular
Data” on page 15-18.

handles Structure

GUIDE creates a handles structure that contains the handles of all the
objects in the figure. For a GUI that contains an edit text, a panel, a pop-up
menu, and a push button, the handles structure originally looks similar to
this. GUIDE uses each component’s Tag property to name the structure
element for its handle.

handles =
figurel: 160.0011
edit1: 9.0020
uipaneli: 8.0017
popupmenui: 7.0018
pushbuttoni: 161.0011
output: 160.0011
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GUIDE creates and maintains the handles structure as GUI data. It is
passed as an input argument to all callbacks and enables a GUT’s callbacks to
share property values and application data.

For information about GUI data, see “Mechanisms for Managing Data” on
page 9-2 and the guidata reference page.

For information about adding fields to the handles structure and
instructions for correctly saving the structure, see Chapter 13, “Managing
Application-Defined Data”.
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Initialization Callbacks

In this section...

“Opening Function” on page 8-25
“Output Function” on page 8-28

Opening Function
The opening function is the first callback in every GUI M-file. It is executed
just before the GUI is made visible to the user, but after all the components

have been created, i.e., after the components’ CreateFcn callbacks, if any,
have been run.

You can use the opening function to perform your initialization tasks before
the user has access to the GUI. For example, you can use it to create data or
to read data from an external source. GUI command-line arguments are
passed to the opening function.

¢ “Function Naming and Template” on page 8-25
¢ “Input Arguments” on page 8-26
¢ “Initial Template Code” on page 8-28

Function Naming and Template

GUIDE names the opening function by appending OpeningFcn to the name
of the M-file. This is an example of an opening function template as it might
appear in the mygui M-file.

% --- Executes just before mygui is made visible.

function mygui_OpeningFcn(hObject, eventdata, handles, varargin)

% This function has no output args, see OutputFcn.

% hObject handle to figure

eventdata reserved - to be defined in a future version of MATLAB
% handles structure with handles and user data (see GUIDATA)

% varargin command line arguments to mygui (see VARARGIN)

o°

% Choose default command line output for mygui
handles.output = hObject;
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% Update handles structure
guidata(hObject, handles);

% UIWAIT makes mygui wait for user response (see UIRESUME)
% uiwait(handles.mygui);

Input Arguments

The opening function has four input arguments hObject, eventdata, handles,
and varargin. The first three are the same as described in “Input Arguments”
on page 8-21. the last argument, varargin, enables you to pass arguments
from the command line to the opening function. The opening function can take
actions with them (for example, setting property values) and also make the
arguments available to callbacks by adding them to the handles structure.

For more information about using varargin, see the varargin reference page
and “Passing Variable Numbers of Arguments” in the MATLAB Programming
Fundamentals documentation.

Passing Object Properties to an Opening Function. You can pass a
property name/value pair for any component as two successive command
line arguments and set that value in the opening function. If you are
setting a figure property, GUIDE handles this automatically. For example,
my_gui('Position', [71.8 44.9 74.8 19.7]) opens the GUI at the
specified position, since Position is a valid figure property (in character
units, the default).

You can define new names for properties or combinations of them. For
example, you can make your GUI accept an alias for a figure property as a
convenience to the user. For example, you might want the user to be able to
open the GUI with a Title argument instead of calling it Name, which is the
property that specifies the name on the GUT’s title bar. To do this, you must
provide code in its OpeningFcn to set theName figure property. The following
example illustrates how to do this.

If you pass an input argument that is not a valid figure property, your code
must recognize its name and use the name/value pair to set the appropriate
property on the correct object. Otherwise, the argument is ignored. The
following example is from the opening function for the Modal Question Dialog
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GUI template, available from the GUIDE Quick Start dialog box. The added
code opens the modal dialog with a message, specified from the command line
or by another GUI that calls this one. For example,

mygui('String','Do you want to exit?')

displays the text 'Do you want to exit?' on the GUI. To do this, you need
to customize the opening function because 'String' is not a valid figure
property, it is a static text property. The Modal Question Dialog template file
contains the following code, which

e Uses the nargin function to determine the number of user-specified
arguments (which do not include hObject, eventdata, and handles)

® Parses varargin to obtain property name/value pairs, converting each
name string to lower case

¢ Handles the case where the argument 'title' is used an alias for the
figure Name property

® Handles the case 'string' , assigning the following value as a String
property to the appropriate static text object

function modalgui_OpeningFcn(hObject, eventdata, handles, varargin)

% Insert custom Title and Text if specified by the user

o°

Hint: when choosing keywords, be sure they are not easily confused

o0

with existing figure properties. See the output of set(figure) for
a list of figure properties.

o°

if(nargin > 3)
for index = 1:2:(nargin-3),
if nargin-3==index, break, end
switch lower(varargin{index})
case 'title'
set(hObject, 'Name', varargin{index+1});
case 'string'
set(handles.text1, 'String', varargin{index+1});
end
end
end
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The if block loops through the odd elements of varargin checking for
property names or aliases, and the case blocks assign the following (even)
varargin element as a value to the appropriate property of the figure or one
of its components. You can add more cases to handle additional property
assignments that you want the opening function to perform.

Initial Template Code
Initially, the input function template contains these lines of code:

® handles.output = hObject adds a new element, output, to the handles
structure and assigns it the value of the input argument hObject, which is
the handle of the figure, i.e., the handle of the GUI. This handle is used
later by the output function. For more information about the output
function, see “Output Function” on page 8-28.

® guidata(hObject,handles) saves the handles structure. You must use
guidata to save any changes that you make to the handles structure.
It is not sufficient just to set the value of a handles field. See “handles
Structure” on page 8-23 and “GUI Data” on page 9-7 for more information.

¢ uiwait(handles.mygui), initially commented out, blocks GUI execution
until uiresume is called or the GUI is deleted. Note that uiwait allows the
user access to other MATLAB windows. Remove the comment symbol for
this statement if you want the GUI to be blocking when it opens.

Output Function

The output function returns, to the command line, outputs that are generated
during its execution. It is executed when the opening function returns control
and before control returns to the command line. This means that you must
generate the outputs in the opening function, or call uiwait in the opening
function to pause its execution while other callbacks generate outputs.

¢ “Function Naming and Template” on page 8-29
¢ “Input Arguments” on page 8-29
® “Output Arguments” on page 8-29
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Function Naming and Template

GUIDE names the output function by appending OutputFcn to the name of
the M-file. This is an example of an output function template as it might
appear in the mygui M-file.

% --- Outputs from this function are returned to the command line.

function varargout = mygui_OutputFcn(hObject, eventdata,...
handles)

% varargout cell array for returning output args (see VARARGOUT);

% hObject handle to figure

% eventdata reserved - to be defined in a future version of MATLAB

% handles structure with handles and user data (see GUIDATA)

% Get default command line output from handles structure
varargout{1} = handles.output;

Input Arguments

The output function has three input arguments: hObject, eventdata, and
handles. They are the same as described in “Input Arguments” on page 8-21.

Output Arguments

The output function has one output argument, varargout, which it returns to
the command line. By default, the output function assigns handles.output
to varargout. So the default output is the handle to the GUI, which was
assigned to handles.output in the opening function.

You can change the output by

® Changing the value of handles.output. It can be any valid MATLAB value
including a structure or cell array.

¢ Adding output arguments to varargout.

varargout is a cell array. It can contain any number of output arguments.
By default, GUIDE creates just one output argument, handles.output. To
create an additional output argument, create a new field in the handles
structure and add it to varargout using a command similar to

varargout{2} = handles.second_output;
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Examples: Programming GUIDE GUI Components

In this section...
“Push Button” on page 8-30

“Toggle Button” on page 8-32
“Radio Button” on page 8-32
“Check Box” on page 8-33
“Edit Text” on page 8-34
“Table” on page 8-35

“Slider” on page 8-36

“List Box” on page 8-36
“Pop-Up Menu” on page 8-37
“Panel” on page 8-39
“Button Group” on page 8-42
“Axes” on page 8-44
“ActiveX Control” on page 8-48

“Menu Item” on page 8-58

See “A Working GUI with Many Components” on page 6-24 in the GUIDE
documentation for an example of a complete GUI that incorporates most of
the controls described in the following sections.

Push Button
This example contains only a push button. Clicking the button closes the GUI.
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< close_button 1 =] |

Cloze |

This is the push button’s Callback callback. It displays the string Goodbye at
the command line and then closes the GUI.

function pushbutton1_Callback(hObject, eventdata, handles)
display Goodbye
close(handles.figurel);

Adding an Image to a Push Button or Toggle Button

To add an image to a push button or toggle button, assign the button’s CData
property an m-by-n-by-3 array of RGB values that defines “RGB (Truecolor)
Images”. For example, the array a defines 16-by-64 truecolor image using
random values between 0 and 1 (generated by rand).

a(:,:,1) = rand(16,64);
a(:,:,2) rand(16,64);
a(:,:,3) rand(16,64);

set(hObject, 'CData',a)

To add the image when the button is created, add the code to the button’s
CreateFcn callback. You may want to delete the value of the button’s String
property, which would usually be used as a label.

See ind2rgb for information on converting a matrix X and corresponding
colormap, i.e., an (X, MAP) image, to RGB (truecolor) format.
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Toggle Button

The callback for a toggle button needs to query the toggle button to determine
what state it is in. The Value property is equal to the Max property when
the toggle button is pressed and equal to the Min property when the toggle
button is not pressed.

The following code illustrates how to program the callback in the GUI M-file.

function togglebuttoni_Callback(hObject, eventdata, handles)
button_state = get(hObject, 'Value');

if button_state == get(hObject, 'Max')

% Toggle button is pressed, take appropriate action

elseif button_state == get(hObject, 'Min')
% Toggle button is not pressed, take appropriate action

end

You can also change the state of a toggle button programmatically by setting
the toggle button Value property to the value of its Max or Min property. This
example illustrates a possible syntax for such an assignment.

set(handles.togglebuttont, 'Value', '‘Max"')

puts the toggle button with Tag property togglebuttoni in the pressed state.

Note You can use a button group to manage exclusive selection behavior for
toggle buttons. See “Button Group” on page 8-42 for more information.

Radio Bution

You can determine the current state of a radio button from within its
Callback callback by querying the state of its Value property. If the radio
button is selected, its Value property is equal to its Max property. If the radio
button is not selected, it is equal to its Min property. This example illustrates
such a test.

function radiobuttoni_Callback(hObject, eventdata, handles)
if (get(hObject,'Value') == get(hObject,'Max'))
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% Radio button is selected, take appropriate action
else

% Radio button is not selected, take appropriate action
end

You can also change the state of a radio button programmatically by setting
the radio button Value property to the value of the Max or Min property. This
example illustrates a possible syntax for such an assignment.

set(handles.radiobuttoni, 'Value', 'Max"')

selects the radio button with Tag property radiobuttoni and deselects the
previously selected radio button.

Note You can use a button group to manage exclusive selection behavior for
radio buttons. See “Button Group” on page 8-42 for more information.

Check Box

You can determine the current state of a check box from within its callback by
querying the state of its Value property. The Value property is equal to the
Max property when the check box is checked and equal to the Min property
when the check box is not checked. This example illustrates such a test.

function checkbox1_Callback(hObject, eventdata, handles)
if (get(hObject,'Value') == get(hObject, 'Max'))

% Checkbox is checked-take approriate action

else

% Checkbox is not checked-take approriate action

end

You can also change the state of a check box programmatically by setting
the check box Value property to the value of the Max or Min property. This
example illustrates a possible syntax for such an assignment.

maxVal = get(handles.checkbox1, 'Max');
set (handles.checkbox1, 'Value',maxVal);

puts the check box with Tag property checkbox1 in the checked state.
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Edit Text

To obtain the string a user types in an edit box, get the String property in
the Callback callback.

function edittext1_Callback(hObject, eventdata, handles)
user_string = get(hObject, 'String');
% Proceed with callback

If the edit text Max and Min properties are set such that Max - Min > 1, the
user can enter multiple lines. For example, setting Max to 2, with the default
value of 0 for Min, enables users to enter multiple lines.

Retrieving Numeric Data from an Edit Text Component

MATLAB software returns the value of the edit text String property as a
character string. If you want users to enter numeric values, you must convert
the characters to numbers. You can do this using the str2double command,
which converts strings to doubles. If the user enters nonnumeric characters,
str2double returns NaN.

You can use the following code in the edit text callback. It gets the value of
the String property and converts it to a double. It then checks whether the
converted value is NaN (isnan), indicating the user entered a nonnumeric
character and displays an error dialog (errordlg).

function edittexti_Callback(hObject, eventdata, handles)
user_entry = str2double(get(hObject, 'string'));
if isnan(user_entry)
errordlg('You must enter a numeric value','Bad Input', 'modal')
uicontrol(hObject)
return
end
% Proceed with callback...

Edit text controls lose focus when the user commits and edit (by typing
Return or clicking away). The line uicontrol (hObject) restores focus to the
edit text box. Although doing this is not needed for its callback to work, it is
helpful in the event that user input fails validation. The command has the
effect of selecting all the text in the edit text box.
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Triggering Callback Execution

If the contents of the edit text component have been changed, clicking inside
the GUI but outside the edit text causes the edit text callback to execute. The
user can also press Enter for an edit text that allows only a single line of text,
or Ctrl+Enter for an edit text that allows multiple lines.

Available Keyboard Accelerators

GUI users can use the following keyboard accelerators to modify the content
of an edit text. These accelerators are not modifiable.

Ctrl+X — Cut

Ctrl+C — Copy

Ctrl+V — Paste

Ctrl+H — Delete last character
Ctrl+A — Select all

Table

A table can contain numbers, character data, and preset choices (drop-down
menus). Each column must contain the same type of data. You can make

a table or any column within it editable by the end user. You can specify
column formats and give rows and columns consecutive numbers or label
them individually. The number of rows and columns automatically adjust to
reflect the size of the data matrix the table displays. Beside having callbacks
common to most components (ButtonDownFcn, DeleteFcn, and KeypressFcn),
tables have the following special callbacks:

® CellEditCallback
® CellSelectionCallback

These callbacks are unique to tables and are described below. Both issue
event data.

Table CellEditCallbacks

If a table is user editable (because one or more columns have their
ColumnEditable property set to true), the CellEditCallback fires every
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time the user changes the value of a table cell. The callback can use event
data passed to it to identify which cell was changed, what the previous value
for it was and what the new value i1s. For example, it can assess whether
the new value is valid or not (e.g., numbers representing a person’s height
or weight must be positive); the callback can issue an error alert and then
replace the invalid value with the previous value.

Table CellSelectionCallback

Every time the user selects a table cell, the table’s CellSelectionCallback
fires. This happens whether table cells are editable or not. When cells are not
editable, users can drag across a range of cells to select them all. When cells
are editable, users can select more than one cell at a time using Shift+click or
Ctrl+click, but not by dragging. The indices for all currently selected cells are
returned in the CellSelectionCallback eventdata structure. The callback
fires every time the selection changes, and new event data is passed.

Slider

You can determine the current value of a slider from within its callback by
querying its Value property, as illustrated in the following example:

function slideri_Callback(hObject, eventdata, handles)
slider_value = get(hObject, 'Value');
% Proceed with callback...

The Max and Min properties specify the slider’s maximum and minimum
values. The slider’s range is Max - Min.

List Box

When the list box Callback callback is triggered, the list box Value property
contains the index of the selected item, where 1 corresponds to the first item
in the list. The String property contains the list as a cell array of strings.

This example retrieves the selected string. It assumes 1istbox1 is the value
of the Tag property. Note that it is necessary to convert the value returned
from the String property from a cell array to a string.

function listbox1_Callback(hObject, eventdata, handles)
index_selected = get(hObject, 'Value');
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list = get(hObject, 'String');
item_selected = list{index_selected}; % Convert from cell array
to string

[
“

You can also select a list item programmatically by setting the list box Value
property to the index of the desired item. For example,

set(handles.listbox1, 'Value',2)

selects the second item in the list box with Tag property listbox1.

Triggering Callback Execution

MATLAB software executes the list box’s Callback callback after the mouse
button is released or after certain key press events:

® The arrow keys change the Value property, trigger callback execution, and
set the figure SelectionType property to normal.

* The Enter key and space bar do not change the Value property but trigger
callback execution and set the figure SelectionType property to open.

If the user double-clicks, the callback executes after each click. The software
sets the figure SelectionType property to normal on the first click and to
open on the second click. The callback can query the figure SelectionType
property to determine if it was a single or double click.

List Box Examples
See the following examples for more information on using list boxes:

® “List Box Directory Reader” on page 10-54 — Shows how to creates a GUI
that displays the contents of directories in a list box and enables users to
open a variety of file types by double-clicking the filename.

® “Accessing Workspace Variables from a List Box” on page 10-61 — Shows
how to access variables in the MATLAB base workspace from a list box GUI.

Pop-Up Menu

When the pop-up menu Callback callback is triggered, the pop-up menu
Value property contains the index of the selected item, where 1 corresponds to
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the first item on the menu. The String property contains the menu items as
a cell array of strings.

Note A pop-up menu is sometimes referred to as a drop-down menu or combo
box.

Using Only the Index of the Selected Menu ltem

This example retrieves only the index of the item selected. It uses a switch
statement to take action based on the value. If the contents of the pop-up
menu are fixed, then you can use this approach. Else, you can use the index
to retrieve the actual string for the selected item.

function popupmenul_Callback(hObject, eventdata, handles)
val = get(hObject, 'Value');

switch val

case 1

% User selected the first item

case 2

% User selected the second item

% Proceed with callback...

You can also select a menu item programmatically by setting the pop-up
menu Value property to the index of the desired item. For example,

set(handles.popupmenui, 'Value',2)

selects the second item in the pop-up menu with Tag property popupmenui.

Using the Index to Determine the Selected String

This example retrieves the actual string selected in the pop-up menu. It
uses the pop-up menu Value property to index into the list of strings. This
approach may be useful if your program dynamically loads the contents of the
pop-up menu based on user action and you need to obtain the selected string.
Note that it is necessary to convert the value returned by the String property
from a cell array to a string.

function popupmenui_Callback(hObject, eventdata, handles)
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val = get(hObject, 'Value');

string_list = get(hObject, 'String');

selected_string = string_list{val}; % Convert from cell array
to string

[
“

% Proceed with callback...

Panel

Panels group GUI components and can make a GUI easier to understand by
visually grouping related controls. A panel can contain panels and button
groups as well as axes and user interface controls such as push buttons,
sliders, pop-up menus, etc. The position of each component within a panel is
interpreted relative to the lower-left corner of the panel.

Generally, if the GUI is resized, the panel and its components are also
resized. However, you can control the size and position of the panel and its
components. You can do this by setting the GUI Resize behavior to Other
(Use ResizeFcn) and providing a ResizeFcn callback for the panel.

Note To set Resize behavior for the figure to Other (Use ResizeFcn),
select GUI Options from the Layout Editor Tools menu. Also see
“Cross-Platform Compatible Units” on page 6-138 for information about the
effect of units on resize behavior.

Even when Resize behavior for the figure is Other (Use ResizeFcn),

if components use normalized Units, they still automatically resize
proportionally unless a ResizeFcn overrides that behavior. The following
example shows how you can use a ResizeFcn to do more than that. The GUI
repositions components automatically. Its panel’s ResizeFcn proportionally
adjusts the fontSize of a button’s label.

1 Create a GUI in GUIDE that contains a panel with two push buttons inside
it. In the Property Inspector, name the buttons Button 1 and Button 2.
Set the figure’s Units to pixels and its Position to [420 520 150 190].
The GUI looks like this.
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i Button 1

Button 2

2 Create callbacks for the two push buttons, and place the following line of
code in each of them.

set(gcbf, 'Position',[420 520 150 190])

This resets the GUI to its initial size, so you can experiment with resizing
it manually.

3 In the Property Inspector, set the Units of the panel and the two buttons to
normalized. Also set the fontSize of both buttons to 10. Make sure that
the fontUnits property for both buttons is set to points.

4 Create a ResizeFcn callback for the panel by Clicking the pencil icon for the
ResizeFcn in the Property Inspector and insert the following code into it.

function uipanelil_ResizeFcn(hObject, eventdata, handles)

set(hObject, 'Units', 'Points') % Was normalized
panelSizePts = get(hObject, 'Position'); % Now in points
panelHeight = panelSizePts(4);

set(hObject, 'Units', 'normalized'); % Now normalized again
% Keep fontsize in constant ratio to height of panel

newFontSize = 10 * panelHeight / 115; % Calculated in points

buttons = get(hObject, 'Children');
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set(buttons(1), 'FontSize',newFontSize); % Resize the first button
% Do not resize the other button for comparison

This code adjusts the size of one of the buttons label (in this instance, the
bottom one) when the figure resizes. It computes newFontSize as the
ratio of the panel’s current size to its original size (expressed in points)
multiplied by the original button fontSize, 10 points. Then it sets one of
the button’s fontSize to that value.

5 When you run the GUI, it looks like the previous figure. When you resize it

to be smaller or larger, the text of one of the buttons shrinks or grows, as
shown in the following illustration.

SI= 18]

Panel

Button 1 | —Pangl——————————
Buttan 2 |

Button 1

Button 2

When you click either button, the GUI and the buttons returns to their
original size. Because all Units are normalized, no other code for
proportional resizing is needed.
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Tip You can enable text in controls to resize automatically by setting the
component’s fontUnits to normalized, without the need for a ResizeFcn.
This example illustrates one way to achieve the same result with callback
code.

Nested panels resize from inner to outer (in child-to-parent order). For more
information about resizing panels, see the uipanel properties reference page.

Button Group

Button groups are like panels except that they manage exclusive selection
behavior for radio buttons and toggle buttons. If a button group contains a
set of radio buttons, toggle buttons, or both, the button group allows only one
of them to be selected. When a user clicks a button, that button is selected
and all others are deselected.

When programming a button group, you do not code callbacks for the
individual buttons; instead, use its SelectionChangeFcn callback to manage
responses to selections. The following example, “Programming a Button
Group” on page 8-43, illustrates how you use uibuttongroup event data to
do this.

The following figure shows a button group with two radio buttons and two
toggle buttons. Radio Button 1 is selected.

<) untitled [_ ] =]

Button Group

{* Radio Button 1 Togale Button 1 |

{~ Radio Button 2
Toggle Button 2
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If a user clicks the other radio button or one of the toggle buttons, it becomes
selected and Radio Button 1 is deselected. The following figure shows the
result of clicking Toggle Button 2.

<) untitled [_ ] =]

Button Group

" Radio Button 1 Toggle Button 1 |

{~ Radio Button 2

The button group’s SelectionChangeFcn callback is called whenever a
selection is made. Its hObject input argument contains the handle of the
selected radio button or toggle button.

If you have a button group that contains a set of radio buttons and toggle
buttons and you want:

¢ An immediate action to occur when a radio button or toggle button is
selected, you must include the code to control the radio and toggle buttons
in the button group’s SelectionChangeFcn callback function, not in the
individual toggle button Callback functions.

® Another component such as a push button to base its action on the
selection, then that component’s Callback callback can get the handle
of the selected radio button or toggle button from the button group’s
SelectedObject property.

Programming a Button Group

This example of a SelectionChangeFcn callback uses the Tag property of the
selected object to choose the appropriate code to execute. The Tag property
of each component is a string that identifies that component and must be
unique in the GUI.

function uibuttongroupi_SelectionChangeFcn(hObject,eventdata)
switch get(eventdata.NewValue,'Tag') % Get Tag of selected object.
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case 'radiobuttont’

o°

Code for when radiobuttoni1 is selected.
case 'radiobutton2’

o°

Code for when radiobutton2 is selected.
case 'togglebuttont’

o°

Code for when togglebuttoni is selected.
case 'togglebutton2’
% Code for when togglebutton2 is selected.
% Continue with more cases as necessary.
otherwise
% Code for when there is no match.
end

The hObject and eventdata arguments are available to the callback only if
the value of the callback property is specified as a function handle. See the
SelectionChangeFcn property on the Uibuttongroup Properties reference
page for information about eventdata. See the uibuttongroup reference page
and “Color Palette” on page 15-50 for other examples.

Axes

Axes components enable your GUI to display graphics, such as graphs and
images. This topic briefly tells you how to plot to axes components in your

GUL

e “Plotting to an Axes” on page 8-44
e “Creating Subplots” on page 8-47

Plotting to an Axes

In most cases, you create a plot in an axes from a callback that belongs to
some other component in the GUI. For example, pressing a button might
trigger the plotting of a graph to an axes. In this case, the button’s Callback
callback contains the code that generates the plot.
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The following example contains two axes and two buttons. Clicking one
button generates a plot in one axes and clicking the other button generates a
plot in the other axes. The following figure shows these components as they
might appear in the Layout Editor.

axes1

Plot 1

axes?

Plot 2

1 Add this code to the Plot 1 push button’s Callback callback. The surf
function produces a 3-D shaded surface plot. The peaks function returns a
square matrix obtained by translating and scaling Gaussian distributions.

surf(handles.axes1,peaks(35));
2 Add this code to the Plot 2 push button’s Callback callback. The contour

function displays the contour plot of a matrix, in this case the output
of peaks.

contour(handles.axes2,peaks(35));

3 Run the GUI by selecting Run from the Tools menu.
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4 (Click the Plot 1 button to display the surf plot in the first axes. Click the
Plot 2 button to display the contour plot in the second axes.

See “GUI with Multiple Axes” on page 10-2 for a more complex example that
uses two axes.

Note For information about properties that you can set to control many
aspects of axes behavior and appearance, see “Axes Properties” in the
MATLAB Graphics documentation. For information about plotting in general,
see “Plots and Plotting Tools” in the MATLAB Graphics documentation.

If your GUI contains axes, you should make sure that the Command-line
accessibility option in the GUI Options dialog box is set to Callback (the
default). From the Layout Editor select Tools > GUI Options > Command
Line Accessibility: Callback. See “Command-Line Accessibility” on page
5-10 for more information about how this option works.
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Creating Subplots

Use the subplot function to create axes in a tiled pattern. If your
GUIDE-generated GUI contains components other than the subplots, the
subplots must be contained in a panel.

As an example, the following code uses the subplot function to create an
axes with two subplots in the panel with Tag property uipaneli. This code
is part of the Plot push button Callback callback. Each time you press the
Plot button, the code draws a line in each subplot. a1 and a2 are the handles
of the subplots.

al=subplot(2,1,1, " 'Parent',handles.uipanell);
plot(atl,rand(1,10),'r");
a2=subplot(2,1,2, 'Parent',handles.uipanell);
plot(a2,rand(1,10),'b");

Flot

(=]
[§&]
iy
-k
=]
-
(=]

0.5
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Tip When working with multiple axes, it is best not to “raise” the axes you
want to plot data into with commands like

axes(atl)

This will make axes a1 the current axes, but it also restacks figures and
flushes all pending events, which consumes computer resources and is rarely
necessary for a callback to do. It is more efficient to simply supply the axes
handle as the first argument of the plotting function you are calling, such as

plot(at, ...)

which outputs the graphics to axes a1 without restacking figures or flushing
queued events. To designate an axes for plotting functions which do not
accept and axes handle argument, such as the 1ine function, you can make a1
the current axes as follows.

set(figure_handle, 'CurrentAxes',atl)
line(X,y,z,...)

See the CurrentAxes description in the figure properties reference page for
more details.

For more information about subplots, see the subplot reference page. For
information about adding panels to your GUI, see “Adding Components to the
GUIDE Layout Area” on page 6-31.

ActiveX Control

This example programs a sample ActiveX control Mwsamp Control. It first
enables a user to change the radius of a circle by clicking on the circle. It then
programs a slider on the GUI to do the same thing.

® “Programming an ActiveX Control” on page 8-49

* “Programming a User Interface Control to Update an ActiveX Control”

on page 8-54

This topic also discusses:
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* “Viewing the Methods for an ActiveX Control” on page 8-55
e “Saving a GUI That Contains an ActiveX Control” on page 8-56
® “Compiling a GUI That Contains an ActiveX Control” on page 8-57

See “Creating COM Objects” in the MATLAB External Interfaces
documentation to learn more about ActiveX controls.

Note GUIDE enables ActiveX controls to resize automatically if the figure
1s resizable. If you are creating a GUI with ActiveX controls outside of
GUIDE, you can use the resizing technique described in “Example — Using
Internet Explorer® Program in a MATLAB Figure” in the MATLAB External

Interfaces documentation.

Programming an ActiveX Control

The sample ActiveX control Mwsamp Control contains a circle in the
middle of a square. This example programs the control to change the circle
radius when the user clicks the circle, and to update the label to display the
new radius.

If you are reading this in the MATLAB Help browser, you can click the
following links to display the GUIDE Layout Editor and the MATLAB Editor
with a completed version of the following example.

Note The following links execute MATLAB commands and are designed to
work within the MATLAB Help browser. If you are reading this online or
in PDF, you should go to the corresponding section in the MATLAB Help
Browser to use the links.

¢ (Click here to display the Mwsamp GUI in the Layout Editor.
¢ (Click here to display the Mwsamp GUI M-file in the MATLAB Editor.
If you modify the example GUI or its M-file and want to retain your changes,

use File > Save as in the Layout Editor and save the files in a folder to which
you have write access.
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1 To add the sample ActiveX control, click the ActiveX tool X in the GUIDE
Layout Editor and drag out an area to contain it. The dialog box opens.

2 Select Mwsamp Control from the list box on the left side of the dialog box. A

preview of it appears in the right side.

) select an ActiveX Control

Actived Control List: Preswiewn:

Microsoft Terminal Services Cortrol | a
Microsoft Toolkar Control, version 6.0
Microsoft TreeView Contral, version &.
Microsoft UpDown Control 6.0 (SP4)
Microsoft Visio Document

Microsoft Web Browser

Microsoft Warks Imaging Server
Migration Wizard OOBE Autamation Ok

M=ie Control

fwsamp Control
MMwsamp2 Contraol
Methesting Application

Mumeric LED Activex Contraol
Olnfol1 Contral

OWWS Post Data

Odometer ActiveX Contral
Olelnstall Class

Outlook Express Mime Editor

Label

CuickTime Object -
kil | >

=101 %]

Percent Active Contral

Preview Class

ProgView Class Procram D MASAMP MuvsampCe 1

PropPanelControl Class )

Pvapplite_ie Control Locstion: C:iPROGRA~1WATLABR200G toalbaximatlak
QuickTime Object winfuninwin32mwwsamp ocx

Create I}J Cancel

Help
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Note Clicking Create places a copy of the file Mwsamp_activex1 in your
working folder. If you move your GUI files to a different folder, you should
move the ActiveX controls they use with them.

Click Create to add the sample ActiveX control Mwsamp to your GUI
and resize it to approximately the size of the square shown in the preview
pane. The following figure shows the ActiveX control as it appears in the
Layout Editor.

If you need help adding the component, see “Adding ActiveX Controls”
on page 6-76.

activexl

| | | I Resize the control by clicking ond drogging

Activate the GUI by clicking the ™ button on the toolbar and save the GUI
when prompted. GUIDE displays the GUI shown in the following figure
and opens the GUI M-file.
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) ActiveXcontrol | o ] 4 |

Label

5 View the ActiveX Properties with the Property Inspector. Select the control

in the Layout Editor, and then select Property Inspector from the View
menu or by clicking the Property Inspector button B on the toolbar.

The following figure shows properties of the mwsamp ActiveX control as they
appear in the Property Inspector. The properties on your system may differ.

E Inspector: COM.MWSAMP_MwsampCrl_1

0] e =

Label Label &

Radius 20 &

This ActiveX control mwsamp has two properties:
® |abel, which contains the text that appears at the top of the control

® Radius, the default radius of the circle, which is 20

Locate the Click callback in the GUI M-file; select View Callbacks from
the View menu and then select Click.

GUIDE adds a new callback template, activex1_Click, to the end of the
GUI M-file.
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7 Add the following code to the mswamp control’s activex1 Click callback.
This code programs the ActiveX control to change the circle radius when
the user clicks the circle, and updates the label to display the new radius.

hObject.radius = floor(.9*hObject.radius);
hObject.label = ['Radius = ' num2str(hObject.radius)];
refresh(handles.figurel);

8 Add the following commands to the end of the opening function,
Mwsamp_OpeningFcn. This code initializes the label when you first open
the GUI.

handles.activexi.label = ...
['"Radius = ' num2str(handles.activexi.radius)];

Save the M-file. Now, when you open the GUI and click the ActiveX control,
the radius of the circle is reduced by 10 percent and the new value of the
radius is displayed. The following figure shows the GUI after clicking the
circle six times.

-} Mwsamp =101

Radius = 9

@

If you click the GUI enough times, the circle disappears.
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Programming a User Interface Control to Update an ActiveX
Control

This topic continues the previous example by adding a slider to the GUI and
programming the slider to change the circle radius. This example must also
update the slider if the user clicks the circle.

1 Add a slider to your layout and then add the following code to the slider
Callback callback:

handles.activexi.radius = ...

get(hObject, 'Value')*handles.default_radius;
handles.activexi.label = ...

[ '"Radius = ' num2str(handles.activexi.radius)];
refresh(handles.figurel);

The first command

® Gets the Value of the slider, which in this example is a number between
0 and 1, the default values of the slider’s Min and Max properties.

® Sets handles.activex1.radius equal to the Value times the default
radius.

2 In the opening function, add the default radius to the handles structure.
The activex1_Click callback uses the default radius to update the slider
value if the user clicks the circle.

handles.default radius = handles.activexi.radius;

3 In the activexi_Click callback, reset the slider’s Value each time the user
clicks the circle in the ActiveX control. The following command causes the
slider to change position corresponding to the new value of the radius.

set(handles.slider1, 'Value',...
hObject.radius/handles.default_radius);

When you open the GUI and move the slider by clicking and dragging, the
radius changes to a new value between 0 and the default radius of 20, as
shown in the following figure.
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i

Radius = 14

O

Viewing the Methods for an ActiveX Control

To view the available methods for an ActiveX control, you first need to obtain
the handle to the control. One way to do this is the following:

1 In the GUI M-file, add the command keyboard on a separate line of the
activexi_Click callback. The command keyboard puts MATLAB software
in debug mode and pauses at the activex1_Click callback when you click
the ActiveX control.

2 Run the GUI and click the ActiveX control. The handle to the control is
now set to hObject.

3 To view the methods for the control, enter

methodsview(hObject)

This displays the available methods in a new window, as shown in the
following figure.
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<) Methods of class COM.mwsamp.mwsampctrl.1.release ;|g|5|
Return Type Mame Arguments Inherited Fram
AboutBox (handle) COM.mwsamp.mwsampctrl.1 1=
Beep (handle) COM.mwsamp.mwsampetrl. 1
FireClickEvent (handle) COM.mwsamp.mwsampetrl. 1
string GetBSTR (handle) COM.mwsamp.mwsampetrl. 1
Wariant GetBSTRAray (handle) COM.mwsamp.mwsampetrl. 1
int3z Getld (handle) COM.mwsamp.mwsampetrl. 1
Wariant GetldArray (handle) COM.mwsamp.mwsampetrl. 1
Wariant Getldvector (handle) COM.mwsamp.mwsampetrl. 1
handle GetlDispatch (handle) COM.mwsamp.mwsampetrl. 1
douhle GetRE (handle) COM.mwsamp.mwsampetrl. 1 |
Wariant GetRBArray (handle) COM.mwsamp.mwsampetrl. 1
Wariant GetREVector (handle) COM.mwsamp.mwsampetrl. 1
Wariant Getvarianthrray thandle} COM.mwsamp.mwsampctrl.1
Wariant Getvariantvector (handle) COM.mwsamp.mwsampetrl. 1
Redraw (handle) COM.mwsamp.mwsampetrl. 1
string SetBSTR (handle, string) COM.mwsamp.mwsampetrl. 1
Wariant SetBSTRAray {handle, Yariant) COM.mwsamp.mwsampetrl. 1
int3z Setld (handle, int32) COM.mwsamp.mwsampetrl. 1
Wariant SetldArray {handle, Yariant) COM.mwsamp.mwsampetrl. 1
Wariant Setldvectar {handle, Yariant) COM.mwsamp.mwsampetrl. 1 ;l

Alternatively, you can enter

methods (hObject)
which displays the available methods in the MATLAB Command Window.

For more information about methods for ActiveX controls, see “Using
Methods” in the External Interfaces documentation. See the reference pages
for methodsview and methods for more information about these functions.

Saving a GUI That Contains an ActiveX Control

When you save a GUI that contains ActiveX controls, GUIDE creates a file in
the current folder for each such control. The filename consists of the name of
the GUI followed by an underscore () and activexn, where n is a sequence
number. For example, if the GUI is named mygui, then the filename would be
mygui_activexi. The filename does not have an extension.
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Compiling a GUI That Contains an ActiveX Control

If you use the MATLAB Compiler mcc command to compile a GUI that
contains an ActiveX control, you must use the -a flag to add the ActiveX file,
which GUIDE saves in the current folder, to the CTF archive. Your command
should be similar to

mcc -m mygui -a mygui_activexi

where mygui_activex1 is the name of the ActiveX file. See the “MATLAB
Compiler™” documentation for more information. If you have more than one

such file, use a separate -a flag for each file. You must have installed the
MATLAB Compiler to compile a GUL
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Menu ltem

The Menu Editor generates an empty callback subfunction for every menu
item, including menu titles.

Programming a Menu Title

Because clicking a menu title automatically displays the menu below it, you
may not need to program callbacks at the title level. However, the callback
associated with a menu title can be a good place to enable or disable menu
items below it.

Consider the example illustrated in the following picture.

«J Untitled =10l x|

File | Edit  View
Cuk |

to clipboard

Paste

Select all

When a user selects the to file option under the Edit menu’s Copy option,
only the to file callback is required to perform the action.

Suppose, however, that only certain objects can be copied to a file. You can
use the Copy item Callback callback to enable or disable the to file item,
depending on the type of object selected.

Opening a Dialog Box from a Menu Callback

The Callback callback for the to file menu item could contain code such as
the following to display the standard dialog box for saving files.

[file,path] = uiputfile('animinit.m','Save file name');
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'Save file name' is the dialog box title. In the dialog box, the filename field
is set to animinit.m, and the filter set to M-files (*.m). For more information,
see the uiputfile reference page.

« ) Menu Editor 1 = =] 3
B - -
'="|“" I v|ﬁ Tog forms the
~ ~Uinenu Propettie: name Uf “E
E- ] File = cdlback
— = Open
— = Close
— = Save
E- [E] Edit
— & cut i Separatar above this tem
- = Copy ™ Check mark this item
— = Paste
S — ¥ Enable this iterm
B [E] View Callback:l%automatic Wigy |
| = Menubar |
Mare optiohs ==
Menu Bar | Context Menus L - |

_ox | e |

Updating a Menu ltem Check

A check is useful to indicate the current state of some menu items. If you
selected Check mark this item in the Menu Editor, the item initially
appears checked. Each time the user selects the menu item, the callback for
that item must turn the check on or off. The following example shows you how
to do this by changing the value of the menu item’s Checked property.

if strcmp(get(hObject, 'Checked'),'on')
set(hbject, 'Checked', 'off');

else
set(hObject, 'Checked','on");

end

hObject is the handle of the component, for which the callback was triggered.
The strcmp function compares two strings and returns logical 1 (true) if the
two are identical and logical 0 (false) otherwise.
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Use of checks when the GUI is first displayed should be consistent with the
display. For example, if your GUI has an axes that is visible when a user first
opens it and the GUI has a Show axes menu item, be sure to set the menu
item’s Checked property on when you create it so that a check appears next to
the Show axes menu item initially.

Note From the Menu Editor, you can view a menu item’s Callback callback
in your editor by selecting the menu item and clicking the View button.




Managing and Sharing
Application Data in GUIDE

e “Mechanisms for Managing Data” on page 9-2

¢ “Making Multiple GUIs Work Together” on page 9-21
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Mechanisms for Managing Data

In this section...

“Overview” on page 9-2

“Nested Functions” on page 9-4

“UserData Property” on page 9-5

“Application Data” on page 9-5

“GUI Data” on page 9-7

“Examples of Sharing Data Among a GUI’s Callbacks” on page 9-10

Overview

Most GUIs generate or use data specific to the application. GUI components
often need to communicate data to one another and several basic mechanism
serve this need.

Although many GUIs are single figures, you can make several GUIs work
together if your application requires more than a single figure. For example,
your GUI could require several dialog boxes to display and obtain some of
the parameters used by the GUIL. Your GUI could include several individual
tools that work together, either at the same time or in succession. To avoid
communication via files or workspace variables, you can use any of the
methods described in the following table.

Data-Sharing | How it Works Use for...

Method

Property/value | Send data into a Communicating data to new GUIs.
pairs newly invoked or

existing GUI by
passing it along as
input arguments.

Output Return data from the | Communicating data back to the
invoked GUIL invoking GUI, such as passing
back the handles structure of the
invoked GUI
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Data-Sharing | How it Works Use for...

Method

Function Pass function handles | Exposing functionality within a
handles or or data through one | GUI or between GUIs

private data

of the four following
methods:

“Nested Functions”:
share the name
space of all superior
functions

Accessing and modifying variables
defined in a directly or indirectly
enclosing function, typically
within a single GUI figure

UserData: Store
data in this figure or
component property
and communicate it
to other GUIs via
handle references.

Communicating data within a
GUI or between GUIs; UserData
is limited to one variable, often

supplied as a struct

Application Data
(getappdata and
setappdata): Store
named data in a
figure or component
and communicate
to other GUIs via
handle references.

Communicating data within a GUI
or between GUIs; any number or

types of variables can be stored as
application data through this API

guidata: Store data
in the handles
structure of a GUI
and communicate
to other GUIs via
handle references.

Communicating data within a GUI
or between GUIs—a convenient
way to manage application data.
GUI Data is a struct associated

with the GUI figure.

The example “Icon Editor” on page 15-62 further explains sharing data

between GUI figures.

The next three sections describe mechanisms that provide a way to manage

application-defined data, stored within a GUI:

9-3
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¢ Nested Functions — Share variables defined at a higher level and call
one another when called function is below above, or a sibling of the caller.

¢ UserData Property — A MATLAB workspace variable that you assign to
GUI components and retrieve like any other property.

* Application Data — Provides a way for applications to save and retrieve
data associated with a specified object. For a GUI, this is usually the GUI
figure, but it can also be any component. The data is stored as name/value
pairs. Application data enables you to create what are essentially
user-defined properties for an object.

e GUI Data — Uses the guidata function to manage GUI data. This
function can store a single variable as GUI data in a MATLAB structure,
which in GUIDE is called the handles structure. You use the function to
retrieve the handles structure, as well as to update it.

You can compare the three approaches applied to a simple working GUI in
“Examples of Sharing Data Among a GUT’s Callbacks” on page 9-10.

Nested Functions

When you place nested functions in a GUI M-file, they enable callback
functions to share data freely without it having to be passed as arguments:

1 Construct components, define variables, and generate data in the
Initialization segment of your code.

2 Nest the GUI callbacks and utility functions at a level below the
initialization.

The callbacks and utility functions automatically have access to the data and
the component handles because they are defined at a higher level. Using this
approach can eliminate the need for storing UserData, application data, or
GUI Data in many instances.

Note For the rules and restrictions that apply to using nested functions,
see “Nested Functions” in the MATLAB Programming Fundamentals
documentation.
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UserData Property

All GUI components, including menus and the figure itself have a UserData
property. You can assign any valid MATLAB workspace value as the
UserData property’s value, but only one value can exist at a time. To retrieve
the data, a callback must know the handle of the component in which the
data is stored. You access UserData using get and set with the appropriate
object’s handle. The following example illustrates this pattern:

1 An edit text component stores the user-entered string in its UserData
property:

function mygui_edittext1(hObject, eventdata, handles)
mystring = get(hObject, 'String');
set(hObject, 'UserData' ,mystring);

2 A menu item retrieves the string from the edit text component’s UserData
property. The callback uses the handles structure and the edit text’s Tag
property, edittext1, to specify the edit text handle:

function mygui_pushbuttoni(hObject, eventdata, handles)
string = get(handles.edittext1, 'UserData');

For example, if the menu item is Undo, its code could reset the String of
edittext1 back to the value stored in its UserData. To facilitate undo
operations, the UserData can be a cell array of strings, managed as a stack
or circular buffer.

Application Data

Application data, like UserData, is arbitrary data that is meaningful to and
defined by your application. Whether to use application data or UserData
is a matter of choice. You attach application data to a figure or any GUI
component (other than ActiveX controls) with the functions setappdata and
getappdata, The main differences between it and UserData are:

® You can assign multiple values to application data, but only one value
to UserData

® Your code must reference application data by name (like using a Tag), but
can access UserData like any other property
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Only Handle Graphics MATLAB objects use this property. The following table
summarizes the functions that provide access to application data. For more
details, see the individual function reference pages.

Functions for Managing Application Data

Function Purpose

setappdata | Specify named application data for an object (a figure

or other Handle Graphics object in your GUI). You can
specify more than one named application data for an object.
However, each name must be unique for that object and can
be associated with only one value, usually a structure.

getappdata | Retrieve named application data. To retrieve named
application data, you must know the name associated with
the application data and the handle of the object with which
it 1s associated. If you specify a handle only, all the object’s
application data is returned.

isappdata True if the named application data exists, false otherwise.

rmappdata Remove the named application data.

Creating Application Data in GUIDE

Use the setappdata function to create application data. This example
generates a 35-by-35 matrix of normally distributed random numbers in the
opening function and creates application data mydata to manage it:

function mygui_OpeningFcn(hObject, eventdata, handles, varargin)
matrices.rand_35 = randn(35);
setappdata(hObject, 'mydata’',matrices);

Because this code appears in the opening function (mygui_OpeningFcn),
hObject is the handle of the GUI figure, and the code sets mydata as
application data for the figure.

9-6
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Adding Fields to an Application Data Structure in GUIDE

Application data is usually defined as a structure. This enables you to
add fields as necessary. In this example, a push button adds a field to the
application data structure mydata created in the previous section:

1 Use getappdata to retrieve the structure.

The name of the application data structure is mydata. It is associated with
the figure whose Tag is figure1. Since you pass the handles structure to
every callback, the code specifies the figure’s handle as handles.figure1:

function mygui_pushbuttoni(hObject, eventdata, handles)
matrices = getappdata(handles.figurei, 'mydata’');

2 Create a new field and assign it a value:

matrices.randn_50 = randn(50);

adds the field randn_50 to the matrices structure and sets it to a 50-by-50
matrix of normally distributed random numbers.

3 Use setappdata to save the data. This command uses setappdata to save
the matrices structure as the application data structure mydata:

setappdata(handles.figurel, 'mydata’',matrices);

GUI Data

GUI data is always associated with the GUI figure and is available to all
callbacks of all the GUI components created in GUIDE. If you specify a
component handle when you save or retrieve GUI data, MATLAB software
automatically associates the data with the component’s parent figure. With
GUI data:

® You can access the data from within a callback routine using the
component’s handle, without needing to find the figure handle.

® You do not need to create and maintain a hard-coded name for the data
throughout your source code.

Use the guidata function to manage GUI data. This function can store a
single variable as GUI data. GUI data differs from application data in that

9-7
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e GUI data is a single variable; however, when defined as a structure, you
can add and remove fields.

® Application data can consist of many variables, each stored under a
separate unique name.

e GUIDE uses GUI data to store its handles structure, to which you can add
fields, but should not remove any.

® You access GUI data using the guidata function, which both stores and
retrieves GUI data.

® Whenever you use guidata to store GUI data, it overwrites the existing
GUI data.

® Using the getappdata, setappdata, and rmappdata functions does not
affect GUI data.

GUI Data in GUIDE

GUIDE uses guidata to create and maintain the handles structure. The
handles structure contains the handles of all GUI components. GUIDE
automatically passes the handles structure to every callback as an input
argument.

In a GUI created using GUIDE, you cannot use guidata to manage any
variable other than the handles structure. If you do, you can overwrite the
handles structure and your GUI will not work. To use GUI data to share
application-defined data among callbacks, you must save the data in fields
that you add to the handles structure. See “handles Structure” on page 8-23
for more information. The GUIDE templates use the handles structure to
store application-defined data. See “Selecting a GUI Template” on page 6-6
for information about the templates.

Adding Fields to the handles Structure

To add a field to the handles structure, which is passed as an argument to
every callback in GUIDE take these steps:

1 Assign a value to the new field. This adds the field to the structure. For
example:

handles.number_errors = 0;
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adds the field number_errors to the handles structure and sets it to 0.
2 Use the following command to save the data:

guidata(hObject,handles)

where hObject is the handle of the component for which the callback was
triggered. GUIDE then automatically passes the hObject to every callback.

Changing GUI Data in an M-File Generated by GUIDE

In a GUIDE-generated M-file, the handles structure always represents GUI
data. The next example updates the handles structure, and then saves it.

Assume that the handles structure contains an application-defined field
handles.when whose value is 'now'.

1 Change the value of handles.when, to 'later' in a GUI callback. This
does not save the handles structure.

handles.when = 'later';
2 Save the changed version of the handles structure with the command
guidata(hObject,handles)

where hObject is the handle of the component for which the callback was
triggered. If you do not save the handles structure with guidata, you lose
the change you made to it in the previous step.

Using GUI Data to Control Initialization

You can declare a GUI to be a “singleton,” which means only one instance

of it can execute at one time. See “GUI Allows Only One Instance to Run
(Singleton)” on page 5-12. The CreateFcns of components in a singleton GUI
are only called the first time it runs; subsequent invocations of the GUI do not
execute the CreateFcns because all the objects already exist. However, the
opening function is called every time a singleton GUI is invoked.

If your GUI performs initialization actions in its OpeningFcn, you might
want some or all of them to occur only the first time the GUI runs. That
is, if the user invoked the GUI again from the Command Line or by other
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means while it is currently running, its internal state might not need to be
initialized again. One way to do that is to set a flag and store it in the handles
structure. The opening function can test for the existence of the flag, and
perform initialization operations only if the flag does not exist. The following
code snippet illustrates this pattern:

function mygui_OpeningFcn(hObject, eventdata, handles, varargin)

% This function has no output args, see OutputFcn.

hObject handle to figure

s eventdata reserved - to be defined in a future version of MATLAB
s handles structure with handles and user data (see GUIDATA)

s varargin command line arguments to spingui (see VARARGIN)

°  ° o°

o

s Check whether initialization has already been performed

o

if ~isfield(handles, 'initialized"')
% Flag not present, so create and store it
handles.initialized = true;
guidata(hObject,handles)
% perform initialization; it will only happen once.
initialize_mygui() % Insert code or function call here
end

Examples of Sharing Data Among a GUI’s Callbacks

¢ “Introduction” on page 9-10

e “Sharing Data with UserData” on page 9-11

e “Sharing Data with Application Data” on page 9-14
e “Sharing Data with GUI Data” on page 9-17

Introduction

The following examples illustrate the differences among three methods of
sharing data between slider and edit text GUI components. It contains a
slider and an edit text component as shown in the following figure. A static
text component instructs the user to enter a value in the edit text or click the
slider. When the user enters an invalid value, the edit text field displays

an error message.

9-10
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X

Enter a value or click the slider

25

If the user types a number between 0 and 1 in the edit text component

and then presses Enter or clicks outside the edit text, the callback sets
handles.slider1 to the new value and the slider moves to the corresponding
position.

If the entry is invalid—for example, 2.5—the GUI increments the value
stored in the error counter and displays a message in the edit text component
that includes the count of errors.

Sharing Data with UserData

To obtain copies of the GUI files for this example, follow the steps listed
below. If you are reading this in the MATLAB Help browser, you can access
the example FIG-file and M-file by clicking the following links. If you are
reading this on the Web or in PDF form, you should go to the corresponding
section in the MATLAB Help Browser to use the links.

If you intend to modify the layout or code of this GUI example, you should
first save copies of its M-file and FIG-file to your current folder. (You need
write access to your current folder to do this.) Follow these steps to copy the
example files to your current folder, and then open them:

9-11
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1 Click here to copy the files to your current folder.
2 Type guide sliderbox_userdata or click here to open the GUI in GUIDE.

3 Type edit sliderbox_userdata or click here to open the GUI M-file in
the Editor.

You can view the properties of any component by double-clicking it in the
Layout Editor to open the Property Inspector for it. You can modify either
the figure, the M-file, or both. Then you can save the GUI in your current
folder using File > Save as from GUIDE. This saves both files, allowing
you to rename them if you choose.

If you just want to run the GUI or inspect it in GUIDE, follow these steps:

1 Click here to add the example files to the MATLAB path (only for the
current session).

2 Click here to run the sliderbox_userdata GUI.
3 Click here to display the GUI in the GUIDE Layout Editor (read-only).

4 Click here to display the GUI M-file in the MATLAB Editor (read-only).

Note Do not save GUI files to the examples folder where you found them,
or you will overwrite the original files. If you want to save the GUI files,
use File > Save as from GUIDE, which saves both the GUI FIG-file and
the GUI M-file.

How Sharing Data with UserData Works. Every GUI component,

and the figure itself, has a UserData property that you can use to store
application-defined data. To access UserData, a callback must know the
handle of the component with which the property is associated. The code uses
the get function to retrieve UserDataand the set function to set it.

Note For more information, see “UserData Property” on page 9-5
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This section shows you how to use GUI data to initialize and maintain an
error counter by storing an error count in the edit text component’s UserData

property.

1 Add the following code to the opening function to initialize the edit
text component’s UserData property. This code initializes the data in a
structure to allow for other data that could be needed:

°

% INITIALIZE ERROR COUNT AND USE EDITTEXT1 OBJECT'S USERDATA TO STORE IT.
data.number_errors = 0;
set(handles.edittext1, 'UserData’',data)

Note Alternatively, you can add a CreateFcn callback for the edit text, and
initialize the error counter there.

2 Add the following statement to set the edit text value from the slider
callback:

set(handles.edittext1, 'String’',...
num2str(get(hObject, 'Value')));

where hObject is the handle of the slider.

3 Add the following lines of code to the edit text callback to set the slider
value from the edit text callback:

val = str2double(get(hObject, 'String'));
% Determine whether val is a number between 0 and 1.
if isnumeric(val) && length(val)==1 && ...
val >= get(handles.slideri, 'Min') && ...
val <= get(handles.slideri, 'Max"')
set(handles.slider1, 'Value',val);
else
Retrieve and increment the error count.
Error count is in the edit text UserData,
so we already have its handle.
data = get(hObject, 'UserData');
data.number_errors = data.number_errors+i;
Save the changes.

o° o°

o°

o°

9-13
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set(hObject, 'UserData’',data);
% Display new total.
set(hObject, 'String', ...
['You have entered an invalid entry ',...
num2str(data.number_errors),' times.']);
% Restore focus to the edit text box after error
uicontrol(hObject)
end

To update the number of errors, the code must first retrieve the value of
the edit text UserData property, and then it must increment the count.
The code then saves the updated error count in the UserData property
and displays the new count.

hObject is the handle of the edit text component because this code appears in
the edit text callback. The next-to-last line of the callback

uicontrol(hObject)

is useful, although not necessary for the callback to work properly. The call
to uicontrol has the effect of placing the edit text box in focus. An edit text
control executes its callback after the user presses Return or clicks away
from the control. These actions both cause the edit text box to lose focus.
Restoring focus to it in the event of an error helps the user to understand
what action triggered the error. The user can then correct the error by typing
again in the edit text box.

Sharing Data with Application Data

To obtain copies of the GUI files for this example, follow the steps listed
below. If you are reading this in the MATLAB Help browser, you can access
the example FIG-file and M-file by clicking the following links. If you are
reading this on the Web or in PDF form, you should go to the corresponding
section in the MATLAB Help Browser to use the links.

If you intend to modify the layout or code of this GUI example, you should
first save copies of its M-file and FIG-file to your current folder. (You need
write access to your current folder to do this.) Follow these steps to copy the
example files to your current folder, and then open them:

1 Click here to copy the files to your current folder.
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2 Type guide sliderbox_appdata or click here to open the GUI in GUIDE.

3 Type edit sliderbox_appdata or click here to open the GUI M-file in
the Editor.

You can view the properties of any component by double-clicking it in the
Layout Editor to open the Property Inspector for it. You can modify either
the figure, the M-file, or both. Then you can save the GUI in your current
folder using File > Save as from GUIDE. This saves both files, allowing
you to rename them if you choose.

If you just want to run the GUI or inspect it in GUIDE, follow these steps:

1 Click here to add the example files to the MATLAB path (only for the
current session).

2 Click here to run the sliderbox_appdata GUIL
3 Click here to display the GUI in the GUIDE Layout Editor (read-only).

4 Click here to display the GUI M-file in the MATLAB Editor (read-only).

Note Do not save GUI files to the examples folder where you found them,
or you will overwrite the original files. If you want to save the GUI files,
use File > Save as from GUIDE, which saves both the GUI FIG-file and
the GUI M-file.

How Sharing Data with Application Data Works. You can associate
application data with any object—a component, menu, or the figure itself. To
access application data, a callback must know the name of the data and the
handle of the component with which it is associated. Use the setappdata,
getappdata, isappdata, and rmappdata functions to manage application data.

Note For more information, see “Application Data” on page 9-5 .

9-15
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The section “Sharing Data with GUI Data” on page 9-17 uses GUI data to
Initialize and maintain an error counter. This example shows you how to do
the same thing using application data:

1 Define the error counter in the opening function by adding the following
code to the opening function:

% INITIALIZE ERROR COUNT AND USE APPDATA API TO STORE IT IN FIGURE.
slider_data.number_errors = 0;
setappdata(hObject, 'slider',slider data);

This code first creates a structure slider_data, and then assigns it to the
named application data slider. The hObject associates the application
data with the figure, because this code appears in the opening function.

2 Convert the slider Value property to a string and set the value of the edit
text component’s String property from the slider callback by adding this
statement to the callback:

set(handles.edittext1, 'String’',...
num2str(get(hObject, 'Value')));

Because this statement appears in the slider callback, hObject is the
handle of the slider.

3 Set the slider value from the edit text component’s callback. Add the
following code to the callback. It assumes the figure’s Tag property is
figurei.

To update the number of errors, this code must first retrieve the named
application data slider, and then it must increment the count. The code
then saves the application data and displays the new error count.

val = str2double(get(hObject, 'String'));
% Determine whether val is a number between 0 and 1.
if isnumeric(val) && length(val)==1 && ...
val >= get(handles.slideri, 'Min') && ...
val <= get(handles.slideri, 'Max"')
set(handles.slider1, 'Value',val);
else
% Retrieve and increment the error count.
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slider_data = getappdata(handles.figurei, 'slider');
slider_data.number_errors = slider_data.number_errors+1;
% Save the changes.
setappdata(handles.figure1, 'slider',slider_data);
% Display new total.
set(hObject, 'String', ...
['You have entered an invalid entry ',...
num2str(slider_data.number_errors),' times.']);
end

hObject is the handle of the edit text component because this code appears in
the edit text callback. The next-to-last line of the callback

uicontrol(hObject)

is useful, although not necessary for the callback to work properly. The call
to uicontrol has the effect of placing the edit text box in focus. An edit text
control executes its callback after the user presses Return or clicks away
from the control. These actions both cause the edit text box to lose focus.
Restoring focus to it in the event of an error helps the user to understand
what action triggered the error. The user can then correct the error by typing
again in the edit text box.

Sharing Data with GUI Data

To obtain copies of the GUI files for this example, follow the steps listed
below. If you are reading this in the MATLAB Help browser, you can access
the example FIG-file and M-file by clicking the following links. If you are
reading this on the Web or in PDF form, you should go to the corresponding
section in the MATLAB Help Browser to use the links.

If you intend to modify the layout or code of this GUI example, you should
first save copies of its M-file and FIG-file to your current folder. (You need
write access to your current folder to do this.) Follow these steps to copy the
example files to your current folder, and then open them:

1 Click here to copy the files to your current folder.
2 guide sliderbox_guidata or click here to open the GUI in GUIDE.

3 edit sliderbox_guidata or click here to open the GUI M-file in the Editor.

9-17
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You can view the properties of any component by double-clicking it in the
Layout Editor to open the Property Inspector for it. You can modify either
the figure, the M-file, or both. Then you can save the GUI in your current
folder using File > Save as from GUIDE. This saves both files, allowing
you to rename them if you choose.

If you just want to run the GUI or inspect it in GUIDE, follow these steps:

1 Click here to add the example files to the MATLAB path (only for the
current session).

2 Click here to run the sliderbox_guidata GUIL
3 Click here to display the GUI in the GUIDE Layout Editor (read-only).

4 Click here to display the GUI M-file in the MATLAB Editor (read-only).

Note Do not save GUI files to the examples folder where you found them,
or you will overwrite the original files. If you want to save the GUI files,
use File > Save as from GUIDE, which saves both the GUI FIG-file and
the GUI M-file.

How Sharing Data with GUI Data Works. All GUI callbacks can access

GUI data. A callback for one component can set a value in GUI data, which, a
callback for another component can then read. This example uses GUI data to

initialize and maintain an error counter.

Note For more information, see “GUI Data” on page 9-7 .

The GUI behavior is as follows:

® When a user moves the slider, the edit text component displays the slider’s

current value.

® When a user types a value into the edit text component, the slider updates
to this value.
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e If a user enters a value in the edit text that is out of range for the slider
(a value that is not between 0 and 1), the application returns a message
in the edit text component that indicates the number of times the user
entered an incorrect value.

The commands in the following steps initialize the error counter and
implement the interchange between the slider and the edit text component:

1 Define the error counter in the opening function. The GUI records the
number of times a user enters an incorrect value in the edit text component
and stores this number in a field of the handles structure.

Define the number_errors field in the opening function as follows:

% INITIALIZE ERROR COUNT AND USE GUIDATA TO UPDATE THE HANDLES STRUCTURE.
handles.number_errors = 0;

Place it above the following line, which GUIDE automatically inserts into
the opening function:

guidata(hObject,handles);

The guidata command saves the modified handles structure so that it can
be retrieved in the GUI’s callbacks.

2 Set the value of the edit text component String property from the slider
callback. The following command in the slider callback updates the value
displayed in the edit text component when a user moves the slider and
releases the mouse button:

set(handles.edittext1, 'String’',...
num2str(get(handles.slider1, ‘'Value')));
This code combines three commands:
® The get command obtains the current value of the slider.
¢ The num2str command converts the value to a string.

® The set command sets the String property of the edit text to the
updated value.

9-19
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3 Set the slider value from the edit text component’s callback. The edit text
component’s callback sets the slider’s value to the number the user enters,
after checking to see if it is a single numeric value between 0 and 1. If the
value 1s out of range, the error count increments and the edit text displays a
message telling the user how many times they entered an invalid number.
Because this code appears in the edit text component’s callback, hObject is
the handle of the edit text component:

val = str2double(get(hObject, 'String'));

% Determine whether val is a number between 0 and 1.

if isnumeric(val) && length(val)==1 && ...
val >= get(handles.slideri, 'Min') && ...
val <= get(handles.slideri, 'Max')
set(handles.slider1, 'Value',val);

else

% Increment the error count, and display it.
handles.number_errors = handles.number_errors+i;
guidata(hObject,handles); % Store the changes.
set(hObject, 'String’', ...
['You have entered an invalid entry ',...
num2str(handles.number_errors),' times.']);
% Restore focus to the edit text box after error
uicontrol(hObject)

end

hObject is the handle of the edit text component because this code appears in
the edit text callback. The next-to-last line of the callback

uicontrol(hObject)

is useful, although not necessary for the callback to work properly. The call
to uicontrol has the effect of placing the edit text box in focus. An edit text
control executes its callback after the user presses Return or clicks away
from the control. These actions both cause the edit text box to lose focus.
Restoring focus to it in the event of an error helps the user to understand
what action triggered the error. The user can then correct the error by typing
again in the edit text box.
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In this section...

“Data-Sharing Techniques” on page 9-21
“Example — Manipulating a Modal Dialog Box for User Input” on page 9-22

“Example — Individual GUIDE GUIs Cooperating as Icon Manipulation
Tools” on page 9-30

Data-Sharing Techniques

Several of the techniques described in “Examples of Sharing Data Among a
GUT’s Callbacks” on page 9-10 for sharing data within a GUI can also share
data among several GUIs. You can use GUI data, application data, and
UserData property to communicate between GUIs as long as the handles
to objects in the first GUI are made available to other GUIs. This section
provides two examples that illustrate these techniques:

¢ “Example — Manipulating a Modal Dialog Box for User Input” on page 9-22

This example describes how a simple GUI can open and receive data from
a modal dialog box.

e “Example — Individual GUIDE GUIs Cooperating as Icon Manipulation
Tools” on page 9-30

This more extensive example illustrates how the three components of an
icon editor are made to interact.

Note These examples omit portions of code to succinctly convey data-sharing
techniques. The omissions are noted by ellipses:

You can copy, run, view, and modify the complete M-files and FIG-files for
the complete examples.
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Example — Manipulating a Modal Dialog Box for
User Input

* “View and Run the changeme GUI” on page 9-23

® “Invoking the Text Change Dialog Box” on page 9-24

® “Managing the Text Change Dialog” on page 9-25

® “Protecting and Positioning the Text Change Dialog” on page 9-26
¢ “Initializing Text in the Text Change Dialog Box” on page 9-28

e “Canceling the Text Change Dialog Box” on page 9-28

® “Applying the Text Change” on page 9-29

¢ “Closing the Main GUI” on page 9-29

This example illustrates how to do the common tasks involved in making
multiple GUIs work together. It explains how to position a second GUI
relative to the main GUI and demonstrates how data is passed to a modal
dialog box invoked from a GUIDE GUI. The dialog box displays text data in
an edit field. Changes that you make to the edit field are passed back to the
main GUI. The main GUI uses this data in various ways. You can update
the appearance of one of the components of the main GUI by changing the
data in the modal dialog box.

The main GUI, called changeme_main, contains one button and a static
text field giving instructions. When you click the button, the modal
changeme_dialog dialog box opens and the button’s current string appears
in an editable text field that you can then change.

If you click OK, the value of the text field is returned to the main GUI, which
sets the string property of the button to the value you entered. The main GUI
and its modal dialog box are shown in the following figure.
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i

Press the button and change its text

Change Me

|
i

Button Text:

I Change Me

0K Cancel

Note The changeme _dialog GUI is patterned after the MATLAB inputdlg
function, a predefined dialog box that serves the same purpose. It also calls
uiwait to block the calling GUI and other processes. You can use inputdlg
when creating programmatic GUIs.

View and Run the changeme GUI

If you are reading this in the MATLAB Help browser, you can access the
example FIG-files and M-files by clicking the following links. If you are
reading this on the Web or in PDF form, you should go to the corresponding
section in the MATLAB Help Browser to use the links.

If you intend to modify the layout or code of this GUI example, you should
first save copies of its M-files and FIG-files to your current folder (You need
write access to your current folder to do this.) Follow these steps to copy the
example files to your current folder and then to open them:

1 Click here to copy the files to your current folder.

2 Type the commands guide changeme_main; guide changeme_dialog or
click here to open the two GUIs in GUIDE.

3 Type the commands edit changeme_main.m; edit changeme_dialog.m
or click here to open the GUI M-files in the Editor.
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You can view the properties of any component by double-clicking it in the
Layout Editor to open the Property Inspector for it. You can modify either the
figure, the M-file, or both. Then you can save the GUI in your current folder
using File > Save As from GUIDE. This saves both the GUI and its M-file. If
you save one of the GUIs in this way, you need to save the other one as well.

If you just want to run the GUI or inspect it in GUIDE, follow these steps:

1 Click here to add the example files to the MATLAB path (only for the
current session).

2 Click here to run the changeme_main GUI.
3 Click here to display the GUI in the GUIDE Layout Editor (read-only).

4 Click here to display the GUI M-file in the MATLAB Editor (read-only).

Note Do not save GUI files to the examples folder where you found them,
or you will overwrite the original files. If you want to save the GUI files,
use File > Save As from GUIDE, which saves both the GUI FIG-file and
the GUI M-file.

Do not change the file name of either GUI when using Save As. Because the
changeme_main M-code calls the changeme_dialog function, modifying that
file name would make the GUI inoperable.

Invoking the Text Change Dialog Box

When the user clicks the Change Me button, the Text Change dialog
box opens. Invoke this dialog box by calling its main function with a
property/value pair:

¢ Name: 'changeme_main' (the main GUT’s name)

e Value: the main GUI’s figure handle
function buttonChangeMe_Callback(hObject,eventdata, handles)

% Call the dialog to change button name giving this figure's handle
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changeme_dialog('changeme_main', handles.figure);
The dialog box uses the handle to access the main GUI’s data. If the main

GUI’s data is missing, the dialog box displays an error in the Command
Window that describes proper usage and then exits.

Managing the Text Change Dialog

1 In the Property Inspector for the Text Change dialog box’s figure, set the
WindowStyle property to 'Modal'. This ensures that when the dialog box
is active the user cannot interact with other figures.

2 Call uiwait in the OpeningFcn of the dialog box to put off calling the output
function until uiresume is called. This keeps the invocation call of the

GUI from returning until that time:

function changeme dialog OpeningFcn(hObject,eventdata,handles,varargin)

uiwait(hObject);

3 Invoke uiresume within CloseRequestFcn for the figure, the Cancel
button, and the OK button. Every callback in which the GUI needs to
close should call uiresume:

function buttonCancel_Callback(hObject,eventdata,handles)

uiresume (handles.figure);

function figure_CloseRequestFcn(hObject,eventdata,handles)

uiresume (hObject);

function buttonOK_Callback(hObject,eventdata,handles)
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uiresume(handles.figure);

Protecting and Positioning the Text Change Dialog

1 The user opens the Text Change dialog box by triggereing the main GUTI’s
buttonChangeMe_Callback callback, which supplies the main GUT’s figure
handle as a property called changeme_main.

2 The OpeningFcn for the dialog box validates the input by searching and
indexing into the varagin cell array. If 'changeme_main' and a handle
are found as successive arguments, it calls uiwait. This ensures that the
dialog GUI can exit without waiting for OutputFcn to close the figure. If it
does not find the property or finds an invalid value, the modal dialog box
displays an error and exits.

function changeme_dialog_OpeningFcn(hObject,
eventdata, handles, varargin)

% Is the changeme_main gui's handle is passed in varargin?
if the name 'changeme_main' is found, and the next argument
% varargin{mainGuilInput+1} is a handle, assume we can open it.

o°

dontOpen = false;
mainGuiInput = find(strcmp(varargin, 'changeme_main'));
if (isempty(mainGuiInput))
|| (length(varargin) <= mainGuilnput)
|| (-ishandle(varargin{mainGuilInput+1}))
dontOpen = true;
else

end

if dontOpen
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kT T R L L EE R ");
disp('Improper input arguments. Pass a property value pair')
disp('whose name is "changeme_main" and value is the handle')
disp('to the changeme_main figure.');

disp('eg:');

disp(' X = changeme_main()"');

disp(' changeme_dialog('changeme_main', x)');

Y e s
else

uiwait(hObject);
end

3 The changeme_dialog OpeningFcn centers the Text Change dialog box
over the main GUI, using the passed-in handle to that figure. So, if the
main figure is moved and the dialog box is invoked, it opens in the same
relative position instead of always in a fixed location.

function changeme_dialog OpeningFcn(hObject,
eventdata, handles, varargin)

mainGuiInput = find(strcmp(varargin, 'changeme_main'));

handles.changeMeMain = varargin{mainGuiInput+1};

% Position to be relative to parent:
parentPosition = getpixelposition(handles.changeMeMain);
currentPosition = get(hObject, 'Position');
% Sets the position to be directly centered on the main figure
newX = parentPosition(1) + (parentPosition(3)/2
- currentPosition(3)/2);
newY = parentPosition(2) + (parentPosition(4)/2
- currentPosition(4)/2);
newW = currentPosition(3);
newH currentPosition(4);
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set(hObject, 'Position', [newX, newY, newW, newH]);

Initializing Text in the Text Change Dialog Box

1 To initialize the Text Change dialog box text to the Change Me button’s
current text, get the main GUT’s handles structure from its handle, passed
to the modal dialog box:

function changeme_dialog OpeningFcn(hObject,
eventdata, handles, varargin)

mainGuiInput = find(strcmp(varargin, 'changeme_main'));

handles.changeMeMain = varargin{mainGuiInput+1};

2 Get the Change Me button’s String property and set the String property
of the edit box to that value in the dialog box OpeningFcn.

% Obtain handles using GUIDATA with the caller's handle

mainHandles = guidata(handles.changeMeMain);

% Set the edit text to the String of the main GUI's button

set(handles.editChangeMe, 'String',
get(mainHandles.buttonChangeMe, 'String'));

Canceling the Text Change Dialog Box

Call uiresume to close the modal dialog box if the user clicks Cancel or closes
the window. Do not modify the main GUI to close the modal dialog box.

function buttonCancel_Callback(hObject,
eventdata, handles)
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uiresume (handles.figure);

function figure_CloseRequestFcn(hObject,
eventdata, handles)
uiresume (hObject);

Applying the Text Change

Use the reference to the main GUI in the handles structure saved by
OpeningFcn in the modal dialog box to apply the text change. The user clicks
OK to apply the text change. This sets the Change Me button label in the
main GUI to the value entered in the text field of the modal dialog box.

function buttonOK_Callback(hObject,
eventdata, handles)

text get(handles.editChangeMe, 'String');

main handles.changeMeMain;

mainHandles = guidata(main);

changeMeButton = mainHandles.buttonChangeMe;

set(changeMeButton, 'String', text);

uiresume(handles.figure);

Closing the Main GUI

When the user closes the changeme_dialog GUI, the changeme_main GUI is
in a waiting state. The user can either click the push button to change the
name again or close the GUI by clicking the X close box. When the user closes
the GUI, its OutputFcn returns the push button’s current label (its String
property) before deleting the GUI figure:

function varargout = changeme_dialog_Dialog_OutputFcn...
(hObject, eventdata, handles)

% Get pushbutton string from handles structure and output it

varargout{1} = get(handles.buttonChangeMe, 'String');

% Now destroy yourself

delete(hObject);

You also need a CloseRequestFcn. If you do not specify one, the GUI cannot
output data because the default CloseRequestFcn, the MATLAB function
closreq, immediately deletes the figure before any OutputFcn can be called.
This figure_CloseRequestFcn does that, but only if the GUI is not in a
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wait state; if it is, it calls uiresume and returns, enabling the OutputFcn
to be called:

function figure_CloseRequestFcn(hObject,eventdata,handles)

if isequal(get(hObject, 'waitstatus'), 'waiting')
% The GUI is still in UIWAIT, use UIRESUME and return
uiresume (hObject);

else

% The GUI is no longer waiting, so destroy it now.
delete(hObject);
end

Example — Individual GUIDE GUIs Cooperating as
Icon Manipulation Tools

This example demonstrates how three GUIs in GUIDE work together when
invoked from the main GUI. The tools are listed and illustrated below:

® The drawing area (Icon Editor)
e The tool selection toolbar (Tool Palette)
¢ The color picker (Color Palette)
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) Figure 1: guide_iconeditor - |EI|1|
lzon file name: I Impart ... |
— lcon Edit Pane (16 X 16) Preview

OK | Cancel |
J Figure 3: guide_colorpalette ;lglzl _|E||5|

ZELY

Mare Colors ..

These GUIs share data and expose functionality to one another using several
different techniques:
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View and Run the Three Icon Manipulation GUIs

If you are reading this in the MATLAB Help browser, you can access the
example FIG-files and M-files by clicking the following links. If you are
reading this on the Web or in PDF form, you should go to the corresponding
section in the MATLAB Help Browser to use the links.

If you intend to modify the layout or code of this GUI example, you should
first save copies of its M-files and FIG-files to your current folder (You need
write access to your current folder to do this.) Take the following steps to copy
the example files to your current folder and open them:

1 Click here to copy the files to your current folder.

2 Type the commands guide guide iconeditor; guide
guide_toolpalette; guide guide colorpalette or click here
to open the two GUIs in GUIDE.

3 Type the commands edit guide_iconeditor.m; edit
guide_toolpalette.m; edit guide_colorpalette.m or click
here to open the GUI M-files in the Editor.

You can view the properties of any component by double-clicking it in the
Layout Editor to open the Property Inspector for it. You can modify either
the figure, the M-file, or both. Then you can save the GUI in your current
folder using File > Save as from GUIDE. This saves both files, allowing
you to rename them if you choose.

If you just want to run the GUI or inspect it in GUIDE, follow these steps:

1 Click here to add the example files to the MATLAB path (only for the
current session).

2 Click here to run the guide_iconeditor GUI.
3 Click here to display the GUI in the GUIDE Layout Editor (read-only).

4 Click here to display the GUI M-file in the MATLAB Editor (read-only).
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Note Do not save GUI files to the examples folder where you found them,
or you will overwrite the original files. If you want to save the GUI files,
use File > Save as from GUIDE, which saves both the GUI FIG-file and
the GUI M-file.

The behavior of the Icon Editor application is described in this sequence:

“M-file Implementations” on page 9-33
“Opening the Icon Editor and the Tool and Color Palettes” on page 9-35
“Setting the Initial Color on the Color Palette” on page 9-37

“Accessing the Color Palette’s Current Color from the Icon Editor” on page
9-38

“Using UserData Property to Share Data” on page 9-39
“Displaying the Current Tool’s Cursor” on page 9-40
“Closing All Windows When Complete” on page 9-41

M-file Implementations

The Icon Editor application uses three M-files and FIG-files that are fully
implemented in GUIDE. You can modify and enhance them in the GUIDE
environment if you choose. The files are:

guide _iconeditor.fig and guide_iconeditor.m — Main GUI, for
drawing and modifying icon files

guide colorpalette.fig and guide_colorpalette.m — Palette for
selecting a current color

guide toolpalette.fig and guide toolpalette.m — Palette for
selecting one of four editing tools

The M-files contain the following function signatures and outputs (if any):

guide_iconeditor.m

varargout = guide_iconeditor(varargin)
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guide_iconeditor_OpeningFcn(hObject, eventdata, handles, varargin)
varargout = guide_iconeditor_OutputFcn(hObject, eventdata, handles)
editFilename_CreateFcn(hObject, eventdata, handles)
buttonImport_Callback(hObject, eventdata, handles)
buttonOK_Callback(hObject, eventdata, handles
buttonCancel_Callback(hObject, eventdata, handles)
editFilename_ButtonDownFcn(hObject, eventdata, handles)
editFilename_Callback(hObject, eventdata, handles)
figure_CloseRequestFcn(hObject, eventdata, handles)
figure_WindowButtonDownFcn(hObject, eventdata, handles)
figure_WindowButtonUpFcn(hObject, eventdata, handles)
figure_WindowButtonMotionFcn(hObject, eventdata, handles)
[toolPalette, toolPaletteHandles]= getToolPalette(handles)
[colorPalette, colorPaletteHandles] = getColorPalette(handles)
setColor(hObject, color)

color = getColor(hObject)

updateCursor(hObject, overicon)

applyCurrentTool(handles)

localUpdateIconPlot(handles)

cdwithnan = localGetIconCDataWithNaNs (handles)

® guide_colorpalette.m

varargout = guide_colorpalette(varargin)
guide_colorpalette_OpeningFcn(hObject, eventdata, handles, varargin)
varargout = guide_colorpalette_OutputFcn(hObject, eventdata, handles)
buttonMoreColors_Callback(hObject, eventdata, handles)
colorCellCallback(hObject, eventdata, handles)
figure_CloseRequestFcn(hObject, eventdata, handles)
localUpdateColor(handles)

setSelectedColor(hObject, color)

® guide_toolPalatte.m

varargout = guide_toolpalette(varargin)
guide_toolpalette_OpeningFcn(hObject, eventdata, handles, varargin)
varargout = guide_toolpalette_OutputFcn(hObject, eventdata, handles)
toolPencil_CreateFcn(hObject, eventdata, handles)
toolEraser_CreateFcn(hObject, eventdata, handles)
toolBucket_CreateFcn(hObject, eventdata, handles)
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toolPicker_CreateFcn(hObject, eventdata, handles)
toolPalette_SelectionChangeFcn(hObject, eventdata, handles)
figure_CloseRequestFcn(hObject, eventdata, handles)

[iconEditor, iconEditorHandles] = getIconEditor(handles)

cdata = pencilToolCallback(handles, toolstruct, cdata, point)

cdata = eraserToolCallback(handles, toolstruct, cdata, point)

cdata = bucketToolCallback(handles, toolstruct, cdata, point)

cdata = fillWithColor(cdata, rows, cols, color, row, col, seedcolor)
cdata = colorpickerToolCallback(handles, toolstruct, cdata, point)

Opening the Icon Editor and the Tool and Color Palettes

When you open the Icon Editor, the Tool Palette and Color Palette
automatically start up. The palettes are children of the Icon Editor and
communicate as described here:

® Property/value pairs — Send data into a newly invoked or existing GUI
by passing it as input arguments.

e GUI data — Store data in the handles structure of a GUI; can communicate
data within one GUI or between several GUIs.

¢ Qutput — Return data from the invoked GUI,; this is used to communicate
data, such as the handles structure of the invoked GUI, back to the
invoking GUIL.

The Icon Editor is passed into the Tool Palette, and Color Palette as a
property/value (p/v) pair that allows the Tool and Color Palettes to make calls
back into the Icon Editor. The output value from calling both of the palettes
is the handle to their GUI figures. These figure handles are saved into the
handles structure of Icon Editor:

% in Icon Editor
function guide_Icon Editor_OpeningFcn(hObject,eventdata,handles,varargin)

handles.colorPalette = guide_colorpalette('iconEditor',hObject);
handles.toolPalette = guide_toolpalette('iconEditor',hObject);
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% Update handles structure
guidata(hObject, handles);

The Color Palette needs to remember the Icon Editor for later:

% in colorPalette
function guide_colorpalette_OpeningFcn(hObject,eventdata,handles,varargin)
handles.output = hObject;

handles.iconEditor = [];

iconEditorInput = find(strcmp(varargin, 'iconEditor'));
if ~isempty(iconEditorInput)

handles.iconEditor = varargin{iconEditorInput+1};
end

% Update handles structure
guidata(hObject, handles);

The Tool Palette also needs to remember the Icon Editor:

% in toolPalette

function guide_toolpalette_OpeningFcn(hObject,
eventdata, handles, varargin)

handles.output = hObject;

handles.iconEditor = [];

iconEditorInput = find(strcmp(varargin, 'iconEditor'));
if ~isempty(iconEditorInput)

handles.iconEditor = varargin{iconEditorInput+1};
end
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% Update handles structure
guidata(hObject, handles);

Setting the Initial Color on the Color Palette

After you create all three GUISs, you need to set the initial color. When you
invoke the Color Palette from the Icon Editor, the Color Palette passes a
function handle that tells the Icon Editor how to set the initial color. This
function handle is stored in its handles structure. You can retrieve the
handles structure from the figure to which the Color Palette outputs the
handle:

% in colorPalette

function guide_colorpalette_OpeningFcn(hObject,
eventdata, handles, varargin)

handles.output = hObject;

% Set the initial palette color to black
handles.mSelectedColor = [0 O 0];

% Publish the function setSelectedColor
handles.setColor = @setSelectedColor;

% Update handles structure
guidata(hObject, handles);

% in colorPalette
function setSelectedColor(hObject, color)
handles = guidata(hObject);
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handles.mSelectedColor =color;

guidata(hObject, handles);
Call the publicized function from the Icon Editor, setting the initial color
to 'red':

% in Icon Editor
function guide_iconeditor_OpeningFcn(hObject,
eventdata, handles, varargin)

handles.colorPalette = guide_colorpalette('iconEditor', hObject);

colorPalette = handles.colorPalette;
colorPaletteHandles = guidata(colorPalette);
colorPaletteHandles.setColor(colorPalette, [1 0 0]);

% Update handles structure
guidata(hObject, handles);

Accessing the Color Palette’s Current Color from the Icon Editor
The Color Palette initializes the current color data:

%in colorPalette

function guide_colorpalette_OpeningFcn(hObject,
eventdata, handles, varargin)

handles.output = hObject;

handles.mSelectedColor = [0 O 0];
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% Update handles structure
guidata(hObject, handles);

The Icon Editor retrieves the initial color from the Color Palette’s GUI data
via its handles structure:

% in Icon Editor

function color = getColor(hObject)

handles = guidata(hObject);

colorPalette = handles.colorPalette;
colorPaletteHandles = guidata(colorPalette);
color = colorPaletteHandles.mSelectedColor;

Using UserData Property to Share Data

You can use the UserData property of components in your GUIDE GUI to
share data. When you click the mouse in the icon editing area, you select a
tool. You can use every tool in the Tool Palette to modify the icon you are
editing by altering the tool’s CData. The GUI uses the UserData property
of each tool to record the function that you call when a tool is selected and
applied to the icon-editing area. Each tool alters different aspects of the icon
data. Here is an example of how the pencil tool works.

In the CreateFcn for the pencil tool, add the user data that points to the
function for the pencil tool:

% in toolPalette
function toolPencil_CreateFcn(hObject, eventdata, handles)
set(hObject, 'UserData', struct('Callback', @pencilToolCallback));

The Tool Palette tracks the currently selected tool in its handles structure’s
mCurrentTool field. You can get this structure from other GUIs after you
create the handles structure of the Tool Palette. Set the currently selected
tool by calling guidata after you click a button in the Tool Palette:

% in toolPalette
function toolPalette_SelectionChangeFcn(hObject,

eventdata, handles)

handles.mCurrentTool = hObject;
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guidata(hObject, handles);

When you select the pencil tool and click in the icon-editing area, the Icon
Editor calls the pencil tool function:

% in iconEditor

function iconEditor_WindowButtonDownFcn(hObject,...
eventdata, handles)

toolPalette = handles.toolPalette;

toolPaletteHandles = guidata(toolPalette);

userData = get(toolPaletteHandles.mCurrentTool, 'UserData');
handles.mIconCData = userData.Callback(toolPaletteHandles,
toolPaletteHandles.mCurrentTool, handles.mIconCData,

The following code shows how the pixel value in the icon-editing area under
the mouse click (the Tool icon’s CData) changes to the color currently selected
in the Color Palette:

% in toolPalette

function cdata = pencilToolCallback(handles, toolstruct, cdata,...

iconEditor = handles.iconEditor;
iconEditorHandles = guidata(iconEditor);
X:

% update color of the selected block
color = iconEditorHandles.getColor(iconEditor);
cdata(y, x,:) = color;

<

Displaying the Current Tool’s Cursor

You can have the cursor display the current tools pointer icon when the
mouse is in the editing area and the default arrow displays outside the
editing area. To do this you must identify the selected tool through the Tool
Palette’s handles structure:

% in Icon Editor
function iconEditor_WindowButtonMotionFcn(hObject,
eventdata, handles)
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rows = size(handles.mIconCData,1);

cols size(handles.mIconCData,2);

pt = get(handles.icon, 'currentpoint');

overicon = (pt(1,1)>=0 && pt(1,1)<=rows) && ...
(pt(1,2)>=0 && pt(1,2)<=cols);

if ~overicon
set(hObject, 'pointer', "arrow');
else
toolPalette = handles.toolPalette;
toolPaletteHandles = guidata(toolPalette);
tool = toolPaletteHandles.mCurrentTool;
cdata = round(mean(get(tool, 'cdata'),3))+1;
if ~isempty(cdata)
set(hObject, 'pointer', 'custom', 'PointerShapeCData’,
cdata(1:16, 1:16), 'PointerShapeHotSpot',[16 1]);
end
end

Closing All Windows When Complete

When the Icon Editor opens, it opens the Color Palette and Tool Palette,
saving their handles and other data in the handles structure. The last thing
the Icon Editor OpeningFcn does is to call uiwait to defer output until the
GUI is complete. When you need to close the windows, neither the Color
Palette nor Tool Palette close independently of the Icon Editor because there
is a complicated close sequence involved. You can close all windows using
one of these methods:

e (Click the OK button or the Cancel button in the Tool and Color Palettes
and then close the Icon Editor Window.

¢ (Close the Icon Editor window directly.
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You cannot close the Color Palette and Tool Palette windows by directly
clicking their close button (X).

In the next example, you set the output of Icon Editor to be the CData of the
icon. The opening function for Icon Editor, with uiwait, contains this code:

% in Icon Editor
function guide_iconeditor_OpeningFcn(hObject, eventdata,
handles, varargin)

handles.colorPalette = guide_colorpalette();
handles.toolPalette = guide_toolpalette('iconEditor', hObject);

% Update handles structure
guidata(hObject, handles);
uiwait (hObject);

As a result, you must call uiresume on each exit path:

% in Icon Editor
function buttonOK Callback(hObject, eventdata, handles)
uiresume(handles.figure);

function buttonCancel_Callback(hObject, eventdata, handles)
% Make sure the return data will be empty if we cancelled
handles.mIconCData =[];

guidata(handles.figure, handles);

uiresume(handles.figure);

function Icon Editor_CloseRequestFcn(hObject, eventdata, handles)

uiresume (hObject);

To ensure that the Color Palette is not closed any other way, override its
closerequestfcn to take no action:

% in colorPalette
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function figure_CloseRequestFcn(hObject, eventdata, handles)
% Don't close this figure. It must be deleted from Icon Editor

Do the same for the Tool Palette:

% in toolPalette
function figure_CloseRequestFcn(hObject, eventdata, handles)
% Don't close this figure. It must be deleted from Icon Editor

Finally, in the output function, delete all three GUIs:

% in Icon Editor

function varargout = guide_iconeditor_OutputFcn(hObject,
eventdata, handles)

% Return the cdata of the icon. If cancelled, this will be empty

varargout{1} = handles.mIconCData;

delete(handles.toolPalette);

delete(handles.colorPalette);

delete(hObject);
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Examples of GUIDE GUIs

e “GUI with Multiple Axes” on page 10-2

e “GUI for Animating a 3-D View” on page 10-15

e “GUI to Interactively Explore Data in a Table” on page 10-31

e “List Box Directory Reader” on page 10-54

® “Accessing Workspace Variables from a List Box” on page 10-61

e “A GUI to Set Simulink Model Parameters” on page 10-66

® “An Address Book Reader” on page 10-81

¢ “Using a Modal Dialog Box to Confirm an Operation” on page 10-98



'IO Examples of GUIDE GUIs

GUI with Multiple Axes

In this section...

“About the Multiple Axes Example” on page 10-2
“View and Run the Multiple Axes GUI” on page 10-3
“Designing the GUI” on page 10-4

“Plot Push Button Callback” on page 10-8
“Validating User Input as Numbers” on page 10-11

About the Multiple Axes Example

This example creates a GUI that plots data that it derives from three
parameters entered by the user. The parameters define a time- and
frequency-varying signal. One of the GUI’s two axes displays the data in the
time domain and the other displays it in the frequency domain.

GUI-building techniques illustrated in this example include:

Controlling which axes object is the target for plotting commands.

Using edit text controls to read numeric input and MATLAB expressions.

¢ Converting user inputs from strings to numbers and validating the result.

Restoring focus to an edit text box when user input fails validation.

When you first open the Signal Analysis GUI, it looks as shown in the
following figure. It evaluates the expression printed at the top of the figure
using the parameters f1, f2, and t that